Product Overview

Genie Backup Manager™ (GBM), is a very easy to use yet powerful and flexible software that can backup and
restore files, documents, emails, settings, programs and more, to virtually any local or remote location,
including internal and external hard disks, FTP locations, across network, optical media, removable media,
memory sticks, and tapes. GBM also offers offsite (online) backup service.

GBM is the only backup software on the market that offers unlimited FREE Plugins, which the user can
download or create to extend the capabilities of Genie Backup Manager™ .

GBM is perfect for users of all computer comfort levels. Novice users will find it easy to create their first
backup job in matter of minutes after installing the software, thanks to its intuitive wizard-based user
interface, while advanced users will appreciate the software's extended scalability and flexibility, with
features such as preserving NTFS Alternative Data Streams, Email notification, and scripting capabilities.

GBM also caters for the data protection needs of business enterprises, by offering features that ensure a
reliable backup mechanism for mission critical data, such as backing up using Open File Backup (OFB), for
businesses operating around the hour that cannot afford to shutdown its running applications during backup,
highly secure encryption, for sensitive documents that must not fall into the wrong hands and scheduling
unattended backup tasks for regularly safeguarding constantly changing data.

Online backup is our latest offering for users who wish to protect their data, without the hassle of
maintaining shelves of stacked backup desks or cartridges, by performing true offsite backups to Genie-
Soft's backup servers. Our online backup solution ensures around-the-hour data accessibility, and is highly
secure, through username and password encryption, as well as 128- bit Secure Socket Layer (SSL) data
transmission, certified by the leading global provider of SSL certificates, Thawte.

As we introduce GBM, we are confident that it can efficiently and effectively address all your data protection

needs. Let GBM work for you and never again worry about losing what you have spent years building or
collecting.
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Feature Matrix

Genie-Soft offers a variety of backup and recovery products, each priced and carrying a set of features
tailored to cater for the needs of different categories of users. Genie Backup Manager comes in three
editions: Server, Pro and Home.

Server is the full edition with all features enabled, while Pro and Home are the somewhat limited-
functionality editions. Genie-Soft also offers two specialized backup utilities for protecting Microsoft Outlook
and Outlook Express data.

Below you can find a comparison of the features available in each edition.

Product Server 8.0 Pro 8.0 Home 8.0
Features

Open File Backup
Option

Disaster Recovery*

Built in CD/DVD burning
capability

Backup Outlook
Express

Backup Outlook 2000-
2007

Backup Windows Mail

Backup Windows
Contacts

Create Outlook Profiles

Backup Files & Folders
Backup My photos
Backup media Files
Backup My Documents

Backup Programs
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Backup Favorites

Backup Internet
Explorer Settings

Backup Windows
Address Book (WAB)

Backup Windows
Settings
Backup Fonts

Automatic Backup
Scheduler

AES Encryption
Purging

Pre & Post Commands

GenieScript: create
custom backup scripts

Backup File Integrity
Testing

Backup your data with
or without compression

Backup as EXE file (To
any medium)

Backup to a remote
FTP Server
(Unlimited size)

Integrated Online
Backup

On-The-Fly
Compression

Auto Update

Change Power options
during backup*

Backup to Tape
Email Notification

Catalog
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CPU Management
MS Exchange
SQL Server
Cloning

Advanced Schedule*

Backup Access Control
List

CRC data verification

Backup Transfer
Method

Manual Folder/File
selection

Auto Multi-drive
spanning

Differential Backup

REV Support*

CD/DVD Backup
Simulation

Bandwidth Throttling*

Control backup
performance*

Date and size filtering *

Snooze Scheduled
backup *

Pause Backup *

Price
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What's New In Version 8.0?

Continuous Data Protection (CDP) for SQL

GBM is currently enhanced with multiple level protection to suit your backup strategies. Now you can create
a single backup job that can run different backup types during the month, week day, or even every hour.
You can also set how many backup version needed to save space and time. Single Level Protection enables
users to run a single backup type to their multiple database backup.

More info...

Continuous Data Protection (CDP) for Exchange

CDP is also enhanced for protecting your Multiple exchange storage groups in an intuitive easy to use
interface that also enables multiple backup types to run during the hour, day, week, or month. Single Level
Protection is also supported for faster backups.

More info...

Disaster Recovery

GBM can recover your system from malicious spyware, virus attacks, system failure,or deletion. Thanks to
the enhanced PE (Preinstalled Environment) technology, Genie Disaster Recovery supports Vista and you can
also perform your disaster Recovery backups online. There is no need for Windows Setup CD. Two simple
steps and you are all set.

More info...

Free Open File Backup Option

GBM currently added Microsoft's latest Volume Shadow-Copy Service (VSS) framework, to permit consistent
backup of locked and open files without the need for additional applications or plug-ins.

More info...

Enhanced Online Backup Integration

Now it is easier to view, manage and delete your online backup storage. Added Bandwidth Throttling to
control how much GBM takes from internet connection. Also improved connectivity that auto resumes when
connection returns.

More info...

Improved Scheduling Capabilities

Now it is easier to protect and rotate backups with the intuitive easy to use scheduling interface that is
integrated in the backup wizard with two modes; Basic Schedule and Advanced Schedule

More info...



REV Support

Now with the new lomega REV support, users can automatically erase, enable/disable write and password
protection before and after backup.

More info...

Improved Connectivity:

GBM now detects when backup destination is accessible and also reports disconnected network drives being
backed up. Also Auto resumes when connection returns.

Enhanced Graphical User Interface
Now more organized with clear options making GBM’s interface better than ever.
Enhanced Filtering Options

Added support of Date and file size filtering and newly added in scripting

More info...

Control Power Options and Backup Speed

You can control backup speed before or during backup and enable/disable power options or change them
during backup.

Pause/Snooze Backups:

You can pause currently pause backups and postpone scheduled backups to start later via snoozing

More info...

New Compression Engine:

The new zip engine is more resource friendly making backups faster and with better compressing
capabilities.
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Copyrights

Copyright© Genie-Soft Corporation 2002-2007. All rights reserved.

Warning: This computer program is protected by copyright law and international treaties. Unauthorized
production or distribution of this program, or any portion of it that's owned by Genie-Soft, may result in
severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Outlook Express®, Outlook®, Internet Explorer®, Windows® and Microsoft® are Registered Trademarks of
Microsoft® Corporation

All trademarks and registered trademarks used in this documentation are property of their respective
owners.
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End User License Agreement

END LICENSE AGREEMENT

PLEASE READ THIS DOCUMENT (THIS "AGREEMENT") CAREFULLY BEFORE USING THE SOFTWARE PROVIDED
ALONG WITH THIS AGREEMENT (THE "SOFTWARE"). BY CLICKING "I ACCEPT THE TERMS IN THE LICENSE
AGREEMENT", YOU AGREE TO THE TERMS OF THIS AGREEMENT AND TO THE GENIE-SOFT PRIVACY POLICY,
WHICH IS INCORPORATED IN THIS AGREEMENT AND CAN BE FOUND AT GENIE-SOFT'S WEBSITE
HTTP://WWW.GENIE-SOFT.COM/ABOUTUS/PRIVACY.HTML). IF YOU DO NOT AGREE TO THE TERMS OF
THIS AGREEMENT, IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY DELETE AND
DESTROY ALL COPIES OF THE SOFTWARE.

Versions of the Software

There are two versions of GENIE BACKUP MANAGER EDITION (registered and evaluation), each of which is
subject to this Agreement. UPON ORDERING, DOWNLOADING, INSTALLING OR USING ANY VERSION OF THE
SOFTWARE, YOU ARE REAFFIRMING THAT YOU ARE BOUND TO THE TERMS OF THIS AGREEMENT.

The registered version requires registration with Genie-Soft.com Corp., Which includes payment of the then
current license fee. The evaluation version is the only version that is provided without charge; however, the
evaluation version is not free software. All rights and licenses to the evaluation version automatically expire
30 days after first installation, after which you must register with Genie-Soft.com Corp. and pay the then
current license fee. Payment must be in US dollars drawn on a US bank. For details on registration methods,
please refer to the help file in the software, or contact Genie-Soft.com Corp.

License to Use

One copy of the evaluation version of GENIE BACKUP MANAGER EDITION may be used by a single person
for evaluation purposes without charge up to 30 days. Subsequent downloads of the evaluation version by
or for the same user do not extend, renew, or otherwise restart the term of the license for the evaluation
version.

One copy of the registered version of GENIE BACKUP MANAGER EDITION may be used by a single person
who uses the software personally. The registered version of GENIE BACKUP MANAGER EDITION may not be
rented, loaned, leased, licensed, or otherwise used, by anyone other than the individual who has registered
the software.

Site licenses for GENIE BACKUP MANAGER EDITION may be obtained from Genie-Soft.com Corp which cover
multiple users at one location or multiple users within a business entity.

You may make a reasonable number of copies of the registered version of the software for backup and
archival purposes. You also agree that you may not reverse assemble, reverse compile, or otherwise
translate the Program.

No Additional Licenses

All rights to the GENIE BACKUP MANAGER EDITION software and documentation not expressly granted
under this Agreement are reserved to Genie-Soft.com Corp. You may not translate, decompile, disassemble
or reverse engineer the GENIE BACKUP MANAGER EDITION software or documentation.

Costs of Litigation.

If any action is brought by either party to this License Agreement against the other party regarding the



subject matter hereof, the prevailing party shall be entitled to recover, in addition to any other relief
granted, reasonable attorney fees and expenses of litigation.

Disclaimer of Warranty

THIS SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER
EXPRESSED OR IMPLIED. BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO
WHICH GENIE BACKUP MANAGER EDITION MAY BE USED, NO WARRANTY OF FITNESS FOR A PARTICULAR
PURPOSE IS OFFERED. IN PARTICULAR, GENIE-SOFT.COM CORP SHALL HAVE NO LIABILITY FOR ANY DATA
STORED OR PROCESSED WITH THIS SOFTWARE, INCLUDING THE COSTS OF RECOVERING SUCH DATA. THE
USER MUST ASSUME THE ENTIRE RISK OF USING THIS PROGRAM. ANY LIABILITY OF GENIE-SOFT.COM
CORP. WILL BE LIMITED EXCLUSIVELY TO PRODUCT EPLACEMENT OR REFUND OF PURCHASE PRICE.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
IN NO EVENT SHALL Genie-Soft OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
PROFITS, BUSINESS INTERRUPTION, CORRUPTION OF FILES, LOSS OF BUSINESS INFORMATION OR ANY
OTHER PECUNIARY LOSS) REGARDLESS OF CAUSE OR FORM OF ACTION, INCLUDING CONTRACT, TORT OR
NEGLIGENCE, ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF
Genie-Soft HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES AND
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY OF CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

Genie-Soft'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY UNDER THIS END USER LICENSE SHALL NOT
EXCEED ONE DOLLAR (US $1.00).

USE OF THIS PRODUCT FOR ANY PERIOD OF TIME CONSTITUTES YOUR ACCEPTANCE OF THIS AGREEMENT
AND SUBJECTS YOU TO ITS CONTENTS.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES SO THIS LANGUAGE MAY
NOT APPLY. IN SUCH CASE, GENIE-SOFT.COM INC'S LIABILITIES WILL BE LIMITED BY THE ABOVE
LIMITATION OF REMEDIES PROVISION.

US GOVERNMENT RESTRICTED RIGHTS

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision
(b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 25 2.227-7013.
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GBM System Requirements

Windows 2000 Server:

e Hard drive with at least 25MB free disk space for installation
e 512 RAM
e IE 6 or higher

e 133 MHz processor or faster

Windows 2003 Server:

e Hard drive with at least 25MB free disk space for installation
e 512 RAM
e IE 6 or higher

e 233 MHz processor or faster
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How to: Install Genie Backup Manager

Installing from the downloaded file:

Run the downloaded .exe file and follow the on-screen instructions to install GBM.

To install from CD:

1. Insert the CD into your CD-ROM drive. Setup.exe will automatically be run. (If this fails to work, double
click the .exe setup file on the CD).

2. Follow the on-screen instructions.
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How to: Register Your Copy of GBM

Upon purchasing a GBM license, the user will receive an email containing a serial number for unlocking the
software and removing the trial period limitation.

To register GBM before the end of the trial period:

1. Start GBM.
2. From the toolbar, click Help then select Registration .

3. Type or copy-paste the serial number into its designated field then click OK.

Genie-5oft Product Registration

ﬂ GENIE BACKUP MANAGER
GEMIE- SOFT 8.0 TRIAL VERSION

Thank you for tving Genie B ackup tanager

You have 24 DAYS LEFT to trp Genie Backup Manager. If pou wish bo uze it
beyond thiz penod, click the "Buy anling row" link,

G Evaluate

:E?‘% Enter Serial Number

Don't have a senal number?
@ Euy online now. ..

@ Reqgiztration help 9 Quit

24 dayz remaining

To reqgister GBM at a later date (30+ days after installation):

1. Start GBM.

2. A dialog will appear instructing you to register your software. Select Enter Serial Number then insert
your registration code..

Online Registration



Registering your copy of GBM online after purchase will entitle you to receive prioritized technical assistance
via email (within 24 hours), MSN messenger and ICQ live online support and special discounts on other
Genie-Soft software titles and future releases.

Online registration is done by filling the online registration form on the Genie-Soft web site.

How to register GBM online?

1. Start GBM.

2. From the left navigation menu in the main screen select Online Registration.

3. Click Sign Up Now.

4. Follow the instructions on the registration page.
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How to: Check for updates

The Genie-Soft support team regularly post updated builds of GBM with minor enhancements and fixes for
known issues. Registered users of GBM can use the Genie-Update tool to download the latest updates for the

software free of charge.

To check for updates:

1. From the Tools menu in the main screen, select Genie Update.

2. Select Next.

3. Follow the on-screen instructions.

ﬁ Genie Update Manager El

Please wait while GBM connecks to Genie-soft servers and checks Far
updates..

ﬁ Genie
U pd atE Products:

- Genie Backup Managet Server Edition 3.0

Skatus:
Getking update status...

Estimated time left;
Transfer rate:

E;__—_'l GeniE - soft
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Open File Backup Agent's System Requirements

Supported Platforms:

Microsoft Windows 2000 and above (Windows 2000/2003 / XP / Vista), running on Intel-compatible
processors.

Windows 2000:

e Hard drive with at least 20MB free disk space for installation
e 64 RAM
e |E 5 or higher

e 133 MHz processor or faster

Windows 2000 Server:

e Hard drive with at least 20MB free disk space for installation
e 256 RAM
e |E 5 or higher

e 133 MHz processor or faster

Windows 2003 Server:

e Hard drive with at least 20MB free disk space for installation
e 256 RAM
e |E 5 or higher

e 133 MHz processor or faster

Windows XP:

e Hard drive with at least 20MB free disk space for installation
e 128 RAM
e |E 5 or higher

e 233 MHz processor or faster



Windows Vista:

Hard drive with at least 25MB free disk space for installation

512 RAM

e IE7

1 GHz Processor or faster
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How to: Install Open File Backup Agent

To install OFB from the Internet:

1. Run the setup file from the location to which you've downloaded it.
2. Follow the on-screen instructions.

3. Restart the computer.

To install OFB from a CD:

1. Close all programs.

2. Insert the CD labeled Genie Backup Manager into your CD-ROM drive.

3. From the Start menu, Select Run.

4. Type D:\OFB\OFB_setup_Final.exe (Substitute the appropriate letter of your CD-ROM drive for D).
5. Follow the on-screen instructions.

6. Restart the computer.
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How to: Register Open File Backup Agent

Upon purchasing a Open File Backup license, the user will receive an email containing a serial number for
unlocking the software and removing the trial period limitation.

To register OFB before the end of the trial period:

1. From the toolbar, click Help then select Register OFB Agent.

2. Type or copy-paste the serial number into its designated field then click OK.
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Upgrade to the New Version of Genie Backup Manager

If you already own an older version of Genie Backup Manager and wish to purchase the latest, or if you wish
to upgrade to a more powerful edition, you are entitled to an "upgrade discount”. Please follow the link
below for more information about upgrading options and pricing.

http://www.genie-soft.com/products/upgrades.html
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How to: Install GBM as an Upgrade

When installing Genie Backup Manager as an upgrade, there is no need to uninstall previous versions first;
GBM files will be copied to a different directory as an independent product, without causing any conflicts.
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How to: Import Data Backup Jobs from Previous Versions

The First time you run GBM 8.0 it will scan for Data Backup jobs from older versions and will prompt the user
whether or not would like to import. However, you can manually import from selecting Import Previous
Jobs from the File menu in the toolbar, then follow the on-screen instructions. This imports job
configurations, settings, and unattended scheduled tasks, but it will not import catalog records for version
6.0.

Only backup jobs created using Genie Backup Manager 6.0 and 7.0 can be imported, and the first execution
of a backup job after it has been imported from version 6.0 will run as a full "Normal" backup, regardless of
the backup type selected and also mirror and incremental with rollback disabled backups created in version
7.0, to ensure consistency; backup jobs imported from GBM 7.0 will continue running without reverting to

full backup

Note:

SQL and Exchange jobs will not be imported
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How to: Restore Backups Created Using Older Versions

GBM 7.0 backups will be restored directly from GBM 8.0; however, if you've upgraded from Genie Backup
Manager Version 6.0 to version 8.0, you can follow the steps below to restore backups created using the old

version:
1. From the toolbar select File, then select Version 6.0 External Restore Utility.
2. Select Browse and locate the backup set you wish to restore data from.
3. Select Next.

4. Select the data items you wish to restore then click Finish.
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What Can GBM Do?

Genie Backup Manager is a powerful backup and restore utility designed to backup your personal files,
folders and settings. However, although this is an important part of disaster recovery, GBM is not intended to
recover from a complete system failure in the normal backup procedure; Microsoft Windows needs to be
installed and running properly in order for Genie Backup Manager to restore your data and settings.

Private users only need to back up files that they have created or modified themselves. Computers use both
program and data files; programs can be reloaded from the original discs, but your data can only be
reloaded from backup copies, which is where Genie Backup Manager comes into play.

Although Genie Backup Manager can reset the archive bit/flag of copied files during backup, determining
which files have been modified since the last backup run is done using the file's last modified date and time
attribute. This ensures that backup jobs are mutually independent, i.e. backing up a certain file with one
backup job does not prevent it from being backed up again by another.

Genie Backup Manager is now enhanced with Disaster Recovery feature that enables you to recover your

Windows installation after it becomes unstable or inoperable. Genie Disaster Recovery backs up what is
needed to recover a system; reducing backup time and space to ensure faster recovery time of system

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Managing Backup Jobs

Copying an Existing Backup Configuration

Duplicate existing backup job and then easily modify its configuration. To do so, click Tools from the
application's toolbar, select Jobs Manager, select a backup job, then click Clone job.

Editing a Backup Job Configuration

You can use the Edit Previous Jobs button in the application’s main window, then select a backup job to
modify its configuration. Another possibility would be to click Backup from the main window, and go to the
Job info page, select Edit Job, select a backup job from the list and click Load.

When the Properties window opens, go to the page with the settings you want to modify.

Deleting a Backup Job

Click Tools from the application's toolbar, select Jobs Manager, select a backup job, then click Remove.
The catalog entries for deleted backup jobs will be removed, but files and folders from the source and
destination will not be deleted.

Rename a Backup Job

Click Tools from the application's toolbar, select Jobs Manager, select a backup job, then click Rename...
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Data Backup Types

There are four basic types of backup supported by GBM. Selecting the best backup type for your purposes
depends on the storage media used, disk space considerations, and file versioning needs. Note that these
backup types do not apply to Microsoft Exchange Server and SQL Server, both of which have separate
backup types of their own. For more information please refer to SQL Backup Types and Exchange Backup

Types.

Full

Backup all selected files and folders every time backup is executed. A new independent backup set will be
created replacing files from older runs, unless the user explicitly opts to keep them by changing file purging

settings.

o Full backup takes the longest time among all backup types.
o Best used for one-time backups, such as for migrating personal files to a new computer.
Incremental

Backup only files that have been added or modified since the last backup. Files that were deleted, renamed
or moved from the source machine will not be deleted from the backup archive.

o The first backup run will automatically backup all selected files and folders (i.e. run as if full backup
was selected).

o Incremental backup with the rollback option enabled is best for spanning backed up data over
multiple storage volumes, such as CDs and DVDs, and for online and FTP backup.

o Over time, incremental backup requires less space and time than differential backup, however, it

requires more time during restore, and all volumes containing previous increment versions and the
most recent full backup must be available.

Mirror

Backup only files that have been added or modified since the last backup. OIld versions of files will be
replaced with newer ones and missing files will be deleted from the backup set.

o The first backup run will automatically backup all selected files and folders.

o Mirror backup is best for keeping an exact "mirror" copy of the original data on external hard disks,
or on a file server, and when access to old versions of files is not required.

Differential



Backup only files that have been added or modified since the most recent normal (full) backup.

) The first backup run will automatically backup all selected files and folders.

o Over time, differential backup requires more space and time than incremental backup, however,
restore takes less time, and only the volumes containing the last differential backup and the most
recent normal backup are required.

o Best for spanning backed up data over multiple storage volumes, such as CDs and DVDs.

Note:

For a complete comparison between backup types, please refer to the following knowledgebase:

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=76
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Data Verification

Verification ensures that backed up data was successfully written on the storage media and that it can be
restored reliably. Genie Backup Manager will by default verify backed up data immediately after the backup
task is completed. Users can also choose to test data integrity of a backup archive at a later time using the

Testing Data Inteqgrity tool.

Testing data integrity can be done using one of two methods in Genie Backup Manager, these are:

Bit-by-bit verification: This is the default method used by GBM to verify that a backup archive is
restorable, and the data contained within it is not corrupt. This is done by reading every bit of each
backed up file, however, this verification method does not compare data to make sure that the backed
up and original versions of files are exactly identical. This means that if the contents of a file in the
backup archive were modified after backup, Genie Backup Manager will not detect it.

CRC check verification: CRC is short for (Cyclic Redundancy Check); a very powerful technique to
obtain data reliability. The CRC is one of the most used techniques for error detection in data
communications and file verification.

When this verification method is used, Genie Backup Manager will generate a table of CRC values for
all the selected files during backup. Come verification time, a new CRC table is generated for the data
stored in the backup archive, and the CRC value for each file being verified is compared against its
counterpart in the original table created during backup. If a file passes CRC check, that means that it
can be restored reliably, and that it is exactly the same as the file that was originally backed up.
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File Versioning in Genie Backup Manager

Genie Backup Manager is great tool for maintaining numerous versions of backed up files; selecting
incremental backup with rollback or differential backup will ensure that each time the backup job is run,
updated files are appended to the backup set instead of replacing older versions.

The catalog feature allows users to browse through all versions for any given backup job, sorted by date,
and enables them to restore (rollback) all or some of their files to the state they were in, at the point in time

that backup was executed.

Users can also limit the number of backup versions Genie Backup Manager should keep per backup job, in
order to preserve disk space. This is done by configuring Purging settings.
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Security in Genie Backup Manager

Genie Backup Manager offers multiple levels of protection to ensure that backed up data is not accessible to
unauthorized persons. ZIP passwords offer moderate protection for compressed backups, with the added
flexibility of being compatible with most compression utilities, to allow users to manually restore data from
backup archives, while AES (Advanced Encryption Standard) encryption has the advantage of being highly
secure, as it is adopted by NIST(National Institute of Standards and Technology) as an FIPS-approved
(Federal Information Processing Standard) symmetric encryption algorithm that may be used by U.S.
Government organizations (and others) to protect sensitive information

Our online backup solutions enjoy an added level of protection, through username and password encryption,

as well as 128- bit Secure Socket Layer (SSL) data transmission, certified by the leading global provider of
SSL certificates, Thawte.
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Compression in Genie Backup Manager

Genie Backup Manager uses non-proprietary ZIP64 compatible compression to reduce backed up data size
and save space, supporting up to 264 -1 files within a zip archive as well as files that have a size greater
than 4GB, for a zip file size that can reach up to about 18 million terabytes (more precisely, 27°64-1 bytes).

The Genie Backup Manager compression engine offers fast performance and low memory usage. Speed
improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better compression than
other formats on many popular file types, especially XML data.

Users can choose between 9 levels of compression starting from no-compression, which packs the entire
backup neatly within a single file, but without the overhead to the backup speed added by compression.

Backup without Compression

Choosing to backup data without compression causes GBM to copy the data to a single folder on the storage
device while preserving the original folder tree structure, this makes data more accessible and less
susceptible to corruption.
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Files Created by GBM Locally

Genie Backup Manager creates a variety of temporary and permanent files and folders on the machine on
which its running during its various operations that are either intended to be used by the user or for the
program's internal use.

Job-related files and folders

When a new backup job is configured, the wizard creates a "JobSettings.dat" file in a folder carrying the
same name as the backup job (usually in C:\Documents and Settings\<user=>\Application Data\Genie-
Soft\GBMAPPLICATION).

In addition, GBM also creates subfolders in the same location for each backup execution starting with a

folder named "00000000" for the first backup run, and a new folder with the name incremented by one for
each subsequent execution. Each folder contains catalog information for the corresponding backup run.

Temporary folders

Genie Backup Manager creates a temporary folder at the start of each session to store transient files and
folders that are created during the program's operations, such as data waiting to be written to CD or DVD, or
data being encrypted or compressed etc.

e Temporary session folder will be deleted when the session is closed (upon exiting main application).

e Unless otherwise specified by the user, GBM will look for the local drive with the most free disk space
and select it for storing its temporary folders and files.

e Temporary files created during a backup run will be deleted when backup is complete.

Logs

Genie Backup Manager provides a log engine that helps you track backup, restore and test operations. It
also offers advanced logs for tracking and debugging backup operations, tape operations, and volume
shadow copy snapshots. For more information on each of these logs and how to access them, please refer to
the Logs and Reports section.
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Files Created on the Backup Destination

This is a list of the most important files that Genie Backup Manager might create on the backup destination,
along with a description of what each folder/file type signifies:

.gbp

The .gbp file type is associated in Windows with Genie Backup Manager, and it represents the file that the
user needs to select in order to load the backup for restore. This file is recreated at each backup execution.
When backup is executed with compression enabled, the file with the extension ".gbp" will represent the
main backup output file containing the entire backup archive along with GBM's internal use files. If data was
forced to split, such as in the case of multiple media spanning, this will be the last file in the set.

In case of backup with compression disabled, GBM will create a file called Main.gbp in the uncompressed

backup folder at each backup execution, which will only serve as a link to the index.gix catalog file, located
in the same folder, that holds the necessary information for restoring the data from the backup archive.

.c00<X>

This file type represents a split in a compressed backup archive; this occurs when a single compressed
archive is divided into multiple linked portions, sequentially numbered starting with .cO00 to cO0X, where X
is the number of split compressed file parts. The last file in the set is always the file {backup job
namet}.gbp.

.N00<x>

This extension represents a source file that has been split during a backup execution with compression
disabled.
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How to: Start Genie Backup Manager

Before you start, make sure that your backup devices have been detected and are configured correctly
without conflicts.

To start Genie Backup Manager...

e Click Start , point to Programs > Genie-Soft, and then click Genie Backup Manager 8.0.

e If you have selected the option to add an icon to your Quick Launch bar when you installed the
software, you can click that icon to start Genie Backup Manager.

e Double click the Genie Backup Manager system tray icon E
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The Welcome Screen

The welcome screen is the first window that opens when the user runs GBM. This window contains links to
tutorials and helpful information and tips for using Genie Backup Manager.

To open the welcome screen at any time click Help in the toolbar then select Welcome Screen. To
suppress the welcome screen remove the checkmark next to Show welcome screen at startup.
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The Grand Tour

If you are a first time user of Genie Backup Manager, it is recommended that you watch the backup tutorial
to become familiar with the software and its interface. The tutorial will simulate the creation of a backup job
and guide you through the backup wizard screens. Other tutorials are available and can be accessed from
the Welcome screen.

To view the Genie Backup Manager flash tutorial select Take a Tour from the applications main window.

Failing to View the Tutorial

If the tutorial fails to play, you might need to install the latest version of the Macromedia Flash Player. You
can download the latest version of Flash Player from the Macromedia website by clicking the link below:

http://www.macromedia.com/shockwave/download/download.cqi?P1l Prod Version=ShockwaveFlash
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http://www.macromedia.com/shockwave/download/download.cgi?P1_Prod_Version=ShockwaveFlash

Shortcuts

The most important functions in GBM are assigned keyboard shortcuts for increased accessibility.

+ Backup Wizard Shortcuts

*'Main Window Shortcuts

* Miscellaneous Shortcuts
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Selection Panes

Selecting data for backup or restore in GBM is done using a Windows-Explorer-like interface. Selection panes
are used to select or deselect files, folders, and various items and settings.

When an item from the left pane is highlighted its contents will be displayed in the right pane, to refine the
selection if necessary.

A plus sign means that the listing can be expanded to display additional items.
A minus sign means that the listing can be collapsed to hide displayed items beneath it.

An empty check box means that the item can be selected but is currently not.

A check box with a blue or green check mark means that the item is selected with all its
contents.

A gray check mark means that some but not all of the item’'s contents have been selected.

] H E D T

A grayed out check box means that the item is not available or not selectable; if the item has an
Expand/Collapse box then the user needs to expand the listing to be able to select its contents.

e
£

My Folders Selection Options

Right-clicking on any item (file or folder) in the right-hand pane in My Folders tab and selecting Selection
Options presents the user with several options for selecting files and folders, these are:

e Select All: Select all items in the pane

e Clear All: Deselect all items in the pane

e Select Files Only: Only select files appearing in the current view

e Select Folders Only: Only select folders appearing in the current view

e Invert Selection: Invert the selection in the current view (unselected items will be selected, and
selected items will be deselected)
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Accessibility

Microsoft Windows offers "Accessibility Options" that make it more eye-friendly for people with visual
disabilities. They allow you to modify the display to make it easier to work with the computer.

GBM supports visual accessibility options; changing Windows appearance will change GBM's user interface

making the software more readable for people with color blindness, weak vision etc...

e GBM needs to be restarted before changes in visual accessibility options are applied.
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Windows and Dialogs

Most windows and dialogs in Genie Backup Manager can be resized to fit the users preference. The minimum
dimensions for the main window is 740X570, hence it is recommended to set the display resolution to
800X600 or more in order to be able to see the entire contents of any window.

When a pane or window is not resizable and part of its contents is hidden, scroll bars will appear enabling
the user to view the concealed parts.

GBM by default remembers the location and size of the main window upon exiting the application so that
these attributes would be retained the next time GBM is started. To disable this feature, click the Tools
menu command, select Global Preferences, select General, then remove the checkmark next to Save
window location on exit.
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Job Summary

During the creation or modification of a backup job, the lower-left corner of the backup wizard will provide a
summary of the backup job's settings, this include:

Job Summary

Job Mame:

Sunday Backup

Media Type:CD/DVD
Backup Type: Incremental
Compression: res
Security Type:

AES 286 bit Encryption
Selected data:
Eztimated zize:6.53 GB
Eztimated items: 40531

¢ Job name: Name assigned to the backup job.
e Media Type: Media selected for storing the backup.

e Backup Type: Full, increment, mirror or differential (backup all selected files or new and changed
files).

e Compression: Compression setting (with or without compression).
e Security Type: Type of security setting used (None, zip password protection or encryption).
e Estimated size: The total estimated size of selected items.

e Estimated items: The estimated number of files selected for backup.
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Wizards Overview

GBM adopts wizard-like interfaces for its three main functions: Backup, Restore, and Scheduling unattended
backups. Each of these will be described in details later on.

Each wizard is comprised of a series of dialog boxes guiding the user through the steps required to perform
the task, all the user has to do is choose the appropriate options in each dialog and then click Next to
proceed to the following step. At any point, the user can click the Previous button to correct or modify
selections made in previous dialogs.
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Getting Help

GBM users can seek assistance regarding the use of the various functions and features of the software using
several different help resources, which include:

o Offline Help

. Online Technical Support
. The Knowledge Base

. Community Forums

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Exiting GBM

To exit GBM do one of the following:

e From the File menu in the toolbar select Exit.
o Press <ALT + F4>.
e Click the X button on the top right corner of the program.

Attempting to exit will open a dialog asking the user to confirm the request

Suppressing the quit confirmation dialog

Registered users can suppress the quit confirmation dialog, to do so:

1. From the toolbar, select Tools, then select Global Preferences.
2. Select General.

3. Remove the checkmark next to Confirm quit dialog box.
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The System Tray Agent

The System Tray Agent is a service that runs in the background and displays an icon E in Windows System
Tray to allow quick access to the following Genie Backup Manager functions:

e Starting Genie Backup Manager.

e Obtaining status reports on your recently performed backups.

e Controlling Open File Backup Agent.

e Creating a new backup job.

e Editing an existing backup job by selecting one from a list.

e Silently running a backup job (Run Backup).

e Running a backup job and shutdown the computer automatically immediately after backup is
completed.

e Checking for updates for Genie Backup Manager.

e Enabling and disabling pop-ups

To start the GBM System Tray Agent, click Start, point to Genie-Soft, point to Genie Backup Manager
8.0 Tools, then click Genie Agent.
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How to: Set the Genie System Tray Agent to Run at Startup

1. Go to Start > Genie-Soft > Genie Backup Manager 8.0 Tools > then click Genie Agent.

2. Right click the Genie Agent icon in the system tray E then select Settings.

3. Make sure Start agent when my computer starts is checked.
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System Tray Agent Settings

To open the GBM agent settings dialog right click on the Genie Backup Manager icon in the system tray then
select Settings.

- General .
H General Settings

v Show notifications

v Start Agent when my computer starts

Cancel Done

e Show notifications: Display GBM agent notifications.

e Start agent when my computer start: Run the GBM system tray agent as a process at startup.



OFB Settings
v Allow Metwork Access to this computer

OFB “ersion: 3156

Cancel | Done |

e Allow network access to this computer: Allow remote computers connected via LAN to use Open
File Backup Agent to backup open files on this machine.
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How to?
Genie Backup Manager

How to: Install Genie Backup Manager

How to: Register Your Copy of GBM

How to: Check for updates

How to: Install GBM as an Upgrade

How to: Import Backup Jobs from Previous Versions

How to: Restore Backups Created Using Older Versions

How to: Start Genie Backup Manager

Open File Backup Agent

How to: Install Open File Backup Agent

How to: Register Open File Backup Agent

The System Tray Agent

How to: Set the Genie System Tray Agent to Run at Startup

Catalog

How to: Back up the Catalog

Local/LAN

How to: Restore from a Local Drives

How to: Enable OFB Agent to Backup Open Files on Remote Locations

How to: Restore Data Stored on Network Locations

Tape

How to: Restore Data Stored on Tapes

FTP

How to: Restore Data Backed Up Using FTP,

Online Backup

How to: Restore/View Online Backups

How to: Purchase Extra Online Space

How to: Delete Online backups




Optical Media

How to: Restore from Optical Media

Removable Media

How to: Restore from Removable Media

System State

How to: Backup System State

How to: Restore System State

How to: Restart the Domain Controller in Services Restore Mode

Outlook

How to: Backup MS Outlook Data

How to: Backup While MS Outlook is Running

How to: Restore Outlook Data

Outlook Express

How to: Backup Outlook Express

How to: Backup while Outlook Express is running

How to: Restore Outlook Express Data

How to: Synchronize Outlook Express Mail Folders

How to: Synchronize Outlook Express Settings

How to: Extract mail folders directly from a backup

How to: View Backed Up Emails

Windows Mail

How to: Backup Windows Mail Data

How to: Restore Windows Mail Data

Windows Registry

How to: Back Up the Entire Reqgistry

How to: Back Up Selected Registry Keys

How to: Restore Windows Registry

Desktop



How to: Back up Desktop ltems

How to: Restore Desktop Items

My Documents

How to: Back Up My Documents

How to: Restore My Documents Folder

Windows Address Book

How to: Back Up Windows Address Book

How to: Restore Windows Address book

How to: Synchronize Windows Address Book Contacts

Windows Contacts

How to: Backup Windows Contacts

How to: Restore Windows Contacts

Windows Favorites

How to: Back Up Windows Favorites

How to: Restore Windows Favorites

Windows Fonts

How to: Back Up Windows Fonts

How to: Restore Windows Fonts

My Media

How to: Use playlists to backup media files

How to: Automatically scan for media files

How to: Restore Media Files

My Photos

How to: Back Up Images and Photos

How to: Restore Images and Photos

Windows Settings

How to: Back Up Windows Settings

How to: Restore Windows Settings




My Folders

How to: Create New File Filters

How to: Import and export file filters

How to: Restore Files and Folders

How to: Restore to a Different Location

My Plugins

How to: Back Up Programs and Program Settings

How to: Compile a Plugin Script

Settings

How to: Create a Quick-Backup Shortcuts on the Desktop

Scheduler

How to: Rotate Backups using Advanced Scheduling

SQL

How to: Register MS SOL Plugin

How to: Backup SOL Server Data

How to: Connect to the Database

How to: Start the Database in Single-User Mode

How to: Restore a Transaction Log Backup

How to: Restore a Differential Database Backup

Exchange

How to: Register MS Exchange Plugin

How to: Backup Exchange Server Data

How to: Restore an Incremental or Differential Backup

Restore

How to: Load Backup from the Archive

How to: Load Backup from the Catalog

How to: Restore/View Online Backups




How to: Restore Data

Disaster Recovery

How to: Create Genie Disaster Recovery Bootable CD/DVD disc

How to: Create Genie Disaster Recovery Backup

How to: Restore Disaster Recovery Job

E-mail Notification

How to: Activate E-mail Notification

How to: Send Email Notifications

Genie Script

How to: Create a Plugin using XML tags

How to: Create a Plugin using Plugin Creator

GRunScript

How to: Create a Backup Job Script

How to: Run a Scripted Backup
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Main Window Commands

The main window contains a selection of the most important Genie Backup Manager functions.

Main Commands

ﬁ Backup

Starts the new backup wizard.

s_ Restore

Starts the restore wizard.
s» Disaster Recovery

Starts the disaster recovery wizard

\;i Catalog
Starts the catalog.

*Q}) Edit Previous Johs

Opens a list of available backup jobs which the user can choose from to edit a backup job's
configuration.

@ Online Backup Account

Manage/Restore/View online backup jobs

Enables you to View/Restore and Manage your online account

Tools

& Run Backup
execute a backup.

P Opens a list of available backup jobs which the user can from to quickly



%] Global Preferences  _ Opens Genie Backup Manager's preferences dialog.

'/_"| == B Opens the Test Data Integrity window.

™ Genie Update - Opens the GBM automatic update window.

20| ke o T - Opens a flash-based walk-through for configuring a new backup job in Genie

Backup Manager.

Quick Links
B Direct link for purchasing GBM online.
"= My Account -Direct link to My Account for online registered users
##% Backup Encydopedia - Opens the Backup encyclopedia.
&Y Online Registration - Register your copy of GBM online.

) Oriine Support - Contact information for the Genie-Soft technical support team.

& LLsiiis - Opens the Genie-Soft home page in your default Internet browser.

&‘ Free Plugins - Opens the Genie-Soft Plugins database page to download free GBM Plugins.

Menu Commands

Menu Item Function
File Backup Wizard Open the backup wizard.
Restore Wizard Open the restore wizard.
Online Restore Wizard Restore backups stored on the Genie-Soft online backup
server.
Tape Restore Wizard Open the tape restore wizard.
Scheduling Wizard Schedule a backup job to run unattended.
Cataloging Open the backup Catalog library.
Default Backup Folder Browse the default location used by GBM for storing

backups.



Tools

Help

Import Previous Jobs

Version 6.0 External
Restore Utilities

Test Backup

Advanced Search

Jobs Manager
Logs Manager

Online Login

Start GBM Agent
Format Re-Writable
CD/DVD

Undo Plugin Restore

GenieScript Compiler

Tape Operations

Global Preferences

Contents

Backup Encyclopedia

Welcome Screen
Supported Recorders

Genie-Soft Home Page

Check for Updates
About

Registration

Import backup jobs created by version 6.0 of Genie Backup
Manager.

Open an external utility for restoring backups created using
Genie Backup Manager 6.0.

Test a backup set's data integrity to ensure it can be
restored reliably.

Search the catalog library or a backup archive for
previously backed up files.

Open the backup jobs manager window.
View, print and manage your backup logs and reports.

Open a dialog to enter your Genie-Soft's online backup
credentials.

Run the Genie Backup Manager monitoring agent in the
system tray.

Quick-erase or fully format CD/DVD media.

Uninstall programs previously restored using My Plugins.
Open the GenieScript script compiling utility.

Tools for erasing, adjusting tape tension, and ejecting
tapes.

Open the Global Preferences window to edit general and
advanced Genie Backup Manager settings.

Open the Genie Backup Manager help documentation.

Open Genie-Soft's free Backup Encyclopedia project web
site.

Open the welcome screen.

Opens your default internet browser to the Genie-Soft web
site.

Credits and basic information about the product.

Open the Genie Backup Manager registration dialog to
enter your serial number and unlock the software.



Register OBF Plugin Open a dialog to insert your Open File Backup agent serial

key.
How to register Open help page on how to register your copy of GBM.
Technical Support - Contact information for getting in touch with Genie-Soft
Contact Us support team to receive technical assistance.
How-To A list of links to the most important how-to help pages.

To access a program menu item using the keyboard

1. Press <ALT=>. This will highlight the File menu in the toolbar.

2. Use the right and left arrow keys to move horizontally between menus and the up and down arrow
keys to move between items inside each menu.

3. Press <ENTER=> to activate the selection.

Backup Summary

The backup summary panel displays a summary report for the most recently performed backup. It also offers
quick access links for viewing the complete backup report as well as re-running the backup.

Backup Status: Status

Last Backup: test summary

Backup Media: Local/LAMN

Date & Time: 2/26/2008 11:32 aM
Type of Backup: Incremental

Size: 110,16 ME

skipped Files: 0

Result: Backup completed successfully

Run test summary
Show Backup Log

Total Mo. of Jobs; 2
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The Backup Wizard

Users can create backup jobs in Genie Backup Manager using
These are the steps that you must confirm in the backup wizard:

Backup Category: Choose what type of data you Wish to backup; data, Microsoft SQL, or Microsoft
Exchange Server

Jobs info: Enter the name of the backup in the Backup Job Name field. You can select Edit existing
backup job to select a previously created backup job and modify its configurations.

To create a shortcut on the Desktop area for quickly running a backup job, select Create quick backup
shortcut on desktop. Click Backup Filename Options if you wish to append a time stamp to the end of
the output backup archive. Click Next to go to the following step.

Where to backup: Select the storage device on which you wish to store your backup. Checking the radio
button next to the desired backup destination option will display a group of settings related to that
destination in the lower box. Click Next to go to the following step. See Backup Devices.

What to backup: Select the files and folders you wish backup. User data is divided into three categories to
make it more manageable during backup and restore: My Profile, My Folders, My Plugins, My SQL, and
My Exchange. Click Next to go to the following step. See Data, Microsoft SOL, and Microsoft Exchange
Server.

Backup Settings: Sets advanced options, including: data backup type, compression, security, purging,
email notifications, pre and post job commands etc. Click Next to save the configurations and start backup.

Scheduling or CDP: At any point during backup job creation, you can click Schedule step 5, to schedule
the backup job for unattended executions. See Scheduler, CDP for SOQL, and CDP for Exchange.

Backup Progress: In this screen, backup progress displays the status of the backup job. See Backup
Progress

Genie Backup Manager provides a dynamic summary of information about the backup job at the bottom-left
corner of the backup wizard, which can be consulted before the backup execution.

Clicking the Main page button returns the user to the main application window without saving the backup
job configuration progress; a warning message will be displayed to the user..

To save the configuration during backup job creation without exiting the wizard or starting backup, click
Save Job.

Opening the Backup Wizard

e From the startup screen click the Backup button.

e From the Files menu, select Backup Wizard.

For each backup job you must specify at least the source files, folders, or other data items that you want to
backup (third wizard step), the rest of the options are not mandatory as they are set to default values, but



can be changed by the user.

The user can move between the wizard screens using one of the following ways:

e Clicking the Next button in the lower right corner, to go through all the wizard screens one at a time.
Clicking the Previous button takes the user one step back.

e By choosing the desired wizard screen from the Backup Steps menu on the left side of the screen.
This allows the user to skip steps that have been set before.
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The Restore Wizard

Using the Restore Wizard you can restore from a backup job. The restore wizard consists of two steps
(pages), from which users can configure what and how to restore. To open the restore wizard select click
the Restore button from the main window, or select the Files menu, then select Restore Wizard.

These are the steps that you must confirm in the restore wizard:

1. Select a file to restore (loading the backup): Select the backup archive you wish to restore data
from. Depending on the destination on which the backup is stored, select one of the following options
from the left menu:

e Select Backup Set: For selecting and loading a backup stored on disk-based media, or more
generally, any backup destination other than Genie-Soft's online backup servers, or tape media.
See the Restore section.

e Tape Restore: Select and load a backup stored on tape media. See Restoring from Tape
Media.

2. Data Selection: Select the files and folders you wish restore. User data is divided into three

categories to make it more manageable during backup and restore: My Profile, My Folders, and My
Plugins. Click Next to start restore.
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The Disaster Recovery Wizard

Users can create Disaster Recovery in two main steps:

1. Create Disaster Recovery Bootable Disk (One time only)

2. Create Genie Disaster Recovery Backup

Opening the Disaster Recovery Wizard

e From the startup screen click the Backup button.

e From the Files menu, select Disaster Recovery Wizard.
The user can move between the wizard screens using one of the following ways:
e Clicking the Next button in the lower right corner, to go through all the wizard screens one at a time.

Clicking the Previous button takes the user one step back.

e By choosing the desired wizard screen from the GDR Steps menu on the left side of the screen in the
Disaster Recovery backup job. This allows the user to skip steps that have been set before.
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Online Backup Account

From this page users can manage the whole online backup account. Login to My Account enables users to
connect to their online account and view the backed up jobs. Select a backup job or Genie drive and click
Restore/View to view the contents of the backed up or uploaded data to Genie Drive. Create Backup Job
opens the online backup wizard to create a new online backup Job.

If the Online Account is running out of space, you can Delete Selected Job, Delete all Jobs, or upgrade
your online plan from Need more space link.

Under Web Online Account Management, you can Manage My Workspace, which opens the online
backup web service. This Workspace enables you to create, edit, and view documents directly from the web
account, opens thumbnails of images and much more! For more information, please visit your online account
via web.



Global Preferences

The Preferences window houses the settings, preferences and configurations for GBM.

To open the Preferences window, do one of the following:

e From the toolbar click Tools, then select Global Preferences.

e From the Tools left-hand menu in the main screen, select Global Preferences.

Note: Settings selected from the preferences dialog will apply to all created backup jobs.
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Preferences: General

The General page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains general settings of the program.

|'.-i‘-.ut|:| update

Select the frequency at which GBM should automatically check for software updates. (This option is only
available for registered users). (Settings)

[T Confirn quit dialog box [registered wersion)

Causes GBM to prompt the user to confirm before closing the main application. This option is only available
for registered users.

W Associate the estension "gbp” with GEM in Windows

Associate the extension ( .gbp) with Genie Backup Manager in Windows; clicking a file with ".gbp" extension
will automatically load the backup and open the restore wizard within Genie Backup Manager.

¥ Save window location on exit

Remember the size and location of the GBM main window the next time it is run.

|—Temp|:|rary filez folder——

Specify a local folder for storing temporary files created by GBM during its various operations, See Files
Created by GBM Locally. (Settings)
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Global Preferences: General - Advanced

The Advanced page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains advanced settings for the program.

Backup Performance

Change backup performance for fazter backupsz or reduce
backup impact on computer

Guicker Backup Fazter Computer

J

Change Backup performance for jobs to either run Faster backups or reduce impact of backup on your
computer

Enable advanced logging for debugging [might zlow down
computer during backup)

Enable advanced logging. Used for trouble shooting purposes by the Genie-Soft technical support team.

Open GBM advanced logz folder

Open the folder containing Genie Backup Manager's advanced debugging logs.
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Global Preferences: General - Sound Alerts

The Sound Alerts page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to attaching sounds to various events in the program.

¥ Enable zound alerts

Enable associating sounds with Genie Backup Manager events.

¥ Enable sound alerts

Ewvents

B ackup finished successfully
B ackup finished with errors
Data verfication complete
Prompt to switch dizks

Teszting data integrity complete

List of GBM events that the user can add sound alerts to.

Altach zound to selected event

Enable sound alert for the selected event.

Browse...

Browse your computer to select a sound file to be associated with the selected event.

Play

Preview selected sound file.
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CPU Affinity

The CPU Affinity page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to CPU utilization management.

When you launch Genie Backup Manager, the system by default enables all processors (CPUs) for its
execution. CPU Affinity allows you to select what CPU(s) Genie Backup Manager can use while running.

If you notice that Genie Backup Manager uses CPUs a lot, you can limit its execution to only one processor
for example. To do this, select/deselect desired processor(s) with checkboxes in the dialog. Execution of
GBM on all non-selected CPUs will be disabled.

CPU Affinity is available on multiprocessor systems only.
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Preferences: Backup Settings

The Backup Settings page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to backup operations.

[] Ahwways dizplay backup log

Automatically display the backup activity log after each backup run.

Ahwans dizplay backup summary

Automatically display summary of results after each backup run.

[ Automatically claze Dutlook Express before backup

Close Outlook Express before each backup run, to avoid running into locked files during backup. (Settings)

[ Awtomatically cloze Outlook befare backup

Close MS Outlook before each backup run, to avoid running into locked files during backup. (Settings)

Show hidden files/folders in "My Folders"

Display and allow selection of files with hidden/system attribute in the file selection panes in My Folders.

After verification wait |10 : zecs then start backup automatically

After GBM confirms selections, wait X seconds before starting backup.

Default backup destination:

C:ADocumentz and Settingshzam'bdy Documentshbdy Backu

The default folder used for storing backups when a new backup job is created.
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Preferences: Backup Settings - Advanced Settings

The Advanced Backup Settings page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains advanced backup-related settings.

[] Prezerve sltemative D ata Streams [A05)

Preserve NTFS Alternative Data Streams even when data is backed up to a non-NTFS partition.

[] Uze CRC check to compare files [Slower)

Compares CRC output of each file in the backup set against the original file to ensure data integrity.

[C] Rename unicode files [Uszing GRename Technolagy]

When a filename is in unicode, rename the file using a unique GUID, to avoid problems restoring the data on
platforms that do not support unicode character sets. GBM will rename the file to its original name upon
restore.

] Backup ACL [Access Contral List]

Backup Access control list that specifies permissions when sharing.
Tape Settings

Tape backup related settings. (Controls)
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Global Preferences: CD/DVD Settings

The CD/DVD Settings page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains options pertaining to writing to optical media.

lze Joliet file zpstem

Select this option if you want to use filenames that contain up to 64 characters in length, including spaces.
This is the default option and is used to record most CDs/DVDs. Joliet also records the associated DOS-
standard name (8+3 characters) for each file so that the disk may be read on DOS systems or earlier
versions of Windows.

Juliet must be used if you want to use file names that contain up to 64 characters in length, including
spaces. Joliet also records the associated DOS-standard name (8+3 characters) for each file so that the CD
may be read on DOS systems or earlier versions of Windows.
1ISO9660 is used if you want to be able to read the CD on different platforms including DOS, Macintosh,
0S/2, Windows and UNIX. Files and directories recorded to CD based on the ISO 9660 standard must meet
the following (8+3) requirements:

¢ A file name may not contain more than eight alphanumeric characters and the underscore symbol [_].

¢ A file name extension may not contain more than three alphanumeric characters.

e A directory name may not contain more than eight alphanumeric characters and the underscore symbol

L1
Although using I1SO is supported in GBM it is strongly recommended that the user uses Joliet to avoid

running into file/folder naming compatibility problems. Otherwise, the user must manually make sure that
the naming convention of all selected files and folders are compatible with the 1ISO9660 standard.

Cache dizk image befare burning [CO-RAC0-AWw anly]

This option increases the reliability of backup to CD media by creating a temporary file on the hard disc that
is then written at once to disc. Caching, however, means that GBM will first copy the data to a temporary
local drive and then onto the CD, which adds a few minutes to the total running time for each disc.

e Caching is not supported on DVD.

e If GBM doesn't detect enough space to perform caching, data will be copied directly to the CD.

[[] Finalize disc [Ma further wiiting to the disk iz possible)

Close the CD/DVD media so that further writing to it is not possible. This is done by not recording the next
writable address in the last session's lead-in, so that in the next time the recorder attempts to write, it has
no way of knowing where to begin writing. Only finalize CDs if you are sure that you will not be appending

new backup versions to it.



lze "BURM Proof* techrology [if supparted by drive)

This technology helps prevent bad burns and CD/DVD creation errors, including buffer underrun and
trackwriter errors. This option might not be supported by all CD/DVD drives.

A Buffer Underrun occurs when the PC cannot deliver data fast enough to the drive's buffer. If the drive's
buffer empties because of the lack of data, the laser will turn off. The resulting gap on the media usually
renders a CD-R disc unusable”
The BURN-Proof feature is effective only for Buffer Under Run errors. Therefore this feature does not cover
the following cases

e Power outage or power disconnection.

e Malfunction or abnormality in PC / Application software.

e Impact on the drives or inferior condition of the media.

Import previous seszions on digk

If the CD contains more than one session, the most recent session is automatically imported so that it could
be updated with the new data.

Each time data is written to a CD/DVD disk a table of contents is written at the end of the session in order to
make the disk readable. This procedure is called session closing; data can still be appended to the disk after
a session is closed.

Genie Backup Manager will by default import previous sessions on the inserted disc before writing to it so as
not to lose existing data.

Disabling this feature causes GBM to write a new table of contents that does not refer to previously written
data on the disc, rendering that data hidden and inaccessible, but it will not free the space occupied by it.

If a file with the same name as the backup file already exists on the CD, GBM will rename the new file by
appending a trailing number, that is incremented by one for each new version of the file that is added.

Rename archive if a filedfolder with the same name exists

This option prevents accidental overwriting of previous backup jobs stored on the CD/DVD in case a file with
a similar file name already exists on it.

[] Simulate backup before committing data to disc

Do a backup simulation before burning data to disc to ensure that data can be written successfully.

Backup to CD/DVD media can be somewhat tricky, a scratched disc or incompatible writing speeds might
render a backup media set useless or corrupt. Now, you can set Genie Backup Manager to perform a backup
simulation to the inserted CD/DVD media to test whether the backup task will be carried out successfully,
before committing data to the media.



[ Eject last backup dise after the backup iz finizhed

When backup to optical media is performed, eject the last disk in the media set to alert user that backup is
finished.
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Global Preferences: Online Backup

The Online Backup page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains options related to the online backup functionality.

B andwidth Thrattling

Enable Bandwidth Thrattling
Lirnit hawe much of internet connection GEM uzes

This option enables you to limit the bandwidth used to upload to Genie Servers
tax Upload R ate: MaLimt = KB/

Maximum upload rate GBM can use to upload backed up files to Genie Servers
) dlways throttle

Always limit maximum upload rate

#) Throttle between these hours

Fram: | 12:00AM = Ta |[12:004M =

Limit maximum upload rate between these hours; otherwise, use full bandwidth

Limit anline cache to:
If this option is disabled Genie Backup Manager will cache the entire backup set to file in a temporary local

location, and then upload it to the Genie-Soft Online Backup Servers. Otherwise, GBM will cache and upload
chunks of data according to the size limit specified in the option below.

Cache size; | 500 E

Set the size for local temporary cache created before uploading data. Make sure your hard drive has enough
disk space for the cache file to be created.
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Global Preferences: Open File Backup

The Open File Backup page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains options related to handling open files during backups.

(%) Dizable Open File Backup

Disable using Open file backup to handle backing up open files

(%) Uze Yolume Shadow Copy [fully integrated)

Allow Volume Shadow Copy service to copy open files during backups.

{®) Use Genie Open File Backup &gent [additional &dd-on)

Allow Open File Backup Agent to copy open files during backups.

Start

Run Open File Backup Agent as a process in the background.

Pauze

Stop Open file Backup Agent. It is recommended to always keep OFB running to ensure a skipped-files-free
backups.

FE Statusg:

Displays the status of Open File Backup Agent: (Activated, Paused or Not installed).

OFE “erzion:

The version of Open File Backup Agent currently installed on the computer.
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Preferences: Restore Settings

The Restore Settings page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to restore operations.

If & file being restored exits in the destination folder

() Do not replace existing file
() Replace if restored file iz newer

(%) Always replace files

Instructs GBM what to do when a file with the same name as the one being restored exists in the destination
folder.

[ Abways dizplay lag after restare

Automatically open the restore log after each restore job.

Restare file modified dates and attnibutes

Remember each backed up file's attributes (hidden, read-only, system, archived) and modified date and time
stamp, to insure they are retained when files are restored.

Outlook. reztore settings

Settings to be used when restoring Microsoft Outlook data. (Settings)
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Global Preferences: Testing Data Integrity

The Testing Data Integrity page of the Global Preferences window (accessible from the Tools menu,
Global Preferences menu item) contains settings defining how Genie Backup Manager verifies the reliability
of produced archives after backup.

() Automatically test data after backup

Run data integrity test automatically after backup is complete.

3 Azk me

Prompt me for action after backup is finished.

) Da not test

Do not perform data integrity testing after backup.

Teszt anly new and changed filez

When performing increment, mirror or differential backups, verify only files that have been newly appended
to the backup set.
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Global Preferences: Email Notification Settings

The Email Notification page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains the mail server settings GBM uses for sending notifications of performed
backups via email.

SMTP Server:

SMTP server hostname or IP address.

Fort:

SMTP port number. Default value is 25.

[]ssL

SSL (Secure Sockets Layer) is a security protocol that provides communication privacy. Select this option if
your SMTP server supports SSL.

From:

Email address to appear in the sender (From) line.

To

Email address of the recipient of the notification.

Subject: GEM Backup Matification

Text to appear in the Subject line of the notification email

[t

Select this option to include the backup log with every notification email.

Configuratian...




Open a dialog for configuring advanced email sending options. (Controls)

[ Send Test E-mail... j

Send dummy notification email to test the entered settings
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Global Preferences: Auto-Exclude

The Auto-Exclude page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings for automatically ignoring specific files and folders during backup.

Some system files and folders on the computer are not made to be moved or copied, and are accessed only
by the Windows system, trying to backup these files will cause an error in GBM. To avoid running into backup

problems, GBM by default skips these files and folders in all the backup jobs created by the user. This
preferences window enables the user to add/remove files and folders from the 'Auto-Exclude’ list.

Enable auto-exclude [Recommended)

Automatically exclude the files and folders specified in the list whenever a backup is performed.

FilefFaolder name Descripkion A
fphc:'l,*.crmlng ComPlus
fphC:'l,hiI:uerFil.sys Power Management
ﬁﬁc:lpagefile.sys Memary Page File

B i o e emmimm e e e e - . - '

List of files and folders to be automatically excluded from all backup jobs.

Femove

Remove an item form the list.

Add...

Add an item to the auto-exclude list.
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Global Preferences: Cataloging

The Cataloging page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to the cataloging feature of the program.

Enable Cataloging

Allow GBM to create a library containing history of backup jobs/runs.

Accezs reztore-wizard even when media et iz not loaded

Enable user to choose a backup set from the catalog and open it within the restore wizard, to browse
and select files for restore, even if the media set is still not loaded.

[[] Read index from catalog [Enable changing storage location]

Allow GBM to do an increment, mirror, or differential backup run by referring to the backup job index
saved in the catalog, instead of the one on the storage media. This is needed when the user is trying
to store the data from a new backup run on a new media volume, other than the one containing the
data from the previous run.
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The Catalog

The Catalog is a library containing a list of all defined backup jobs and the files backed up during each job's
executions. With this utility, users can keep track of file versions, and run, view search for and extract files
directly from the backup archive without going through the restore wizard.

For each new execution of a backup job, Genie Backup Manager creates a new subfolder in a folder carrying
the same name as the backup job (usually in C:\Documents and Settings\<user=>\Application Data\Genie-
Soft\GBMAPPLICATION\), starting with a folder named "00000000" for the first backup execution, and a new
folder with the name incremented by one for each subsequent run. Each folder contains catalog information
for the corresponding backup execution, which Genie Backup Manager refers to, to populate the catalog
window.

To access the catalog click the Catalog button in the main window, press <Alt+C=>, or select Catalog from
the File menu.

Although highly not recommended, users can disable cataloging if they feel that they will not be benefiting
from this feature, and wish to spare the small amount of disk space that would otherwise be consumed by
the catalog files. This can be done by clicking the Tools menu, selecting Global Preferences, selecting
Cataloging, and unchecking the box next to Enable cataloging. Note that doing so will prevent Genie
Backup Manager from writing catalog information locally, thus loosing all historical data related to backup
executions, and the ability to browse, search, extract, view, or run backed up files, unless restored first.

Using the Catalog

Backup jobs are listed in alphabetical order in the left pane of the catalog window. Expanding the tree
beneath a backup job displays its versions ordered according to the date and time on which they were
executed. Users can expand the tree under any backup version to view detailed information about the files
that were backed up. The following filters can be selected: All files, New files, Unchanged files, Modified
files, and Deleted files. Clicking on one of the filters displays the results in the right pane. The following
columns are available in the file list view, which can also be used for sorting:

e Filename: name of listed file.

e Size: size of listed file -before compression if backup set was compressed-

e Date Modified date of the most recent change made to the file before it was backed up.

e GBM Data Type: My Profile, My Folders or My Plugins.

¢ Extension: the filename extension (file type) of the backed up file.

e Original Path: the original path in which the backed up files was located.

The user can further refine the list of results by typing a filename mask in the Filter by field above the
results pane. For more advanced file searching options, see Advanced Search.

Right-Click Options



Right clicking an object from the panes in the Genie Backup Manager Catalog will open a menu with options
related to the clicked item.

Right-Clicking a Backup Job:

e Delete Job: Delete all catalog entries for the currently selected job.
e Expand All: Fully expand the tree beneath the selected backup job.

e Collapse All: Collapse the tree of backup runs below the selected backup job.

Right-Clicking a Backup Run:

e Restore: open the restore wizard to restore data from the selected backup run.
e Show log: Show backup log for the selected backup run.
e Delete: Delete the catalog entry for the selected backup run.

e Delete All: Delete all catalog entries for the currently selected job.

Right-Clicking a File:

e Restore selected file: Extract the selected file to a location specified by the user.

e Restore checked files: Restore all files with ticked checkboxes to a location specified by the user.
e Mark all: Mark all files as selected.

e Clear all: Deselect all files.

e Run selected file: Open selected file using the application associated by Windows with its file type.

e View with Notepad: View selected file using Notepad.
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Advanced Search

The file Search dialog offers the most direct way to locate a backed up file. Use the Search dialog if you are
looking for common file types, if you remember all or part of the name of the file you want to find, If you
recall the size of the file you wish to locate, or if you know when you last changed a file. The Search dialog
can search within all performed backup runs to locate all revisions of a file or files.

To open the advanced search dialog from the catalog window, click the Advanced Search link the upper-
right corner.

You can write the name of the file you wish to locate directly in the Search for field. If you know only part of
the name, you can use wildcard characters to locate all files that include that part in the name. For example,
*map.* will find "road map.jpg"”, "tech map.doc", and "tech map.txt". You can also search for files which
names contain a sequence of adjacent letters. For example, ost will find "most wanted.doc", "host.txt", and
"outlook.ost".

You can instruct Genie Backup Manager to look for your file either in a specific backup archive, or in all the
archives created by currently configured backup jobs, by selecting one of the following options from the
Search in drop-down menu.

e Selected Backup Run: Search for file within the highlighted backup run.

e Selected Backup Job: Search for file within the selected backup job.

e All Jobs: Search the entire catalog.

e Browse for Backup Job: Open a list of backup jobs/runs to choose from

e Browse for Backup File: Specify a backup set to search within, useful when there is no catalog entry
is available for that backup set.

The GBM data type menu enables you to refine your search by specifying whether the file you are searching
for belongs to a My Profile item.

You can use additional search criteria to make your search more specific by clicking the More choices tab,

this will enable you to refine your search according to the size and/or "last modified date and time" attribute
of the file(s) you are looking for.
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How to: Back up the Catalog

The catalog is normally small enough to fit on one floppy disk depending on the total number of files listed in

the catalog.

To backup the catalog

1. From the left navigation menu in the backup wizard select What to Backup.

2. Select My Plugins tab.

3. Select GBM 8.0 Preferences, Jobs, Scripts and Catalogs.
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Backup Devices

The Where to Backup wizard screen defines where the backup will be stored. To choose a storage device
during backup job creation/editing select Where to backup from the left navigation menu in the backup
wizard. Make sure you can write in the destination and the selected folder (you have the proper rights and
the media is not write-protected).

GBM is the only backup software that grants users the flexibility of choosing between all the following
storage destinations without the need for purchasing and installing extra plugins or add-ons:

External and Internal hard disks.

e Across network (Shared network locations, SAN devices, NAS devices, etc.).

e Memory Sticks (Flash memory).

e CD/DVD media (all formats - DVD+RW/DVD=*R/DVD-RAM/CD-R/CD-RW), including Blu-ray.

e Removable media devices (REV, floppy disks, ZIP disks, JAZ etc ...)

e Remote locations using FTP service.

e Tape devices.

e Online backup.
For each backup run, a new index (*.gbp file") is created in the destination folder, containing the backup
job's catalog as well as other information necessary for Genie Backup Manager to be able to restore data
automatically. If this file is lost, GBM will not be able to restore data, and the user will only be able to
manually access the files and folders stored in the archive. The catalog is also stored locally to enable offline
browsing of the data stored in the backup (even if the storage media is not loaded), as well as file versioning
information.
If the backup destination drive/device is missing or disconnected when backup starts, Genie Backup Manager
will display a warning message saying that there is not enough space on the destination, and backup will be
aborted.

Note:

In easy mode, backing up to Local/LAN is only supported
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Internal and External Drives

Genie Backup Manager allows users to backup data to hard disk drives of all kinds, whether internal or
external (hard drives, USB drives etc.). In addition, GBM enables users to select more than one hard disk as
a backup destination; if one hard disk gets full, GBM will automatically continue backup to the next hard disk
specified in the multi-drive spanning list. The Local/LAN option is selected by default when you define a
new backup job, and data is backed up to the default backup destination as specified in the Global
Preferences window.

To backup to an internal or external hard drive during backup job creation or editing, select Where to
Backup from the left-hand menu, then select Local/LAN location.

If the backup destination drive/device is missing or disconnected when backup starts, Genie Backup Manager
will display a warning message saying that there is not enough space on the destination, and backup will be
aborted. Users can avoid this using either the Multi-Drive Spanning, or the Backup Transfer Method
features.

If the desired location is not visible in Windows Explorer, users can also type the backup destination path
directly in the box.

Note:

You can also backup USB attached external drives using Removable media option as it is automatically
detected.
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Multi-Drive Spanning

Multi-drive spanning allows Genie Backup Manager to treat multiple disk drives as one during backup.

Many people have more than one partition defined on their hard drive, others have more than one drive that
they use to store backups on. Most backup solutions allow the user to select only one partition/drive as a
target for storing data for each backup job, when that drive is full, backup will cease to run, unless the user
manually frees more disk space, or automatically sets the software to erase the contents of the media. Genie
Backup Manager offers a novel way for handling these scenarios, using multi-drive data spanning.

Multi-drive spanning is a feature that enables users to divide backed up data onto more than one local/LAN
location, this includes multiple partitions, hard disks, shared and mapped networked locations, SAN and NAS
devices etc.

Multi-drive spanning locations can either be preset, i.e. the user gets to predefine an ordered list of storage
locations for GBM to use. Or, the user can set GBM to prompt him for a new location, once the drive
currently being used is full. This feature is disabled by default.

Selecting Repeat , causes Genie Backup Manager to cycle through the list of backup devices, such that when

the last destination in the list is full, GBM will re-attempt to backup on the first destination, and then the
second, and so on.

Enabling multi-drive data spanning:

To allow GBM to span backed up data onto more that one local/LAN location:

1. From the left-hand navigation menu in the backup wizard select Where to Backup .
2. Select Local/LAN location .
3. Select Allow multi-drive spanning .

4. Choose one of the following options:

e Use all available Space : Write until current location is full before moving on to the next one.

e Use fixed split size: Use a fixed amount of disk space from the current location then move on
to the next one, even if the previous one still has free disk space.

5. Click Auto spanning drive List to create a list of predefined locations for GBM to use. If no list is
defined, GBM will prompt the user to enter a new backup location once the one currently being used is
full.

J Tip:

Use Read index from catalog to enable GBM to perform incremental, mirror, or differential backups without the
need to reload the full backup
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Splitting Backup Files

Using the new 64-bit Zip compression, Genie Backup Manager compresses backed up data to one file that
can reach up to about 18 million terabytes in size ( more precisely, 264 -1 bytes) - provided that this is
supported by the file system being used - However, the user might want to split the compressed backup file
into multiple smaller chunks, for instance in order to copy them later to removable media, or when the file
system, such as FAT 16, does not allow creation of large files etc.

GBM can split the backup set into multiple linked files with sequentially numbered extensions (e.g. .001 .002
.003 etc ...) with the last file in the series assigned the main (.gbp) extension.

To split backup files:

1. From the left navigation menu in the backup wizard select Where to Backup.
2. Select Local/LAN Location.
3. Select Enable multi-drive spanning.

4. Select Use fixed split size, then enter the desired split size value.
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How to: Restore from a Local Drives

Restoring data from backups stored on local hard drives is straight forward.

1. Make sure that the drive on which your backup is stored is attached to the computer and accessible
from Windows Explorer.

2. Open the folder holding the backup on your device.

3. Double click the main "gbp" file corresponding to the backup set you wish to restore data from.
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Backup to Network Locations

Genie Backup Manager allows backing data to LAN-connected devices (Local Area Networks), these include
shared network folders, mapped networked drives, SAN devices, NAS devices etc...

To backup to a networked device or location during backup job creation or editing, select Where to Backup
from the left-hand menu, select Local/LAN location, click Browse, then select My Network Places or
type the full path to the backup destination.

If the backup destination drive/device is missing or disconnected when backup starts, Genie Backup Manager
will display a warning message saying that there is not enough space on the destination, and backup will be
aborted. Users can avoid this using either the Multi-Drive Spanning, or the Backup Transfer Method

features.

If the desired location is not visible in Windows Explorer, users can also type the backup destination path
directly in the box, e.g. "\\Server\shared documents".
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Backup from Network Locations

Genie Backup Manager users can backup data from shared folders on networked devices. To do so select
What to Backup from the backup wizard, click My Folders tab, from the folders view pane select My
Network Places , then select the folder(s) you wish to backup. If the desired location is not visible in My
Folders , use the manual files selection feature to enter the path to the data location manually.

If the desired network location is a mapped drive/folder, simply browse to the drive letter assigned to it from
the folders view pane to select the data for backup.

' Tip

On a Microsoft Windows Network if you share a folder that has a dollar sign '$' at the end of its name, then it is considi
be hidden and other machines cannot see it, unless you explicitly enter its name in the address bar or the command p
Users can add this kind of sources by manually typing the complete path in the Manual File Selection panel. To add a
item, click Add, then type the full path to file or folder. Select Include sub-folders if you wish child folders to be includec
backup.

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



How to: Enable OFB Agent to Backup Open Files on Remote
Locations

Open File Backup Agent can be set to handle open files while backing up data using Genie Backup Manager
from a network-connected machine. This allows centralized LAN-based backups for clients with potentially-

open files.

Perform the following steps on each network computer you intend to backup data from:

1. Install Open File Backup Agent.

2. Click Start, point to Genie-Soft, then Genie Backup Manager 8.0 Tools, and click OFB.
3. Right-click the Genie Agent icon in the system tray then select Settings.

4. Make sure Allow Network Access to This Computer is selected.
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How to: Restore Data Stored on Network Locations

1. In the main screen click Restore.
2. Click Select Backup Set.

3. Browse to the location of the backup set and select the ".gbp" file corresponding to the backup version
you wish to restore, then click Open.

4. Click Next.

5. Continue with restore.
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Backup to Tapes

GBM supports backup to tape devices with the option to span data over multiple tape cartridges. Tapes are
one of the most commonly used backup storage devices due to the fact that they can store large amounts of
data at a relatively low cost.

To backup to tape, select Where to Backup from within the backup wizard, select Tape Devices. Tape
devices are listed in GBM in the same order as the machine's BIOS.

Genie Backup Manager allows backed up data to be divided, and stored on up to ten tape cartridges. Each
tape must be formatted at least once using GBM's tape erase tool before it can be used for backup.

Genie Backup Manager stores a copy of the backup job's catalog both on the last cartridge of the tape set
used during backup, and locally on the computer on which backup was performed. If the local copy of the
catalog is missing, the user needs to regenerate it using the tape scan feature in order to restore data.

Tape Backup Limitations

When backup to tape is selected, the following GBM features are not supported.

Purging.

Mirror backup and incremental backup without rollback.

192-bit AES encryption.

Extracting from Catalog
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How to: Restore Data Stored on Tapes

1. Insert the last cartridge from tape set into the drive.
2. Open the Restore Wizard.
3. From the left navigation menu select Tape Restore.

4. Select the appropriate backup job/run corresponding to the backup archive you wish to restore from, If
the catalog entry for that backup is not present you will need to Generating the Tape Catalog.

5. Click Next.

6. Continue with restore.
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Generating Tape Catalog

When backup to tape media is performed using Genie Backup Manager, a catalog (index) of backed up files
and folders is generated and stored on the tape, and another copy is stored locally on your machine. Genie
Backup Manager needs this index in order to properly restore data from the tape.

When restoring data from tape to a machine different from the one where the backup was made, or if the
local copy of the tape catalog was deleted either intentionally or during a system format, the catalog needs
to be regenerated.

Regenerating the backup catalog for a single tape backup set

Insert tape into the drive.

Open the Restore Wizard.

From the left navigation menu select Tape Restore.

Click Generate Catalog. GBM will scan the tape and detect all GBM backups stored on it and list them.

Wait until Status is "idle".

Regenerating the backup catalog for a multi-tape backup set

If Genie Backup Manager spanned your data during backup over more than one tape cartridge, you will need
to do the following in order to generate the catalog:

1.

2.

3.

Open the Restore Wizard.
From the left navigation menu select Tape Restore.
Insert the last tape from the backup set into the tape drive.

Click Generate Catalog. Genie Backup Manager will scan the tape then prompt you to insert the first
tape from the set.

Insert the first tape then click Ok.
Wait until Status is "idle".

Repeat steps 4 through 6 for each remaining tape, inserting them in backwards sequence, starting with
the tape before the last in the set, then the tape before that, and so on, until the first.

Trying to generate a catalog from a tape that is not the last tape in a backup set will result in an error;
Genie Backup Manager will report that no catalog was found.
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Tape Tools

The Tape Operations utility offers a number of options for handling tape media, including tape erase, tape
eject, tape tension adjustment, and deleting tape catalog.

To open the Tape Operations dialog click Tools from the toolbar then select Tape Operations.

Selecting Erase will format the inserted tape cartridge, deleting its contents, and preparing it for use with
GBM. Tapes must be formatted at least once using GBM's Tape Erase before it can be used for backup. If
automatic tape erase was selected from the backup wizard's Settings page, and the tape was not properly
formatted for backup, GBM will automatically format it. When Tape Erase is selected, the Tape Label field
will be enabled allowing users to change the tape’'s internal volume label before erasing it.

Selecting Eject will expel the cartridge currently inside the tape drive.

Select Tension to tune the inserted cartridge's tape tension. Periodic tape tension adjustment is
recommended. Variance in tape tension can cause read-write errors and wear-and-tear to the media and
hardware; too little tension can result in early tape flying, even though the head may have little or no visible
wear. Too much tension will not show up until later because the greater tension will maintain tape to gap
contact longer, but will wear like a belt sander, actually shortening the performance period.

Select Remove on-tape catalog to delete catalog entries stored on the inserted tape as a sort of quick-
erase. Deleting on-tape catalog will remove references to performed backup jobs, in which case restore of
data stored on tape will not be possible unless the user regenerates the catalog.
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FTP Servers

Genie Backup Manager allows users to perform backup operations to any FTP server connected to the
Internet by simply entering the server's address and authentication. Genie Backup Manager will create a
local temporary copy of the backup, then "push" a data stream that can be compressed and/or encrypted to
the designated FTP server. This feature will allow you to easily store data offsite or perform centralized
backups for remote client data.

To perform FTP backup, select Remote Location Using FTP from the Where to Backup page in the
backup wizard. Available space on FTP server will not be calculated/displayed during backup. You will need to
make sure the FTP account you are using has enough disk space.

When backing up to a remote machine using FTP, GBM first creates a temporary copy of the backup locally
on the machine then uploads it to the FTP server, these files are by default deleted immediately when
backup to FTP is complete. The user can set GBM to keep these files even after backup is done - to serve as
a local second copy of the backup- from the Advanced Settings dialog.

If the connection is dropped or interrupted, or if there was no upload activity for a considerable period of
time during backup to a remote FTP server, GBM will pause the upload and retry to reestablish connection (if
possible) then resume from the broken point; GBM repeats these steps until the entire backup is uploaded or
the number of retries specified by the user are exceeded. Users can modify the number of auto-resume
retries from the Advanced Settings dialog.

Users can restrict the transfer rate at which GBM uploads data to the FTP server during backup, so as not to
"hog" the connection's bandwidth from the Advanced Settings dialog.

Limitations of FTP Backup

When FTP backup is selected, the following GBM features are not supported.

e Purging old backup files.

e Incremental backup without rollback.

Mirror backup.

Extracting from Catalog

'Tip:

You can rotate backup types via scheduling, for more information, please refer to How to: Schedule Rotating
Backup Jobs
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FTP Backup Settings

The FTP backup settings dialog allows access to advanced FTP connection settings that users can customize
for optimized performance and compatibility with the FTP server.

To open the advanced FTP Backup settings dialog, select Where to Backup from within the backup wizard,
select Remote location using FTP, then click Advanced Settings.

Addrezs:

Name or IP address of FTP server.

Port: |21

FTP server port number. Default value is 21.

Izer:

Username for the FTP access account.

Faszward:

FTP access account password.

B ackup directany:

Path to which the backup should be stored on the server. If path does not exist, GBM will create it.

Test Connechion...

Perform a test connection to the server, to check that the entered settings are correct.

Advanced Settings. ..

Advanced FTP connection settings. (Controls)
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How to: Restore Data Backed Up Using FTP

GBM currently does not support direct data restore from FTP sites. In order to restore FTP backed up data,
the user needs to first download the backup files from the FTP server using either an Internet browser, or a
third party FTP software. It is recommended to use third party FTP software to download the backup set for

better reliability and speed.

Restoring from FTP Using the Default Internet Browser

1. Open your default Internet browser.

2. Login to the FTP site containing your backed up data by entering its URL into the address bar in the
following format:

ftp://[username]:[password]@[ftpsiteaddress]

Where:

e [username] is the username of the FTP account used for uploading files.
e [password] is the password for the FTP account used for uploading files.

e [ftpsiteaddress] is the address for the FTP site used for uploading files, including the complete
path to the location of the backup set.

E.g.

ftp://sam:mypassword@my.ftp.site.com/genie/monday/

3. Locate the backup set and then Copy/Paste it onto your hard disk.

4. Follow the local restore procedure.

Restoring from FTP Using Third Party Software

1. Use a third-party FTP software to download the complete backup set onto your hard disk.

2. Follow the local restore procedure.
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Online Backup

Online backup is Genie-Soft's latest offering for users who wish to safeguard their data, without the hassle of
maintaining shelves of stacked backup disks or cartridges. Online backup with GBM is as easy as backing up
to any local hard drive, ensures around-the-hour worldwide data accessibility, and is highly secure, through
username and password encryption, as well as 128- bit Secure Socket Layer (SSL) data transmission,
certified by the leading global provider of SSL certificates, Thawte.

You can sign up to get a free-of-charge trial account to test our unparalleled online backup service by
clicking the Sign up for a free trial account link. The trial account will grant you 50MB of free online
backup space. Credit card information will be requested, but your card will not be charged.

Your Genie-Soft online-backup account also offers Genie Drive feature, which enables uploading personal
files via email, organize your data by creating new folders, deleting, cutting, copying, and pasting files and
folders to different locations in the Drive. In addition to that, Genie Drive allows you to easily share folders
with friends and family or cooperate workgroups. You can drag-drop files and folders to the drive that is
installed on your computer and it will automatically synchronize with the web service. For more features,
login to your online account via web.

Finally, using Genie Online-Backup, you can set multiple users and allocate disk space quota for each one.

Setting Genie Backup Manager to perform online backup:

1. Make sure you have an online backup account with enough free space.

2. From the backup wizard, select Where to Backup.

3. Select Online backup.

4. Click Login.

5. If this is the first time you login to your online account in GBM 8.0 a registration form will appear. If
you do not have an online backup account, fill the information to register. Or click Login if you already

have an account.

6. Type your email address and password in their respective fields (Email/Password) as were entered
when you signed up to the Genie-Soft online backup service.

7. Choose between Standard and Secure data transmission.

8. Click Login now.

1. From the Main page Click Online Backup Account

2. If this is the first time you login to your online account in GBM 8.0 a registration form will appear. If
you do not have an online backup account, fill the information to register. Or click Login if you already
have an account.

3. Type your email address and password in their respective fields (Email/Password) as were entered
when you signed up to the Genie-Soft online backup service.

4. Choose between Standard and Secure data transmission.




5. Click Login now.

6. In the main screen, select Create Backup Job

You can change the Genie-Soft online account you use for backup by clicking the Change User button.
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Security Options

High data security and privacy during online backups in Genie Backup Manager are achieved through the
application of the following data-security standards:

Securing Account Passwords

This security measure is applicable even when secure online backup is not selected.

Passwords are encrypted using the SHA-256(Secure Hash Algorithm). This hash encryption algorithm is one
of the required secure hash algorithms for use in U.S. Federal applications, including the use of other
cryptographic algorithms and protocols, for the protection of sensitive unclassified information.

This Encryption methodology is a one way encryption; therefore it cannot be decrypted at the server’s side
and therefore there is no way to recover a password from the data base, the server will only be able to reset
the password and not recover it. The reset password will be sent to the user’s personal email, this process
prevents hackers from resetting the user’s account, which is a great feature to prevent user impersonation.

Securing Data Transmission

Genie Online Backup supports a 128- bit Secure Socket Layer (SSL) certified by the leading global provider
of SSL certificates Thawte. This protocol uses RSA encryption algorithm in order to encrypt the data on the
link and prevent hackers from eavesdropping on personal information.

This Authentication is done to reassure the clients that they are sending their information to the right source.
In other words, the certificate based authentication verifies that we are who we say we are. This
authentication is done by the SSL certificate provided by Thawte. An SSL Web Server Certificate enables
Genie Online Backup users to view the following information:

e The domain for which the certificate was issued. This allows them to check that the SSL Web Server
Certificate was issued for your exact host and domain.

e The owner of the certificate. This acts as further reassurance, since customers are able to see whom
they are doing business with.

e The physical location of the owner. Once again this reassures customers that they are dealing with an
actual entity.

e The validity dates of the certificate. This is extremely important, since it shows users that your Digital
Certificate is current.

Setting Secure Data Transmission:

1. From the left navigation menu in the backup wizard select Where to Backup.
2. Select Online Backup.

3. Click the Change User button.



OR

Make sure Secure is selected.

From Online Backup Account in Main Page
Click the Change User button.

Make sure Secure is selected
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Online Backup Settings

Online Backup Settings slightly differ from other backup settings by the following:
Full Backup: Backs up all selected data every run

Backup without versioning (Mirror backup): backs up new and modified files; deletes missing files in a
single archive

Backup with versioning (Incremental backup): backups up new and modified files in a new backup
archive (disabling rollback is not supported)

Security: All security options provided in GBM are fully supported in Genie Online backup in addition to
Secure data transmission

Bandwidth Throttling: This feature enables you to limit the bandwidth used to upload backup to the offsite
Genie servers.

Purging: Control the your online space usage via purging and also number of backup versions

More settings: Power Management Options, Reset Archive bit option, Email notification, and Pre & Post
commands are also fully supported
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How to: Restore/View Online Backups

1. From the Main Page Select Online Backup Account

2. Click Login to My Account if you are not currently logged in and enter your email account and
password. Select Secure or Standard transmission and click Login now

3. Wait for Genie Backup Manager to list all the backups available online.
4. Select a backup job from the list.
5. Click Restore/View to restore or view your backup

6. To Restore, select the data you wish to restore and continue with restoration process

IJ Tip

You can also search and restore an individual file via catalog
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How to: Restore from Genie Drive

1.

2.

From the Main Page Select Online Backup Account

Click Login to My Account if you are not currently logged in and enter your email account and
password. Select Secure or Standard transmission and click Login now

Wait for Genie Backup Manager to list all the backups available online.
Select Genie Drive to restore files that were uploaded manually.
Click Restore/View or Next
Select the files/folders you wish to restore and choose one of the following restore modes:
e Alternative: restore data to the specified path, while maintaining the original folder tree
structure.

e Single folder: restore data to the specified path, after collapsing the original folder tree
structure (no subfolders).
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How to: Purchase Extra Online Space

If you wish to upgrade your online backup account to another plan that offers more storage space or seats
(users), do the following:

Directly from application:

1. From the backup wizard, select Where to Backup.
2. Select Online backup.
3. Click Buy more space

OR

1. From the Main page Click Online Backup Account
2. Click Need more space?

From Internet

1. Open your Internet browser.

2. Go to http://online.genie-soft.com and login to your account.

3. From the main page select Billing.
4. Click Buy more space.

5. A list of extra space/seats plans that you are eligible to upgrade to will be displayed. Choose the plan
that suites your needs.

e During backup if GBM determines that the user does not have enough online backup space, it will
notify the user and give the option to purchase more backup storage space.
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How to: Delete Online backups

1. From the Main Page Select Online Backup Account

2. Click Login to My Account if you are not currently logged in and enter your email account and
password. then wait for Genie Backup Manager to list all the backups available online.

3. Select the backup job from the list and click Delete Selected Job or Delete all Jobs



Optical Media

Genie Backup Manager can write to CD/DVD media of any format (DVD+RW/DVD+R/DVD-RAM/CD-R/CD-
RW), including double layer DVDs and Blu-ray, using both built-in burning capability and packet writing -
with the aid of third party software -.

To set Genie Backup Manager to backup to a CD/DVD drive, select Where to Backup from the left-hand
menu, select CD/DVD media, then select the drive letter of the recorder you wish to use.

You can backup an unlimited amount of data to CD/DVD media even if one disc does not have sufficient
space to hold all the data, since GBM will by default divide your backup into several discs (automatic disk
spanning), and all you need to do is to replace discs when prompted to do so.

Genie Backup Manager will by default use the entire amount of empty space available on each inserted disk
during backup, you can select Use fixed split size to instruct GBM to only fill up a fixed amount of space on
each inserted disc. Make sure to leave some space as a safety margin for the table of contents that will be
written to close the disc session.

If GBM fails to write to disc or is interrupted during the process, the user will be given the option to retry by
inserting a new disc, or to cancel the operation.

Genie Backup Manager checks the integrity of data written on each disc in the backup set immediately after
the disc's session is closed. If the data is corrupt, GBM will ask the user whether to proceed with backing up
the rest of the data (in the case of automatic disc spanning) or cancel the backup task.

To prevent GBM from verifying data integrity after writing to a CD/DVD, uncheck the option Verify data
after backup in the disc burning progress dialog that appears during backup.

To retrieve an updated list of supported optical recorders, make sure you are using the latest Genie Backup
Manager version using the Genie-Update tool, from the main application window click Help, then select
Supported Recorders.

GBM by default uses the maximum speed supported by both the recorder drive and the inserted media for
burning, however, for trouble shooting purposes the user can select a custom writing speed by clicking
Advanced Settings. If no disk is inserted in the drive, GBM will load the list of speeds supported by the
recorder drive, inserting a disk in the drive would cause GBM to load the list of speeds supported by both the
recorder and inserted media.
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Disc Recording Options

Genie Backup Manager uses two methods for writing a CD/DVD disc: The built-in burner and Incremental
Writing (AKA Packet Writing) using third party software.

Track-at-Once recording is what most recorders and software support today, and is the built-in default
CD/DVD recording method used in Genie Backup Manager, which means that you do not need to use third
party software to use it for writing data to optical media. Track-at-once burning does not allow manipulation
of individual files after they have been written to disc, and thus, only supports full, incremental with rollback,
and differential backup types. Purging old backups is also not supported.

Packet writing on the other hand lets you treat an optical disc as though it were a big floppy disk, allowing in
the process for the deletion and replacing of individual files, thus supporting all backup types, including
incremental without rollback and mirror (as long as data is not divided over multiple discs). However, Genie

Backup Manager supports this recording method only through the use of third party software.

Built-in burner vs. packet writing.

Issue Track-at-Once Packet Writing

Speed Slower. Faster (Except when backup without
compression is used).

Compatibility Readily readable on most drives. In most cases the packet writing

software used to write the data must
be installed in order to read from the
disk.

Incremental &
Mirror Backup

Rollback forced. Mirror backup not
supported.

Backup with rollback option disabled is
supported (new versions of files
overwrite old versions). Mirror backup
supported.

Purging old
backups files

Not supported.

Supported as long as data is not
divided over more than one disk.

Availability

Built in.

Must use third party packet writing
software.

Note: Default Windows XP writing
component does not use packet
writing.

Disk space
utilization

More disk capacity.

Less disk capacity; Packet Writing
consumes more space on disc.

Pre-use formatting

Blank disks need not be formatted
before usage. Disks previously
written to using packet writing
software must be fully erased: Tools
> Format Re-writable CD = Full
Format.

All disks must be formatted at least
once using the third party software, to
become compatible with packet
writing.

Note: Disks formatted using one
packet writing software must be
reformatted before being used with
another.
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Using the Built-in Burner

The built-in CD/DVD burner in Genie Backup Manager can write to almost all optical media formats, including
the new dual-layer DVD and Blu-Ray technologies; no third party software is required.

To set GBM to backup to optical media using the built-in burner:

1. From within the backup wizard select Where to Backup.

2. Select CD/DVD media ( DVD*=RW/DVD+=R/DVD-RAM/CD-R or CD-RW).

3. Make sure Use packet writing Software is not selected.
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Incremental Writing (Packet Writing)

If your CD/DVD device is not compatible with Genie Backup Manager, or if you wish to use backup types not
supported by GBM's built-in burner, you can use third party packet writing software.

Packet writing is a term for software that lets you record data onto an optical disc directly from Windows
Explorer, My Computer, or from the File/Save As section of any computer program. Simply put, it lets you
treat a CD as though it were a big floppy disk.

When backup using third party packet writing software is selected, Genie Backup Manager will still control
what and how much data is written to each inserted disc.

e CD/DVDs written with this method can only be recognized on other computers if the same third party
packet writing software is installed there too.

e Free Packet-Writing software are available for download on the Internet, please refer to the following
knowledgebase article for more information: http://www.genie-
soft.com/asp/community/KnowledgeArticle.asp?KBID=128

To set GBM to write to CDs and DVDs using third party packet writing software:

1. From within the backup wizard select Where to Backup.
2. Select CD/DVD media ( DVD+RW/DVD+R/DVD-RAM/CD-R or CD-RW).

3. Select Use third party packet writing Software.
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Formatting Optical Media
GBM comes with a CD/DVD formatting tool that can perform both quick erase and full disc format.
This feature can only be used with re-writable optical media.

e New blank discs need not be formatted before using them with Genie Backup Manager. However, if the
disk has been written to previously using a packet writing software then it needs a full format before

GBM can use it for backup.

e When using packet writing, make sure the disc you wish to backup to has been formatted using the
third party packet writing software.

Setting a backup job to automatically erase CD/DVD discs before backup:

1. From the left navigation menu in the backup wizard select Where to Backup.
2. Select CD/DVD media ( DVDxRW/DVD=R/DVD-RAM/CD-R or CD-RW).

3. Make sure Automatically erase disc before backup is selected.

e Automatic disc erase uses quick erase, not full format.

Manually erasing CD/DVD discs:

1. From the toolbar click Tools, then select Format Re-Writable CD/DVD.
2. Select the drive letter of the recorder containing the disk you wish to erase.

3. Select one of the following options:

e Quick Erase: Quickly delete the contents of the disk (takes around 1-2 minutes to complete)

e Format: Fully format disc (might take around 30 minutes or more to complete).

e Quick erasing re-writable disks might render them ‘stubborn’ after a number of erases, it is
recommended to perform a format every 7-10 quick erase sessions to revitalize the disk.



Copyright (¢) 2007 Genie-Soft, Inc. All rights reserved.



How to: Restore from Optical Media

To restore data stored on CD or DVD discs:

1. Insert the last disc in the backup set into the drive.
2. Open the Restore wizard.
3. Click Select backup set.

4. Browse to the CD/DVD drive and select the catalog ".gbp file".

5. Click Open.
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CD/DVD Backup Strategies

GBM offers flexibility and reliability when backing up to CD/DVD. Here are some strategies to make your
backup reliable and more flexible:

1. Use blank CD/DVDs: For reliable backups it is recommended that you use blank (new) CD/DVDs to
ensure that the CD/DVD does not contain scratches from extensive use.

2. Simulate Backup: GBM offers simulating capabilities to ensure successful burning of backup so you
know that your backup will burn correctly on the CD/DVD before it actually backs up. To can enable
this option from Tools> Global Preferences>= CD/DVD Settings> Simulate backup before
committing backup to disc

3. Create full backup on high capacity media: Backing up to CD/DVD is much slower than backing up
to a hard drive. Also DVD's even if dual layered cannot compare with the high capacity Hard drives. In
GBM you can create your full backup on an external drive, edit your job, select incremental or
differential on CD/DVD. Please make sure Read index from catalog (Enable changing storage
location) is selected from Tools> Global Preferences> Cataloging

4. Rotate backup types via scheduling: Purging is disabled when burning backups to CD/DVD media.
However, you can rotate backup types using Advanced schedule in Scheduler. for more information,
see Advanced Schedule

5. Use packet writing software to purge backups: you can enable purge option using packet writing
software as it enables writing to CD/DVD as if you were backing up to a hard drive. Packet writing also
allows you to perform mirror backups and incremental backups with rollback disabled.
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Removable Media

Removable media devices include floppy disks, JAZ drives, ZIP drives, memory sticks, etc. Removable media
is a practical backup destination, because it allows automatic media spanning, i.e. GBM would backup to the
inserted volume until all available space has been consumed then prompt the user to insert a new disk, and
so on, until all data has been written.

To set Genie Backup Manager to backup to a removable media device, open the backup wizard, select Where
to Backup, then select Multiple Disks (Removable Media Devices). A list of all attached removable media
devices will be displayed to choose from. External hard disk drives are now detected under removable
media; however, you may backup external harddisk under Local/LAN option to enable multi-drive spanning.
For more information, see Backup to Internal and External Drives.

You can backup an unlimited amount of data removable media even if one volume does not have sufficient
space to hold all the data, since GBM will divide your backup into several discs, and you only need to replace
discs when the program prompts you to do so.

Select Automatically erase contents of disk before backup if you wish to save time by allowing GBM to
quick-format each inserted volume during backup.

REV® devices are implicitly supported in GBM
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REV Device Settings

Now GBM supports lomega REV operations to ensure a more reliable and non interrupted backup. These
settings include:

Eject disk after backup: After backup completes, GBM safely and automatically ejects REV disc after
backup. This procedure is similar to right-clicking the REV drive icon in My Computer or Windows Explorer
and select Eject.

Disable write protection during backup/enable after backup: If you insert a write protected REV disk
prior backup any traditional backup program or a simple copy to disk cannot be achieved if write protection
is enabled. Selecting this option will check if your REV disc is write protected and will disable it before
backup. In addition to that, when backup completes, write protection will be automatically enabled.

Disable access protection during backup/enable after backup: Access protection prevents anyone
without the password from adding, deleting, modifying, or viewing your files. Therefore, if this option was
enabled prior backup, GBM will fail to perform backup. However, using this option and entering the access
protection password in the Password field will automatically disable access protection before backup and
enable it afterwards.

Notes:

If write protection and access protection were originally disabled, GBM will not enable it after backup



How to: Restore from Removable Media

To restore data stored on removable media:

1. Make sure the last storage volume from the backup set is inserted/connected.
2. Open the Restore wizard.

3. Click Select backup set.

4. Browse to removable media drive and select the catalog ".gbp file".

5. Click Open.
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The Default Backup Destination

When a new backup job is created, the backup destination option (where to backup) will be set to a default
local folder, typically "My Documents\My Backups", which can be later changed by the user.

To change GBM's default backup folder select Tools from the toolbar, select Global Preferences, select
Backup Settings, and enter a new path in the Default backup destination box. Note that the default
backup destination can only be set to point to a local or networked location.

To view the contents of the default backup folder click File from the toolbar then select Default Backup
Folder.
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Backup Transfer Method

Disconnections during backup (network failure, faulty disks etc.) can lead to corrupt backups. To avoid
having to redo backup when such an event occurs, users can activate this feature to make a temporary local
copy of the data before copying it to its final destination; this way, Genie Backup Manager can resume

backup from where it was interrupted.

To activate Backup Transfer Method for a backup job, select Settings from the backup wizard, click on the
More Settings link, select Backup Transfer Method, and make sure the option Backup to local
temporary location before copying to backup destination is checked.
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Media ID

During backup to removable or optical media, Genie Backup Manager will assign a different id (label) to each
disc/volume for identification. It is recommended to mark the media with this label, since GBM will refer to it
as it prompts the user to replace disks during restore or when attempting to add new versions to a backup.
GBM names each disk using the following naming scheme:

<Backup Job Name> - <Volume Number>

Where:
e Backup Job Name: is the name assigned to the backup job.

e Volume Number: indicates the disk's number according to the sequence in which volumes where
inserted during backup.

To change the Media ID:

1. From the left navigation menu in the backup wizard select Settings.
2. Click Advanced Settings.
3. Make sure Change media ID is selected.

4. Type a new label to be used instead of the backup job name.
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Data

User data is divided into three categories to make it more manageable during backup and restore. Data
selection is the third screen in the backup wizard.

m MY FOLDERS MY PLUGINS

This user data group contains various built-in plugins that you can use to backup some of the most
important items on your computer; this includes Emails, Favorites, Windows Settings, Desktop files and
folders etc...

Plugins are system independent, i.e. one can backup his favorites, for instance, from a Windows XP machine
and restore them on a Windows 2000 machine, without having to worry about the changed Windows
environment, and GBM would know exactly where to copy the files.

The items in this group were selected to include the most commonly backed up data types during system
formats.

MY PROFILE m MY PLUGINS

This user data group allows you to backup files and folders from any location readily accessible from My
Computer using an easy to use Windows-Explorer-like interface.

Use this group when you know where your files and folders are located and need to be able to access/restore
files individually.

MY PROFILE MY FOLDERS m

This group lists plugins that can be used to back up various items, such as programs, program settings,
saved games, databases etc ...

These plugins are different from those in My Profile in that users can download free plugins to extend the
capabilities of GBM, or create their own custom plugins and share them with other users.
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Profile Data

This user data group contains various built-in plugins that you can use to backup some of the most
important items on your computer; these include Emails, Favorites, Windows Settings, Desktop files and
folders etc. The items in this group were selected to include the data types most commonly backed up during
system formats.

My Profile items can be migrated between different computers or different versions of Windows safely; one
can backup his favorites, for instance, from a Windows XP machine and restore them on a Windows 2000
machine, and GBM would know exactly where to copy the files.

Selecting an item from the left pane displays a list of selection refinements in the right pane, along with
item-specific settings.
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System State

Genie Backup Manager provides an easy, secure and reliable way to backup System State. System state
backup includes all system state data as a unit; you cannot choose to backup individual components due to
dependencies among the system state components and to insure a stable system after restoration.

System State Items That GBM Can Backup

e Boot files, including system files and performance counter configurations

e COM+ Class registration database: A store of registration information for COM objects in the Windows
system. COM is a standard for binary interoperability of registered software components.

e Windows Registry: A database that Windows uses to store hardware and software configuration
information, user preferences and setup information

e System Files under Windows File protection: A system service that protects special operating system
files. In the event that one of these files is deleted or overwritten, System File Protection will replace
the file with the original from its cache.

e Active Directory Service: Stores Information about the network resources across a domain and is only
created on systems that are domains

e SYSVOL Directory: Contains Group Policy data this folder is only created on systems that are domain
controllers

e Certificate Services database including private keys. This databases are only created on certification
authority systems

¢ Cluster Database: Contains information about all physical and logical elements in a cluster, including
cluster objects, their properties, and configuration data. It is created on systems that are a node of a
Windows cluster

e The Metadirectory for The Microsoft Internet Information Services if IS is installed on the computer



How to: Backup System State

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.

3. In the left-hand pane Select the checkbox next to System State.
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How Restore to System State?

1. Open the restore wizard.
2. Load a backup, then click Next.
3. Make sure the My Profile tab is selected.
4. From the left-hand pane, select System State
Important Notes
e When Restoring System State with active directory, you must Restart the domain controller in
Directory Services Restore Mode

e It is recommended to Restore Active Directory, which is part of System State, before restoring MS
Exchange. This will save time instead of manually configuring you storage groups, mail boxes, etc...

e Aborting System State Restoration may cause your system to become unstable.

e It is Recommended to restore System State data to the same Windows version due to variation in
components on each version

e If you have more than one domain controller in your organization and Active Directory is replicated to

any of these other servers, you might have to authoritatively restore any Active Directory data that
you want to restore.
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Restart the Domain Controller in Directory Services Restore Mode

Restoring your Active directory requires your Domain Controller to be offline. Therefore you must restart
your domain controller in Directory Services Mode

To perform this procedure, you must provide the Administrator password for Directory Services Restore
Mode.

To restart the domain controller in Directory Services Restore Mode

1. Restart the domain controller.
2. When the screen for selecting an operating system appears, press F8.

3. On the Windows Advanced Options menu, select Directory Services Restore Mode.

4. When you are prompted, log on as the local administrator.
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Backing up Email Clients Data

Genie Backup Manager offers backup options for of the most commonly used email clients: Ms Outlook
(2000-2007, Windows Mail, and Outlook Express. Backup of other email clients' data is also supported

through Genie-Soft's free plugins project.
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MS Outlook

Genie Backup Manager can help you to backup all your Outlook data or transfer your existing Outlook
profile(s) from one computer to another. Using Genie Backup Manager you can migrate your Outlook profile
between different versions of Windows.

MS Outlook Data Items that GBM Can Backup:

e Main data files (Outlook.pst, Archive.pst) and additional data files created by the user.

e Extensions (addins).

e Settings and preferences, including customized toolbar settings, contacts and nicknames, send and
receive settings, navigation pane settings, rules etc ...

e Signatures: The blocks of formatted text and/or graphics that appear at the end of e-mails send that
identify yourself and your contact information.

e Stationery: Stationery and themes are a set of unified design elements and color schemes you want to
apply to messages. They specify fonts, bullets, background color, horizontal lines, images, and other
design elements you want to include in outgoing e-mail message

e Custom Forms: Custom forms created by outlook users. Forms are an easy way to distribute and
collect information electronically.

e E-mail accounts: POP3, IMAP and HTTP e-mail accounts

e Miscellaneous options set by the user while using Microsoft Outlook such as: notifications, displays,
read receipts, sending options and formats, maintenance preferences, etc...

e Categories: Any Microsoft Outlook item can be assigned to one or more categories. Consistent use of
categories makes it easier to locate specific items.
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Outlook Data Files

The following is a list of MS Outlook files that GBM can backup.

Description Stored in Typical File Location

Outlook data files | (.pst) drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Outlook

Offline Folders file | (.ost) drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Outlook

Personal Address | (.pab) drive:\Documents and Settings\<user>\Local Settings\Application

Book Data\Microsoft\Outlook

Offline Address (.oab) drive:\Documents and Settings\<user>\Local Settings\Application

Books Data\Microsoft\Outlook

Command bar and | (.dat) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

menu

customizations

(.dat)

Navigation Pane (:xml) drive:\Documents and Settings\<user>\Application

settings. Data\Microsoft\Outlook\Outlook.xml

This file includes

Shortcuts,

Calendar, and

Contact links.

Outlook contacts | (.nk2) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

nicknames

Rules (-pst) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook
Note: If you upgraded from a version of Outlook prior to Outlook 2002, you
may have a .rwz file on your computer hard disk drive. The file is no longer
needed and the rules information is now kept on the server for Microsoft
Exchange e-mail accounts, and within the personal folders file (.pst) for
POP3 and IMAP e-mail accounts. You can delete the file.

Print styles (Outlprnt with | drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook

no extension)
Signatures (.rtf, .txt, drive:\Documents and Settings\<user>\Application
.htm) Data\Microsoft\Signatures

Stationery (-htm) drive:\Documents and Settings\<user>\Application Data\Microsoft\Stationery

Custom forms drive:\Documents and Settings\<user>\Local Settings\Application
Data\Microsoft\Forms

Dictionary (.dic) drive:\Documents and Settings\<user>\Application Data\Microsoft\Proof




Templates (.oft) drive:\Documents and Settings\<user>\Application
Data\Microsoft\Templates
Send/Receive (.srs) drive:\Documents and Settings\<user>\Application Data\Microsoft\Outlook
settings
Message (.msg, .htm, | drive:\Documents and Settings\<user>\My Documents
.rtf)
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How to: Backup MS Outlook Data

1. Log in to the Windows account using the Outlook profile(s) you wish to backup.
2. From the left navigation menu in the backup wizard select What to Backup.
3. Select My Profile tab.

4. Expand the Outlook tree to view available profiles.

5. Select the checkboxes next to the profiles you wish to backup.

6. From the right-hand pane select the desired Outlook data items for each profile.
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How to: Backup While MS Outlook is Running

GBM may not properly backup Outlook data files if Outlook is running. To avoid files being skipped during
backup if the Open File Backup service is disabled, the user can set GBM to automatically close Outlook
before backup starts and then reopen it when backup is complete.

For a better solution to avoid this and all similar open-file problems, see Managing open files.

To set GBM to automatically close Outlook before backup:

1.

2.

3.

From the toolbar, click Tools, then select Global Preferences.

Select Backup Settings.

Select Automatically close Outlook before backup.

If you wish to let GBM run outlook again after backup, select Reopen Outlook after backup.

Enter the number of minutes GBM should wait for Outlook to close before aborting backup; GBM will
not be able to close Outlook if one of its dialogs or internal messages is open.
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How to: Restore Outlook Data

Although Genie Backup Manager can backup multiple Outlook profiles simultaneously, each profile must be
restored separately.

1. Open the restore wizard.

2. Load a backup, then click Next.

3. Make sure the My Profile tab is selected.

4. From the left-hand pane, expand the tree under Outlook, then select a profile.

5. From the items list pane select the Outlook Data Items you wish to restore.

6. Choose one of the following options:

e Create a new profile: create a new profile, and restore data to it.
e Overwrite existing profile: overwrite existing profile with the one being restored.
e Append to Existing profile: merge restored profile with an existing one. PST files will be

appended as additional data files, not synchronized.

7. If you wish to restore another Outlook profile, run Outlook once, then close it and repeat steps 1
through 6
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Outlook Express

Genie Backup Manager can help you to backup all your Outlook Express data or transfer your existing
Outlook Express identity from one computer to another. Using Genie Backup Manager you can also migrate
your Outlook Express emails and settings between different versions of Windows.
GBM is also the first and ONLY Outlook Express backup utility to allow users to view, read, print, and extract
emails directly from the backup without restoring them first.
e Outlook Express makes it easy for two or more users on the same PC to keep their mail separate using
identities. GBM can backup multiple Outlook Express identities simultaneously.

e Selecting an Outlook Express mail folder will automatically select all its subfolders.

e To select an Outlook Express mail folder without its subfolders or to deselect a folder without un-
selecting its subfolders, right-click on the checkbox next to it.
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How to: Backup Outlook Express

1. From the left navigation menu in the backup wizard select Where to Backup.
2. Select My Profile tab.

3. Expand the Outlook Express tree to view identities available for backup.

4. Select the checkboxes next to the identities you wish to backup.

5. From the right-hand pane select the desired Outlook Express data items for each identity.
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How to: Backup While Outlook Express is Running

GBM may not properly backup Outlook Express data if Outlook Express is running and if Open File Backup
(OBF) is disabled. To avoid files being skipped during backup, the user can set GBM to automatically close
Outlook Express before backup and then reopen it when backup is complete.

For a better solution to avoid this and all similar open-file problems, see Managing open files.

To set GBM to automatically close Outlook Express before backup:

1.

2.

3.

From the toolbar, click Tools, then select Global Preferences.
Select Backup Settings.
Select Automatically close Outlook Express before backup.

If you wish to let GBM run outlook Express again after backup, select Reopen Outlook Express after
backup.

Enter the number of minutes GBM should wait for Outlook Express to close before aborting backup.
GBM will not be able to close Outlook Express if one of its dialogs or internal messages is open
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How to: Restore Outlook Express Data

Although Genie Backup Manager can backup multiple Outlook Express identities simultaneously, each
identity must be restored separately.

10.

11.

If you are restoring to a new Windows installation, you must start Outlook Express once before
attempting to restore.

Open the restore wizard.

Load the backup, then click Next.

Make sure the My Profile tab is selected.

From the left-hand pane, select the identity you wish to restore.

From the items list pane select the Outlook Express data items you wish to restore.
Click Select identity.

Choose an identity from the list and click Select.

Click Back to Restore.

Finish selecting other backup items and click Next to start restore.

Repeat steps 2 through 10 to restore additional Outlook Express identities.
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How to: Synchronize Outlook Express Mail Folders

Genie Backup Manager isn't an Outlook Express synchronization tool per se’, however, GBM offers a work
around, by restoring data to a dummy temporary identity, from there the user can use Outlook Express
import functionality to synchronize emails form the existing identity with emails from the restored identity.

To synchronize Outlook Express Emails:

1.

2.

3.

10.

11.

12.

13.

14.

Open the restore wizard.

Load a backup, then click Next.

Make sure the My Profile tab is selected.

From the left-hand pane, select the identity you wish to restore.

From the items list pane select the Outlook Express data items you wish to restore.
Click Select identity.

Choose an identity from the list, then click Select.

Select Synchronize my emails.

Click Ok and complete the restore process.

When restore is complete, run Outlook Express.

From the File menu select Import then select Messages.

Select Microsoft Outlook Express.

Select Genie Backup ldentity and click Next until you reach the Select Folders page.

Choose one of the following options:

e Import all.

e Selected Folders.
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How to: Synchronize Outlook Express Settings

To synchronize settings and email accounts from a backed up Outlook Express identity with an existing
Outlook Express identity do the following:

1. Open the restore wizard.

2. Load the backup, then click Next.

3. Make sure the My Profile tab is selected.

4. From the left-hand pane, expand the Outlook Express list, then select an identity.

5. From the item list pane, make sure Outlook Express Root is not selected, and select Outlook
Express Data.

6. Click Select identity.
7. Choose an identity from the list, then click Select.

8. Click Back to Restore.
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How to: Extract Mail Folders Directly from a Backup

This features allows you to extract an Outlook Express mail folder directly from backup without having to
restore the entire identity.

1. Open the restore wizard.

2. Load the backup, then click Next.

3. Make sure the My Profile tab is selected.

4. From the left-hand pane, select an identity.

5. From the items list pane, expand the Outlook Express Root tree, and select an email folder.

6. Click Extract.

7. Select a folder then click Ok.
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How to: View Backed Up Emails

GBM is the first Outlook Express backup utility to allow users to view, read, print, and extract emails directly
from the backup without restoring them first.

1. Open the restore wizard.

2. Load the backup, then click Next.

3. Make sure the My Profile tab is selected.

4. From the left-hand pane, select an identity.

5. From the items list pane, expand the Outlook Express Root tree, then select an email folder.

6. Click View Emails.
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Windows Mail

Windows Mail is the successor to Outlook Express. Windows Mail builds on the foundation of Outlook Express,
adding a variety of new features designed to make your e-mail experience more productive and fun, while
helping to reduce risks and annoyances such as phishing and junk e-mail. With GBM, users can backup and
restore Windows Mail emails, accounts, rules, and stationary simply and easily with a click of a button.

Windows Mail Data Items that GBM Can Backup:

e Mail: Inbox, Outbox, drafts, Deleted Items, Junk email folders, and all user defined folders for emails

e Accounts: Email accounts, Internet news accounts and Directory Service accounts.

¢ Rules: Message rules created in Windows Mail

e Settings: This includes the options the user selects and sets while using Windows Mail such as:
notifications, displays, send/receive message options, read receipts, sending options and formats,
maintenance preferences, etc...

e Stationery: Stationery and themes are a set of unified design elements and color schemes you want to

apply to messages. They specify fonts, bullets, background color, horizontal lines, images, and other
design elements you want to include in outgoing email messages.



How to: Backup Windows Mail Data

1. From the left navigation menu in the backup wizard select Where to Backup
2. Select My Profile tab

3. Select Windows Mail



How to: Restore Windows Mail Data

1. Open the Restore wizard.

2. Load the backup, then click Next.
3. Make sure the My Profile tab is selected.
4. From the left-hand pane, select Windows Mail
5. Select one of the following options:
e Overwrite:This option enabled GBM to add missing emails, stationery to your current configuration. This
method is recommended even if you are restoring to a new installation

¢ Merge:This option enabled GBM to add missing emails, stationery to your current configuration. This method
is recommended even if you are restoring to a new installation



Backing Up Other Email Clients

Backup of email clients other than MS Outlook and Outlook Express is supported through Genie-Soft's free
Plugins project. The Genie-Soft plugins database contains hundreds of downloadable free plugins that
extend Genie Backup Manager's capabilities to support backup of extra items, such as email clients, that are
not already listed in the My Profile section. Users can also create custom plugins to backup additional items
not included in the database, by writing XML-based scripts (for more information see Scripting).
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Windows Registry

Windows Registry is a database that holds the settings and options in your windows system. Whenever you
make changes to your hardware configurations, software, users settings or PC preferences on your computer
these changes are reflected in and stored in windows registry.

If you are the kind of person who likes to fiddle with registry to tweak settings or if you're a software

experimenting fan, then backing up your registry is a necessity. Using Genie Backup Manager, you can
backup your entire registry or just a few selected keys.
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How to: Back Up the Entire Registry

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. In the left-hand pane Select the checkbox next to Registry.

4. Select Backup Entire Registry.
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How to: Back Up Selected Registry Keys

1. From the left navigation menu in the backup wizard select What to Backup.

2. Select My Profile tab.

3. In the left-hand pane Select the checkbox next to Registry.

4. Select Backup selected registry keys.

5. Click Add Registry Keys

6. Select a registry key then hit Add. Repeat this step until all desired registry keys are selected.

7. Click Done.
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How to: Restore Windows Registry

Restoring the entire registry must NOT be performed except on the same machine and under the same
Windows installation. Restoring the registry under a different Windows installation (for example after a
system format) or to another machine WILL corrupt your system.

Arbitrary restoring registry keys may have unpredictable consequences and cause your system to crash or
corrupt installed programs. It is recommended not to restore registry keys unless the user knows exactly
what the keys are for.

To restore Windows Registry

1. Open the restore wizard.

2.

3.

Load the backup then click Next.
Select My Profile tab.
Select the checkbox next to Registry.

From the right-hand pane, select the registry key(s) you wish to restore.
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The Desktop

The Desktop area is the preferred location for storing files that the user needs to be readily available and
accessible, however, the actual Desktop folder is nested in the drive in a location not obvious to most
people. Genie Backup Manager will backup and restore Desktop items to their correct locations on the target
computer regardless of the Windows version installed or the user account under which you are logged on.
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How to: Back up Desktop Items

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select Desktop.
4. From the right-hand pane select one of the following two options:
e All desktop: backup the entire Desktop area with all its files and subfolders. The desktop area
will be automatically re-scanned each time backup is performed to include newly added files and

folders.

e Selected files and folders: backup only a selected set of files and folders. Selection will not be
re-scanned for new files in subsequent backups.

Note:

Shortcuts (*.Ink) are excluded from the backup job as they are linked to different locations that may not be
restored in the original location causing broken and unused links.
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How to: Restore Desktop Items

Genie Backup Manager allows you to migrate your Desktop area items between different machines,
Windows, and user accounts.

1. Open the restore wizard.

2. Load the backup then click Next.

3. Select My Profile tab.

4. From the left-hand pane, select Desktop.

5. From the right-hand pane, select the Desktop items you wish to restore.

6. Select one of the following options:

e Restore to Desktop to restore to the desktop area of the currently logged on user.

e Restore to alternate location to restore to a different folder.
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My Documents Folder

Most applications, including VS.NET, and the Microsoft Office suite etc. consider ‘My Documents’ as the
default location for any user's work. However, this folder is mapped differently for each user on the same

computer.

Genie Backup Manager enables you to backup 'My Documents' folder quickly and easily, over and over again,
each time making sure that new and changed files are always backed up. Moreover, GBM will always restore
'My Documents' to its correct path on the target computer regardless of the Windows version installed or the

user account under which you are logged on.
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How to: Back Up My Documents

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select My Documents.
4. From the right-hand pane, select one of the following two options:
e All My Documents: Backup the entire 'My Documents' folder. Genie Backup Manager will
automatically re-scan the '‘My Documents' folder for newly added files before each backup run.
e Selected Files/Folders: Select specific files and folders to be backed up from within the "My

Documents' folder. Genie Backup Manager will only backup the original set of selected files each
time, newly added files and folders will be ignored.
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How to: Restore My Documents Folder

1. Open the restore wizard.
2. Load the backup, then click Next.
3. Make sure the My Profile tab is selected.
4. From the left-hand pane, select My Documents.
5. From the right-hand pane, select the Desktop items you wish to restore.
6. Select one of the following options:
e Restore to My Documents: to restore to the My Documents folder of the currently logged on
user.

e Restore to alternate location to restore to a different folder.
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Windows Address Book

Windows Address Book is where contact information is stored. This information is used by programs such as

Microsoft Outlook, Microsoft Outlook Express, Microsoft Internet Explorer, Microsoft NetMeeting, and
Microsoft Phone System.
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How to: Back Up Windows Address Book

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.

3. Select Windows Address Book.
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How to: Restore Windows Address book

1. Open the restore wizard.
2. Load the backup, then click Next.
3. Make sure the My Profile tab is selected.

4. From the left-hand pane, select Windows Address Book.

e Windows Address Book contacts are listed according to Outlook Express identities, to be able to view
the restored Windows Address Book contacts properly make sure restored Outlook Express identities
keep their old names. Otherwise synchronize your Windows Address Book data.
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How to: Synchronize Windows Address Book Contacts

Restoring Windows Address Book will replace the existing WAB file on the machine. The user can manually
synchronize the existing address book with the backed up version by doing the following:
1. Open the restore wizard.
2. Select the backup set, then click Next.
3. Make sure the My Profile tab is selected.
4. From the left-hand pane, select Windows Address Book.
5. Click View Backed Up Windows Address Book.
6. From the toolbar click File, then select Export.
7. Select WAB Address Book, and save the WAB file in a temporary location.
8. Run Outlook Express.
9. From the toolbar click File, then select Import.
10. Select Address Book.

11. Browse to the location of the saved WAB file and select it then click Ok.
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Windows Contacts

Microsoft Windows Vista provides a new mechanism and user interface for storing and retrieving information
about people (contacts) who are important to the users of Microsoft Outlook and Windows Mail (formerly
Outlook Express)



How to: Backup Windows Contacts Data?

1. From the left navigation menu in the backup wizard select What to Backup
2. Select My Profile tab
3. Select Windows Contacts

4. Select Include Windows Live Contacts (if available) if you wish to backup Windows Live contacts.
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How to: Restore Windows Contacts

1. Open the restore wizard.
2. Load the backup, then click Next.
3. Make sure the My Profile tab is selected.

4. From the left-hand pane, select Windows Contacts

Note:

This option is used to restore Windows contacts backed up originally via GBM, restoring windows contacts
will only restore missing contacts and will not delete newly created contacts that were not originally backed
up via GBM.
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Windows Favorites

In Microsoft Internet Explorer you can tell the program to remember a list of your "favorite” Web pages, so
that you can go back to them easily, without having to type in the address (URL) again. Genie Backup
Manager allows you to backup your Favorites, transfer them from one computer to another, or migrate them
between different versions of Windows.
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How to: Back Up Windows Favorites

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.

3. Select Favorites.
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How to: Restore Windows Favorites

1. Open the restore wizard.
2. Load the backup, then click Next.
3. Make sure the My Profile tab is selected.

4. Select Favorites.
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Windows Fonts

Windows Fonts are the files used by your operating system to display and print text. These fonts come in
many different styles and types, and their location is usually unknown to users. Genie Backup Manager
allows you to backup your Fonts, transfer them from one computer to another, or migrate them between
different versions of Windows.
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How to: Back Up Windows Fonts

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.

3. Select Windows Fonts.
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How to: Restore Windows Fonts

1. Open the restore wizard.

2. Load the backup, then click Next.

3. Make sure the My Profile tab is selected.

4. From the left-hand pane, select Windows Fonts.

5. From the right-hand pane select the fonts you wish to be restored.
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Media Files

Genie Backup Manager can be set to automatically backup music and video playback files of all formats
including: MP3, MPEG, DAT, WAV, RealPLayer files, MediaPlayer files, QuickTime files etc...

Genie Backup Manager offers two easy methods for locating and backing up media files on your computer:
using playlists, and scanning for media files.
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How to: Use Playlists to Backup Media Files

A media playlist is a table of your favorite media files -or more commonly, mp3s- that you have currently
loaded into a media player to play in a specific order, by saving this list to file you can reuse it to play the

same songs without having to re-select them each time.

Since most users already have their favorite songs on their machines organized in playlists, GBM offers a
novel way of backing up media files using these playlists to locate favorite songs and movie clips and copy

them to the backup destination.

GBM will also backup the playlist itself and regenerate it in the same original order at restore time so as to

play the same songs even if they were restored to a different location.

e GBM currently only supports 3 playlist formats: m3u, pls and wpl.

How to use playlists to backup media files?

1.

2.

3.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.

Click the plus sign next to My Media to expand the lest beneath it.

From the right-hand pane click Add Playlist.

Select a media playlist file then click Open.
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How to: Automatically Scan for Media Files

You can set Genie Backup Manager to automatically locate and backup media files scattered on your hard
drive. By default, when this option is selected, GBM will search for media files under the 'My Media' folder
located in 'My Documents’, however, the user can include new folders/drives to be scanned each time the
backup job is run. The supported formats GBM scans for are the following:

*.au,*.snd,*.asf,*.wm,*.wmx,*.wmd,*.wma,*.wax,*.wmv,*.wvx,*.avi,*.wav,*.mpeg,*.mpg,*.mpe,
*.mlv,*.mp2,*.mpv2,*.mp2v,*.mpa,*.mp3,*.mid,*.midi,*.rmi,*.aif,*.aifc,*.aiff,*.rt,*.rm,*.ram,*.ra,
*.rmvb,*.rp,*.rv,*.mov,*.qt,*.m4a,*.m4p,*.mpl,*.mpga,*.ssm,*.sdp,*.3gp,*.mp4,*.swa,*.3gpp,

*.mpa,*.mla,*.mlv,*.mqv, and *.bwf

Genie Backup Manager will automatically re-scan the default media folders, defined in Genie Backup
Manager, for new media files each time the backup job is run. However, new custom folders added by the
user won't be re-scanned, unless the user clicks the Scan button in backup job editing mode.

Using Automatic Scan to Back Up Media Files?

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select My Media.

4. If you wish to let GBM scan your entire computer for media files, click Scan, make sure Local drives
minus program files is selected, then click Search.

5. If you wish to scan for media files only in certain folders of your choice, click Add Folder, select the
folder you wish to scan, then click Ok. Repeat this step until all folders are selected.

6. When the media files list is populated, expand the three, to view a list of all detected media files, and
select the ones that you wish to backup.
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How to: Restore Media Files

1.

2.

3.

7.

Open the restore wizard.

Load the backup, then click Next.

Make sure the My Profile tab is selected.

Depending on the media backup method you selected, select Media Playlist or My Media Files.
From the right-hand pane, select the media files you wish to restore.

From the Restore files to list box select one of the following options:

e Original location: restore each media file to the original path from which it was backed up.

e Alternate location: restore all media files under a user-specified folder, maintaining the original
folder structure.

e Single folder: restore all media files to the root of a user-selected folder.

If you're restoring media files backed up using the playlist method, select Regenerate playlist to
generate a new playlist based on the new locations to where your files were copied.
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Images and Photos

You can set Genie Backup Manager to automatically locate and backup image files scattered all over your
hard drive. By default, when this option is selected, GBM will search for images under the 'My Pictures' folder
located in 'My Documents’, however, the user can include new folders/drives to be scanned for images.
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How to: Back Up Images and Photos

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select My Photos.

4. If you wish to let GBM scan your entire computer, click Scan, make sure Local drives minus
program files is selected, then click Search.

5. If you wish to scan only in certain folders of your choice, click Add Folder, select the folder you wish
to scan, then click Ok. Repeat this step until all folders are selected. Genie Backup Manager will
automatically re-scan the default media folders, defined in Genie Backup Manager, for new image files
each time the backup job is run. However, new custom folders added by the user won't be re-scanned,
unless the user clicks the Scan button in backup job editing mode before backup.

6. When the photos list is populated, expand the three, to view a list of all detected image files, and

select the ones that you wish to backup. GBM will display a thumbnail preview of any highlighted image
in the upper-right corner of the program.
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How to: Automatically Scan for Photos and Images

You can set Genie Backup Manager to automatically locate and backup media files scattered on your hard
drive. By default, when this option is selected, GBM will search for photos and images files under the '‘My
Pictures' folder located in 'My Documents’, however, the user can include new folders/drives to be scanned
each time the backup job is run. The supported formats GBM scans for are the following:

*.bmp, *.dib,*.jpg, *.jpeg, *.jpe, *.jfif, *.gif, *.tif, *.tiff, and *.png
Genie Backup Manager will automatically re-scan the default media folders, defined in Genie Backup

Manager, for new media files each time the backup job is run. However, new custom folders added by the
user won't be re-scanned, unless the user clicks the Scan button in backup job editing mode.

Using Automatic Scan to Back Up Images and Photos

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select My Photos.

4. If you wish to let GBM scan your entire computer for media files, click Scan, make sure Local drives
minus program files is selected, then click Search.

5. If you wish to scan for media files only in certain folders of your choice, click Add Folder, select the
folder you wish to scan, then click Ok. Repeat this step until all folders are selected.

6. When the media files list is populated, expand the three, to view a list of all detected media files, and
select the ones that you wish to backup.
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How to: Restore Images and Photos

1. Open the restore wizard.
2. Load the backup, then click Next.
3. Make sure the My Profile tab is selected.
4. Select My Photos.
5. From the right-hand pane, select the image files you wish to restore.
6. Select one of the following options:
e Restore to original location: to restore each image to the same path from which it was
originally backed up.

e Restore to alternate location to restore all image files under a different folder.
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Internet Explorer

GBM enables the user to backup the following items that define the way Internet Explorer functions:

e Internet Explorer Settings: Home page, security, privacy, content, connections, programs, and

advanced settings.

e Internet Explorer Cookies: Cookies are small text files that some web sites use to store information

on your PC, among other reasons they are used sometimes to grant you access next time around to
the web site or for customization features.
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How To: Backup Internet Explorer

1. From the left navigation menu in the backup wizard select What to Backup
2. Select My Profile tab

3. Select Internet Explorer

4. In the right-hand pane, select one of the following options:

¢ Internet Explorer Settings: Home page, security, privacy, content, connections, programs, and
advanced settings.

e Internet Explorer Cookies: Cookies are small text files that some web sites use to store
information on your PC, among other reasons they are used sometimes to grant you access next
time around to the web site or for customization features.
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How to: Restore Internet Explorer Settings

1. Open the Restore wizard

2. Select the backup set, then click Next
3. Make sure the My Profile tab is selected

4. From the left-hand pane, select Internet Explorer Settings
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Windows Settings

GBM gives users the ability to backup the following selection of personalized Windows settings and
configurations:

e Desktop Wallpapers: Desktop wallpaper settings and background image.

¢ Visual Appearance: Shapes, sizes and colors of windows, buttons and fonts.

e International settings: Regional settings, Time, Date, Currency and Number formats.

e Mouse Preferences: Mouse pointer behavior settings.

e Mouse Cursors: Preferred mouse cursor scheme.

e Connections Settings: Network connection accounts. Backing up Dialup Preferences will only backup
network connection settings; needed protocols should already be installed and the modem should
already be configured.

e Power Settings: PC power options properties located in the control panel.

e Consol Settings: Windows command prompt settings, options, colors, font and layout.

e Multimedia: For storing favorite sound, audio, and video settings plus the sounds scheme; sounds
associated with events in the windows system.

e Advanced Settings: Saves Windows Explorer advanced view settings, such as hide extensions, show
system files etc...
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How to: Back Up Windows Settings

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select Windows Settings.

4. Select the individual Windows settings items that you want to backup.
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How to: Restore Windows Settings

1. Open the restore wizard.

2. Load the backup, then click Next.

3. Make sure the My Profile tab is selected.

4. From the left-hand pane, select Windows Settings.

5. From the items list pane select the individual items you wish to restore.
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Files and Folders

This user data group allows you to backup files and folders from any location readily accessible from My
Computer using an easy to use Windows-Explorer-like interface.

Use this group when you know where your files and folders are located and need to be able to access/restore
files individually.

Selecting My Documents or items from the Desktop area for backup from My Folders does not guarantee that
they will be restored properly, since the paths to these folders might differ on a other computers, new
Windows installations or a different Windows versions. To avoid this, it is recommended to backup these
items from My Profile.

A plus sign means that the listing can be expanded to display additional items.
A minus sign means that the listing can be collapsed to hide displayed items beneath it.
An empty check box means that the item can be selected but is currently not.

A check box with a blue or green check mark means that the item is selected with all its
contents.

A gray check mark means that some but not all of the item’'s contents have been selected.

[] ﬂ m D 1 =+

A grayed out check box means that the item is not available or not selectable; if the item has an
Expand/Collapse box then the user needs to expand the listing to be able to select its contents.

My Folders Selection Options

Right-clicking on any item (file or folder) in the right-hand pane in My Folders tab and selecting Selection
Options presents the user with several options for selecting files and folders, these are:

e Select All: Select all items in the pane

e Clear All: Deselect all items in the pane

e Select Files Only: Only select files appearing in the current view

e Select Folders Only: Only select folders appearing in the current view

e Invert Selection: Invert the selection in the current view (unselected items will be selected, and
selected items will be deselected)

e Run: Will execute the selected file
e Open: Opens selected File/Folder
e Open in Windows Explorer: Opens the path of the file/folder in Windows Explorer

e Properties: Displays the File/Folder properties
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Selecting Files and Folders for Backup

The My Folders window is divided into two panes; the left-hand pane lists drives and folders, where as, the
right-hand pane lists the contents of the highlighted drive or folder form the left-hand pane.

Selecting files and folders for backup:

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Folders tab.

3. Click in the checkbox next to each individual folder or file that you wish to backup.

When running repetitive backup tasks, especially scheduled unattended backups, the user would normally
want files that are newly created in, or moved to a selected folder to be included in the backup
automatically, without having to manually select them each time before running the backup task.

Genie Backup Manager automatically detects files and subfolders that have been added to a selected folder
after the date of most the recent backup, provided that the parent folder was originally selected, i.e. the
check box next to the folder was ticked when the backup job was created (or edited).

Example:

Lets assume Jack has a folder called Week that has three files, Saturday, Sunday, and Monday. Jack first
creates a backup job, and selects the contents of the folder Week for backup. The next day, Jack adds
several new files and folders to the folder Week.

e Scenario: When Jack created the backup job he selected folder Week for backup by ticking its check
box, marking all its files for backup.
Result: All new files and folders will be appended to the backup.

e Scenario: Jack selected the three files by ticking folder Week's check box, but before saving the
backup job he deselected files Sunday and Monday.

Result: All new files and folders will be appended to the backup.
e Scenario: Jack selected the three files by ticking each file's checkbox individually.

Result: New files and folders won't be appended to backup.

Hidden and System files are made selectable in GBM only if they were visible in Windows Explorer. You can
set GBM to always hide files with hidden or system attributes so that they would not to be included in the
backup, regardless of their status in Windows Explorer. To do so, click Tools, then select Global
Preferences, select Backup Settings, then remove the check mark next to Show hidden files/folders in
My Folders.

On a Microsoft Windows Network if you share a folder that has a dollar sign '$' at the end of its name, then it
is considered to be hidden and other machines cannot see it, unless you explicitly enter its name in the
address bar or the command prompt. Users can add this kind of sources to the backup selection by manually



typing the complete path in the Manual File Selection panel. To add a new item, click Add, then type the
full path to file or folder. Select Include sub-folders if you wish child folders to be included in backup.
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File Filtering

Users can filter selected files in My Folders based on filename, date, and size criteria. For instance users can
choose to backup only .doc files in a certain folder or exclude all files that start with the letters (sa), backup
files created between May and June this year, and/or not to include files/folders larger than 2GB.

Filters are applied to sources through rules consisting of an include filter or an exclude filter. Only one
restriction type (include or exclude) can be assigned per rule. During backup, Genie Backup Manager
processes only files that match the include filter and do not match the exclude filter. If a file satisfies both an
include filter rule and an exclude filter rule, the exclude filter takes precedence and the file is not processed.

Rules are composed from restrictions created with one or more filename masks separated by a semicolon.
If a file satisfies at least one restriction, the rule will apply.

e Filters are not reflected in the file/folder selection tree, they are only processed during backup.
e A rule can be attached to any folder but is only processed if the folder was selected for backup.
e If arule is created for a folder "'m1" and another rule is created for one of its decedents (sub folders)

"\m1\m2", Genie Backup Manager will process the subfolder (m2)'s distinct rule regardless of the rule
of parent folder (m1).
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How to: Create New File Filters

1. From the navigation menu of the backup wizard select What to Backup.
2. Select My Folders tab.

3. Click File Filters.

4. Click Create Rule.

5. Select one of the following options:

o All data: Apply created filter to all selected files and folders in the backup job.

e Selected folder: Apply created filter to the folder that was highlighted prior to opening the File
Filters dialog.

e Browse for folder: Select a folder to attach the created filter to.
6. Click Ok to return to the main dialog.
7. Select one of the following two options:
¢ Include only file with the following mask: Only files matching the specified file mask will
processed during backup.
e Exclude files with the following mask: File matching the specified file mask will not be

processed.

8. Type the name or part of the name of files you wish to filter. You can use wildcard characters to filter
files that include a certain part of the name. For instance *.doc will filter all files with the extension
doc. You can add more than one file mask per rule, use a semicolon (;) as a separator.

9. If you wish to apply the created rule to the decedents of the selected folder, select Include Sub
folder

10. Click More options to enable filtering by size and date.

e Filtering by Size

e Filtering by Date

Quickly Adding a File Extension to a Previously Created Filter

From the My Folders tab in the What to Backup wizard screen right-click on the folder then choose Add
rule to this folder.
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How to: Import and Export File Filters

File filter rules can be exported from one backup job so as to be imported and used again in another.

Exporting File Filtering Rules to File

1. Open the File Filters dialog.
2. Select Export.
3. Choose a location to save the file to.

4. Click Ok.

Importing File Filtering Rules from File

1. Open the File Filters dialog.
2. Select Import, then select Import from File.

3. Browse to the location of the filters ".gix" file and select it, then press OK.

Importing Filters from Another Backup Job:

1. Go to My Folders.
2. Click File Filtering Rules.

3. Select Import, point to Import from Backup Job, then choose a backup job from the list.
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Auto-Exclude

Some system files and folders on the computer are not intended to be moved or copied, and are accessed
only by the Windows system, trying to backup these files will cause an error in GBM, so, to avoid running
into backup problems, GBM does not process these sources during backup in any of the defined backup jobs.
You can add custom Auto exclude rules to treat specific files and folders in the same manner.

Adding an Auto Exclude rule:

1. Click Tools in the toolbar, then select Global Preferences.

2. Select Auto Exclude.

3. Click Add.

4. Type the full path of the file/folder to be excluded. You can use wildcards here.
5. Type a description for the added item.

6. Click Ok.

7. Restart GBM.

e To disable all Auto-Exclude rules uncheck the option Enable Auto Exclude.

e To remove and Auto-Exclude rule, select it from the Auto-Exclude list then click Remove.
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Using Wild Cards

A wildcard character is a keyboard character such as an asterisk (*) or a question mark (?) that is used to
represent one or more characters when referring to files and folders.

Wildcard Characters Usage

Asterisk (*) | Use the asterisk as a substitute for zero or more characters. If you are looking for
a file that you know starts with "gloss" but you cannot remember the rest of the
file name, type the following:

gloss™*

This locates all files of any file type that begin with "gloss" including Glossary.txt,
Glossary.doc, and Glossy.doc. To narrow the search to a specific type of file, type:

gloss*.doc

This locates all files that begin with "gloss™ but have the file name extension .doc,
such as Glossary.doc and Glossy.doc.

Question Use the question mark as a substitute for a single character in a name. For
mark (?) example, if you type gloss?.doc , you will locate the file Glossy.doc or Gloss1.doc
but not Glossary.doc.
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How to: Restore Files and Folders

1. Open the restore wizard.
2. Load the backup, then click Next.
3. Select the My Folders tab.

4. Choose the files and folders you wish to restore.
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File Attributes

During backup, files attributes, including the modified date and time stamp, might change depending on
factors such as the storage device being used, file splitting, file system etc ... GBM saves this information
during backup and reassigns each file its correct attributes during restore.

To disable restoring file attributes:

1. Open the restore wizard.

2. Load the backup, then click Next.
3. Select My Folders tab.

4. Click Advanced.

5. Uncheck the option Restore file attributes.
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How to: Restore to a Different Location

By default, restore returns each file and folder selected for restore to the original path from where it was
backed up. Genie Backup Manager can be set to restore the data to a different user-specified path.

1. Open the restore wizard.

2. Load the backup, then click Next.

3. Select My Folders tab.

4. From the Restore file to combo box, choose one of the following options:

e Original location: restore each file and folder to its original path.

e Alternative: restore data to the specified path, while maintaining the original folder tree
structure.

e Single folder: restore data to the specified path, after collapsing the original folder tree
structure (no subfolders).
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Restoring Existing Files

By default, when a file being restored already exists in the destination folder, GBM will compare the two files'
modified date and time stamps and overwrite the existing file only if it was older than the one being
restored.

To change this behavior:

1. Open the restore wizard.

2. Load the backup, then click Next.
3. Select My Folders tab.

4. Click Advanced.

5. Choose one of the following options:

e Do not replace existing files.
e Replace older files.

e Always replace files.
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Programs and Program Settings

Other backup software charge users extra for downloading plugins that allow them to extend the software's
capabilities and automatically backup additional items, such as email clients data, application settings,
instant messengers, etc... Genie Backup Manager, however, offers its users unrestricted access to hundreds
of plugins from the constantly growing Genie-Soft add-ins database free of charge.

Genie Backup Manager comes bundled with several popular plugins, which users can select for backup from
the My Plugins tab in the backup wizard. Extra plugins can be downloaded by typing the name of an
application in the Easy plugin search and download box then clicking Go; GBM will search the database
and return a table of downloadable plugins matching that keyword.

My Plugins lists all installed plugins, but only those connected to applications detected on the system will be
selectable.

Users can also use GBM's XML-based scripting to create new plugins, and share them with friends, colleague,
and other GBM users.
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How to: Back Up Programs and Program Settings

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Plugins tab.

3. Select items you wish to backup.
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Adding and Removing Plugins

Extra GBM plugins can be obtained and installed using the following methods:

e Searching for new plugins in the Genie-Soft database and downloading them.

e Creating custom plugins using GenieScript.
e Visiting the Genie-Soft community forums, and requesting a new script to be written for the

program/item you wish to backup, Genie-Soft support team and other GBM users will do their best to
help you.

How to Search for Plugins?

1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Plugins tab.

3. Inthe Easy plugin Search and download field, type the name, or part of the name, of the
application or item you wish to be able to backup, then click Go.

4. Click the Download button next to the plugin you wish to install.

Installing a plugin:

Simply double-click the plugin file to install it.

Removing a plugin:

Right-click the plugin, then select Remove selected.
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How To: Restore Plugins

1. Open the Restore wizard.

2. Load the backup, then click Next.
3. Select the My Plugins tab.
4. Choose the Plugins you wish to restore.

5. Select Restore Destination (Per Plugin)

e Restore to Default Location: Restores data to the currently installed program location.

e Restore to Alternate Location (if applicable): If the plugin is a full application backup, the
user can specify a new location to restore the data as if you are installing the program in a new
location.

(J Tip

To undo plugin restoration, see Plugin Rollback
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Plugin Rollback

Restoring of data backed using plugins can be reversed with the help of the GBM restore-undo utility.
1. From the toolbar, click Tools, then select Undo Plugin Restore. A list of all restored My Plugins items
will open.

2. Select an item from the list and click Uninstall.
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Backup Types

There are four types of backups supported by GBM that depend on whether the user wants to backup all the
selected data, or just new and changed files. Backup types are: Full, Incremental, Differential, and Mirror.

The first run always backs up all selected files and folders, and a backup catalog (.gbp file) is stored on the
destination media. On subsequent runs, Genie Backup Manager searches for the catalog ".gbp file" in the
destination. If the media is empty or it does not contain the catalog file, GBM will start with a new full
backup. If the catalog file is found, GBM will make a new version, with a new version of the catalog file,
depending on the selected backup type and versioning settings.

e Genie Backup Manager also stores a local copy of the catalog file on the computer on which the backup
is performed. If you do not wish GBM to look for the file in the destination media - for instance, to
store different versions on separate media volumes - you can set GBM to read the index from the

local catalog.

e You can disable reset archive bit, if you do not want GBM to reset archives. This option will not affect
on the backup jobs ran on GBM

Notes:
Differential, incremental, and mirror backups are not supported in Easy mode

For Online Backup types, see Online Backup Settings
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Full Backup

When a user selects Full backup, GBM will back up all the selected files and folders each time the backup job
is run. New files will also be appended to the selection. On consecutive runs, in general, this backup type is
more time and space consuming than the other three backup types, but is more user friendly.

To set GBM to always run a full backup, select Full, from the Settings screen in the backup wizard.

e This backup type is best for one-time backups to migrate data between computers.
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Incremental Backup

In incremental backup, the first run always backs up all selected files and folders, and a backup catalog (.gbp
file) is stored on the destination media. On subsequent runs, Genie Backup Manager searches for the catalog
".gbp file" in the destination. If the media is empty or it does not contain the catalog file, GBM will start with
a new full backup. If the catalog file is found, GBM will create a new backup version, containing only files that
have been added or modified since the previous run. A new version of the catalog file will be appended to
the media, and files that were deleted, renamed or moved from the source machine will not be deleted from
the backup archive, but they will not be included in the last version of the catalog.

To set GBM to use incremental backup, select Increment, from the Settings screen in the backup wizard.

e Incremental backup, by default, uses the files' "modified date and time" attribute to determine which
files have been modified since the previous backup run.

Rollback

Enabling rollback during increment backup will cause GBM to keep old versions of modified files backed up in
previous runs; this way the user can still restore (rollback to) any backed up older version of a certain file to
protect against losing data by mistake.
With rollback enabled, each backup run will create a new file on the destination media - or a new folder if
compression was disabled - containing new and changed files, and a new catalog ".gbp file" will be added to
the root backup folder, with a trailing number appended to the filename; this number will be incremented by
one for each new version, starting with zero (0) on the second run.
Example:

Backup Job.gbp ... First run.

Backup Job.0.gbp ... Second version.

Backup Job.1.gbp ... Third version.

Backup Job.2.gbp ... Fourth version.

Disabling rollback means that GBM will append new files to the original backup file/folder, while modified
files will overwrite older versions.

When backup using compression is selected, if the data after compression exceeds 2GB in size, rollback will
be forced.
e The catalog will only contain one entry during incremental backup with rollback disabled. Each new
version catalog will replace the previous one.
e Disabling rollback is not supported when backup to tape is selected.

¢ Disabling rollback is not supported when FTP backup is selected.

e Backup without rollback is not supported backing up to Online



Backup without rollback is not supported when media is not re-writable, or if the user does not have
delete permission on the destination.

To backup to CD/DVD with rollback disabled, media needs to be re-writable and packet writing
enabled.

Backup without rollback is not supported when spanning to more than one location
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Differential Backup

In differential backup, the first run always backs up all selected files and folders, and a backup catalog (.gbp
file) is stored on the destination media. On subsequent runs, Genie Backup Manager searches for the catalog
".gbp file" in the destination. If the media is empty or it does not contain the catalog file, GBM will start with
a new full backup. If the catalog file is found, GBM will create a new backup version, containing only files that
have been added or modified since the most recent full backup. A new version of the catalog file will be
appended to the media, and files that were deleted, renamed or moved from the source machine will not be
deleted from the backup archive, but they will not be included in the catalog.

To set GBM to use differential backup, select Differential, from the Settings screen in the backup wizard.
Each backup run will create a new file on the destination media - or a new folder if compression was disabled
- containing new and changed files, and the new catalog ".gbp file" will be added to the root backup folder,
with a trailing number appended to the filename; this number will be incremented by one for each new
version, starting with zero (0) on the second run.
Example:

Backup Job.gbp First run.

Backup Job.0.gbp Second version.

Backup Job.1.gbp Third version.

Backup Job.2.gbp Fourth version.

o Differential backup, by default, uses the files' "modified date and time" attribute to determine which
files have been modified since the previous backup run.
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Mirror Backup

In mirror backup, the first run always backs up all selected files and folders, and a backup catalog (.gbp file)
is stored on the destination media. On subsequent runs, Genie Backup Manager searches for the catalog
".gbp file" in the destination. If the media is empty or it does not contain the catalog file, GBM will start with
a new full backup. If the catalog file is found, GBM will create a new backup version, in which new files will
be appended to the original archive, modified files will replace older versions, and files that are missing from
the source machine will be removed from the backup archive. The catalog ".gbp file" will be replaced with a
new version. The resulting backup archive consists of either one compressed file or one folder.

To set GBM to use mirror backup, select Mirror, from the Settings screen in the backup wizard.

Limitations of Mirror Backup

e When backup using compression is selected, if the data after compression exceeds 2GB in size

e The catalog will contain only one entry when mirror backup is enabled, with new versions of the catalog
replacing old ones.

e Mirror backup is not supported when backup to tape is selected.
e Mirror backup is not supported when FTP backup is selected.

e Mirror backup is not supported when media is write protected, not rewritable, or if user does not have
delete permission on the destination.

e To use mirror backup to CD/DVD, the media needs to be re-writable with packet writing enabled, and
limited to only one disc.

e Not supported when spanning to more than one location

Copyright (c) 2007 Genie-Soft, Inc. All rights reserved.



Security in Genie Backup Manager

Genie Backup Manager offers multiple levels of protection to ensure that backed up data is not accessible to
unauthorized persons. ZIP passwords offer moderate protection for compressed backups, with the added
flexibility of being compatible with most compression utilities, to allow users to manually restore data from
backup archives, while AES encryption has the advantage of being highly secure, as it is adopted by NIST as
an FIPS-approved (Federal Information Processing Standard) symmetric encryption algorithm that may be
used by U.S. Government organizations (and others) to protect sensitive information

Our online backup solutions enjoy an added level of protection, through username and password encryption,

as well as 128- bit Secure Socket Layer (SSL) data transmission, certified by the leading global provider of
SSL certificates, Thawte.
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Zip Password Protection

Genie Backup Manager uses standard zip format compression, and thus can add a standard zip compression
password to the created archive; using this protection method would still allow users to access their data
using ZIP-compatible compression utilities. Users will not be able to browse or restore files and folders
stored inside a ZIP-password-protected backup until they enter their passwords.

e This method only offers moderate protection; it is not recommended for securing sensitive data.

e ZIP passwords cannot be less than 6 characters long.

To add zip password protection to a backup job:

1. From the left navigation menu in the backup wizard select Settings.
2. From the Security box select Password Protection.

3. Type a password twice in the Password and Confirm Password fields
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Encryption

Encryption is encoding data to prevent any non-authorized party from reading or changing it. The level of
protection provided by encryption is determined by an encryption algorithm. The contents of the data that
you want to protect are encrypted based on a password that you specify. In order for GBM later restore the
original contents of the encrypted files, the correct password must be supplied

AES Encryption

GBM uses AES encryption. AES is the Advanced Encryption Standard. This encryption method, has been
adopted by NIST as an FIPS-approved (Federal Information Processing Standard) symmetric encryption
algorithm that may be used by U.S. Government organizations (and others) to protect sensitive information

GBM supports AES encryption in 3 different strengths: 128-bit AES, 192-bit AES and 256-bit AES. These
numbers refer to the size of the encryption keys that are used to encrypt the data; the higher the number
the stronger the encryption, at the expense of being slightly slower. All three methods can provide
significantly greater security than the password protection method.

The strength of encryption does not depend only on the length of the encryption key used but also on the
password supplied by the user. Please read more about Encryption Passwords

e GBM requires that the correct password be supplied before the contents of an encrypted backup set
can be viewed or restored to its original unencrypted form. The password is not required, however, for
actions that do not require access to the unencrypted contents of the file. In particular, encrypted files
can be deleted from backup set, or can be replaced within the backup set, without a password

Notes on encryption safety

Encryption can be a very effective measure for protecting your sensitive data; however, even encrypted
documents can be compromised . The following is a list of some of the ways in which the safety provided by
encryption can be compromised. Note that these are not GBM related risks but rather risks that arise from
mishandling the password or a file in its unencrypted form

AES encryption at 192-bit is not supported when Tape backup is selected.

If a keystroke monitor (key-logger) or other malicious code (such as a trojan horse) is running on your
computer, your password may be recorded when you type it. Be sure to check frequently for viruses and
follow other recommended computer safety procedures

If you extract an encrypted file and then delete it, it may be possible for someone to later "undelete” the file
using file recovery software or the Recycle Bin. You can use the Genie Wipe tool to irreversibly delete
sensitive files

When you extract, open or view a file directly from the backup set (using Catalog or from the Restore
Wizard), GBM must extract the file to a temporary location so that the associated program can open it. If
you subsequently close GBM without first closing the program that is using the file, GBM may not be able to
delete the temporary copy of the file, thereby leaving it on disk in unencrypted form. The associated
program may also make one or more backup copies of the decrypted file, and GBM will not be able to delete
these

After backing up or restoring encrypted files, some or all of the unencrypted file contents may remain in your



computer's memory or the page swap files on disk. A malicious user may be able to retrieve this
unencrypted information
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Using Encryption in Backup

GBM can protect backed up data from being accessed by unauthorized people using AES encryption. GBM
encrypts data on-the-fly, meaning that it encrypts files as they are being copied to the backup storage
device instead of first encrypting the entire data then backing it up.

To add AES encryption protection to a backup job:

1. From the left navigation menu in the backup wizard select Settings.

2. Select AES Encryption.

3. Type a password twice in the Password and Confirm Password text input boxes.
4. Click Encryption Strength.

5. Choose an encryption level.

Note

e Encryption applies only to the contents of backed up files. Information about an encrypted file, such as
its name, date, size, and attributes, can be viewed, without a password, by anyone who has access to
the backup set.

e Encryption is not supported in Easy Mode

Decrypting data during restore

Upon selecting a backup set with encryption protection for restore, GBM will request the encryption
password. The user will not be allowed to browse, view, extract or restore data unless the correct password

is supplied.
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Encryption Passwords

The security of your data depends not only on the strength of the encryption method but also on the
strength of your password, including factors such as length and composition of the password, and the
measures you take to ensure that your password is not disclosed to unauthorized third parties.

You should keep the following considerations in mind when choosing passwords for your files:

Encryption password cannot be less than 6 characters long

In general, longer passwords are more secure than shorter passwords. To take maximum advantage of
the full strength of AES encryption passwords lengths must be approximately:

e 15 characters for 128-bit encryption.

e 23 for 192-bit encryption.

e 31 characters for 256-bit encryption.

Passwords that contain a combination of upper and lower case letters, digits, and punctuation are more
secure than passwords containing only letters.

Because you can use spaces and punctuation, you can create "pass phrases” that are long enough but
still easy to remember and type.

Avoid using easily guessed passwords such as names, birthdays, Social Security numbers, addresses,
telephone numbers, etc...

Avoid storing the password on the same volume on which the encryption data is located.

Keep a record of the passwords you use and to keep this record in a secure place. GBM has no way to
access the contents of an encrypted file unless you supply the correct password.
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Online Backup Security

High data security and privacy during online backups in Genie Backup Manager are achieved through the
application of the following data-security standards:

Securing Account Passwords:

This security measure is applicable even when secure online backup method is not selected.

Passwords are encrypted using the SHA-256(Secure Hash Algorithm). This hash encrypted algorithm is one
of the required secure hash algorithms for use in U.S. Federal applications, including use by other
cryptographic algorithms and protocols, for the protection of sensitive unclassified information. This standard
is called secure because, for a given algorithm, it is computationally infeasible to find a message that
corresponds to a given message digest, or to find two different messages that produce the same message
digest. Any change to a message will, with a very high probability, results in a different message digest.

This Encryption methodology is a one way encryption; therefore it cannot be decrypted at the server’s side
and therefore there is not way recover a password from the data base the server will only be able to reset
the password and not recover it. The reset process will be sent to the user’s personal email, this process
prevents hackers from resetting the user’s account, which is a great feature to prevent user impersonation.

Securing Data transmission:

Genie Online Backup supports a 128- bit Secure Socket Layer (SSL) certified by the leading global provider
of SSL certificates Thawte. This protocol uses RSA encryption algorithm in order to encrypt the data on the
link and prevent hackers from eavesdropping on personal information.

This Authentication is done to reassure the clients that they are sending their information to the right source.
In other words, the certificate based authentication authenticates that we are who we say we are. This
authentication is done by the SSL certificate provided by Thawte. An SSL Web Server Certificate enables the
Genie Online Backup users to view the following information:

e The domain for which the certificate was issued. This allows them to check that the SSL Web Server
Certificate was issued for your exact host and domain.

e The owner of the certificate. This acts as further reassurance, since customers are able to see whom
they are doing business with.

e The physical location of the owner. Once again this reassures customers that they are dealing with an
actual entity.

e The validity dates of the certificate. This is extremely important, since it shows users that your Digital
Certificate is current.

Enabling Data Transmission Security:

1. From the left navigation menu in the backup wizard select Where to Backup.



2. Select Online Backup.
3. Click the Change User button.

4. Make sure Secure is selected.
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Pre and Post Job Commands

To run commands before or after backup is completed, users can use the Pre and Post Job Commands
option.

These are some of the helpful tasks that a user can accomplish using pre/post commands...

Task Command(s)

Checking disk drives for errors before backup. CHKDSK

Copying, moving, deleting and replacing files and folders. COPY, XCOPY, RENAME,
REPLACE, MOVE, DEL

Defragmenting a drive before or after backup. DEFRAG

Temporally disabling real-time antiviral software to speed up backup. Refer to the command line

options section of your anti-
virus help documentation.

Printing documents (such as the activity log when backup is done). PRINT

Shutting down, logging off or restarting the computer. SHUTDOWN

For a complete list of Windows system commands that can be used, open the Start menu, click Run, type
CMD and click Ok, then type help and press enter. for more information on using a specific command type
"<command=> /?" in the command prompt then press enter.

To attach pre/post job commands to a backup job:

1. From the left navigation menu in the backup wizard select Settings.

2. Click More Settings then select Pre & Post Job Commands.

3. Make sure the Enable Pre & Post Job Commands option is checked

4. From the Events list select whether to attach a pre, post, or pre-data confirmation job command.
5. Make sure Enable Command is selected.

6. Inthe Command Line box, type the command you wish to be executed or browse for a .batch, .cmd
or script file you wish to execute for multiple commands

7. If you do not wish for one process to run until the previous one in the sequence has finished, make
sure the Wait until previous process ends option is selected. Other wise the command and the
backup job will run almost simultaneously.

Environmental Variables

Output files from backup jobs have varying names, depending on the backup job name and the number of
the backup run. Using special environmental variable strings, you can write commands and pass the backup
job's output files as parameters without having to worry about their changing names:



$BACKUPOUTPUTS$ Resolves to the complete path of the main backup file/folder.
$LOGFILES$ Resolves to the complete path of the backup log file.
$BACKUPPRFOLDERS$ Resolves to the complete path of the parent folder containing the backup set.

$BACKUPFILENAMES$ The name of the output backup file, without the path.

e Environmental variables passed to commands must be enclosed in quotations, such as
"$BACKUPOUTPUTS$".

Built-In Commands

When using the following commands, Genie Backup Manager will open a dialog displaying the progress of the
command execution. Each one of these commands takes two parameters:

e Copy: Copy a file or folder to a new location.
e Move: Move a file or folder to a new location. The file/folder in the original location will be deleted.

¢ Rename: Rename a file or folder.
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Understanding Backup Sets and Purging

When the storage media is re-writable, and the user has the right folder privileges, Genie Backup Manager
can be set to delete old backup files created by the backup job, to save space. The way purging old backups
works varies depending on the backup type used. Purging is not supported when Mirror Backup is used .

To set GBM to purge old backup files created by a backup job:

1. From the left menu in the Backup Wizard, select Settings.
2. Click Purge Settings.

3. Select one of the following options:

e Keep old backups: Do not delete old backups

e Keep only last X backups: Keep only the last X backup files and delete files produced by older
backups

o Keep old backups for a period of X days: Delete any backup file older than X days

Backup Sets

To understand how purging works in Genie Backup Manager, the user needs to be familiar with the concept
of Backup Sets. For the purpose of this help documentation, a backup set is the minimum collection of
backup files - or folders, in the case of backup without compression - that are needed to successfully perform
a restore. For example, if the user wishes to restore files that were backed up using an incremental backup
job on March 23rd, then every backup file created by this backup job since that date and back to the most
recent full backup before that date should be present and are considered a backup set.

Purging works with backup sets and not backup runs. if the user chooses to "keep the last 5 backups”, that
means that Genie Backup Manager will always keep the most recent 5 backup sets created by that job.

Purging with Full Backup

Full backup copies all the selected files each time the backup is performed. Each time a full backup is
performed, a new backup set is created, and a bracketed number after the backup job name is incremented
by one, to denote the backup run number.

Since each backup run creates a backup set, keeping the last X backup sets means keeping the backup files
produced by the most recent X backup runs.

Ex:

A full backup is performed, job name is "My_backup"”, and purging option selected is "keep only last 4
backups".



1st run My _backup.gbp is created

2nd run My_backup(1).gbp is created
3rd run My _backup(2).gbp is created
4th run  My_backup(3).gbp is created

5th run My_backup(4).gbp is created and My backup.gbp
is deleted

6th run  My_backup(5).gbp is created and My
Backup(1).gbp is deleted

7th run  My_backup(6).gbp is created and My
Backup(2).gbp is deleted

Purging with Incremental Backup

During incremental backups, the first backup run performed after the backup job is created is a Full backup,
subsequent backup runs are all incremental until the user elects to reset the backup job to full, either
manually or automatically using the "Limiting increments" feature. GBM treats each full backup and all
subsequent increments until the next full run as a complete backup set.

For each backup run that is performed, a number after the backup job name is incremented by one, when
backup is switched to full, that number is reset and another bracketed number is incremented by one to
denote the number of full backups performed since the backup job was created.

When purging is selected, backup rotation is forced, which means that after a certain number of incremental
backups, Genie Backup Manager will automatically reset the backup type to full for one backup run, then
performs another set of incremental backup runs, then resets to full again, and so on.

If the user enables purging with the option to "Keep only last X backups", Genie Backup Manager will reset
backup type to full "full" X time, and on the X+1 run, it will delete the oldest backup set.

Example

An incremental backup is performed.

. Job name: "My_backup"

. Purging option: "keep only last 3 backups™

e Backup rotation: 2 increments.

* Bold denotes the creation of a new backup set.



1st run My_backup.gbp is created (Full backup) .

2nd run My_backup.0.gbp is created (increment). Backup Set
3rd run My _backup.1.gbp is created (increment).
4th run My_backup(1).gbp is created (Full backup) .
5th run My _backup(1).0.gbp is created (increment). Backup Set
6th run My_backup(1).1.gbp is created (increment).
7th run My_backup(2).gbp is created (Full backup) .
8th run My _backup(2).0.gbp is created (increment). Backup Set
9th run My _backup(2).1.gbp is created (increment).
10th run My_backup(3).gbp is created (Full).

My_backup.gbp, My_backup.0.gbp &

My_backup.1.gbp are deleted Backup Set
11th run My _backup(3).0.gbp is created (increment).
12th run My _backup(3).1.gbp is created (increment).
13th run My_backup(4).gbp is created (Full).

My_backup(1).gbp, My_backup(1).0.gbp &
My_backup(1).1.gbp are deleted

Purging with Differential Backup

During differential backups, the first backup run performed after the backup job is created is a full backup,
subsequent backup runs are all differential until the user elects to reset the backup job to full, either
manually or automatically using the "Limiting increments" feature. Each differential backup along with the
most recent full backup combined form a standalone backup set. Backup files produced in between those two
backups can be deleted safely.

Purging with ""Limit increments' option enabled

If purging was selected and the "Limit increments” option was enabled for X increments. Genie Backup
Manager will automatically reset the backup type to full after every X differential backup runs. Purging
in this case will treat each full backup run with all subsequent consecutive differential runs as a
backup set, and purging will work exactly like in the case of incremental backup.

Purging with "Limit increments' option disabled

If purging is selected with the "limit increments" option disabled, Genie Backup Manager will treat
each differential backup run along with the most recent full backup as a standalone backup set. Thus,
the option to "Keep only last X backups" means that only the full backup run, the last differential



backup, and the most recent X intermediate backups are kept.

Example

An incremental backup is performed.

e Job name: "My_backup"
e Purging option: "keep only last 3 backups"

e Limit increments: disabled.

1st run My_backup.gbp is created (Full backup) .
2nd run My _backup.0.gbp is created (Differential).
3rd run My_backup.1.gbp is created (Differential).
4th run My _backup.2.gbp is created (Differential).
5th run My_backup.3.gbp is created (Differential).

My_backup.0.gbp is deleted.

6th run My _backup.4.gbp is created (Differential).
My_backup.1.gbp is deleted.

7th run My _backup.5.gbp is created (Differential).
My_backup.2.gbp is deleted.

8th run My_backup.6.gbp is created (Differential).
My_backup.3.gbp is deleted.

Rotating Backups

When increment or differential backup is used, the user can set GBM to automatically switch to full backup
after a specific number of increments. Each full backup and its subsequent increments are treated by GBM as
one backup set, enabling the user to purge old backup sets safely.

To set GBM to limit the humber of increments for each backup set:

From the left menu in the Backup Wizard, select Settings

1. Click Purge Settings.
2. Select the Limit increments option.

3. In Number of increments, type the number of increments you wish GBM to perform before switching
to full backup .
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Understanding Archive Bit and Backup Types

The archive bit is a file attribute that is set whenever a file is modified. For backups that use archive bits,
this bit is turned off after the backup completes, indicating to the system that the file has been backed up. If
the file is changed again before the next backup, the bit will be turned on and Genie Backup Manager will
back up the file.

Whenever a file is created or changed, the operating system activates the Archive Bit or modified bit . By
default, unless you specifically select to use the archive bit, Genie Backup Manager uses the last modified
date and time stamp to determine whether a file has been backed up.

Using the archive bit in determining changed files, however, can cause confusion if the user is not careful, if
the data selection for more than one backup job overlap. To explain this, consider this scenario: Jack has
two backup jobs that he has scheduled to run consecutively, named Documents and Work . The folder
Monthly Reports was selected to be backed up by both backup jobs. Come backup time, the job Documents,
will backup the folder the turn off the archive bit. When its time for the job Work to run, it will find that the
folder has already been backed up and skips the folder.

When the archive bit method is used with full, increment or mirror backup, GBM will turn off the archive bit
after each backup run. However, when used with differential backup, GBM will only reset the bit in the first
full backup, but not in subsequent differential runs, this way, GBM will always keep backing up files that have
changed since the first full backup.

To set GBM to reset the archive bit after backup:

1. From the left menu in the backup wizard Select Settings.
2. Click More Settings then select Advanced Settings.

3. Select Reset the Archive Bit.

To use the archive bit in determining changed files:

1. Click the Start menu in the Windows toolbar, then select Run.
2. Type regedit.

3. Browse the registry until you reach the following key:
HKEY_CURRENT_USER\Software\Genie-Soft\GBMAPPLICATION\Main\

4. Double-click the value CompareMethod.

5. Set the value to 0 (zero).
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Adding a Timestamp to the Backup File

A timestamp is a combination of date + time that is appended at the end of the backup filename to indicate
when the backup run was performed

To attach a timestamp to the backup set:

1. From the left navigation menu in the backup wizard select Job Info.

2. Click Backup Filename Options.

3. Select Attach timestamp to backup set.

4. From the Timestamp format combo-box choose preferred date/time format.

5. Click Ok.

Timestamp formats

Timestamp formats are:

e Month dd, yyyy@hh:mm:ss AM/PM
e Day of the week, Month dd, yyyy

e Month dd, yyyy

e yyyy-mm,dd

e Month dd

e mm-dd-yyyy@hh-mm AM/PM

e mm-dd-yyyy@hh-mm-ss AM/PM

e hh.mm.dd AM/PM
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Rotating Backup Types

When increment or differential backup is used, the user can set GBM to automatically switch to normal
backup after a specific number of increments. Each full backup and its subsequent incremental or differential
executions are treated by GBM as one backup set, enabling the user to purge old backup sets safely.

To set GBM to limit the number of increments for each backup set:

1. From the left menu in the backup wizard, select Settings.
2. Click Purge Settings.

3. Select the Limit increments option.

4. In Number of increments, type the number of increments you wish GBM to perform before switching
to full backup.

Note:

You can also rotate backup types using Advanced Schedule
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Compression

Genie Backup Manager uses non-proprietary ZIP64 compatible compression to reduce backed up data size
and save space, supporting up to 264 -1 files within a zip archive as well as files that have a size greater
than 4GB, for a zip file size that can reach up to about 18 million terabytes ( more precisely, 2764-1
bytes).

The Genie Backup Manager compression engine offers fast performance and low memory usage. Speed
improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better compression than
other formats on many popular file types, especially XML data.

Users can choose between 9 levels of compression ranging form no-compression, to best.

To set GBM to compress backed up data:

1. From the left navigation menu in the backup wizard select Settings.
2. Select Use Compression.

3. Select the desired compression level from the combo box.

Backup without Compression

Selecting to backup data without compression would cause GBM to copy the data to a folder on the storage
device while preserving the original file/folder structure, this makes data more accessible and less
susceptible to corruption.
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Power Management Options

Users can set Genie Backup Manager to trigger a power-saving event after a backup job has been executed.
Allowed options are:

Exiting Genie Backup Manager.

e Shutting down computer.

e Setting computer on Hibernate mode.
e Logging off computer.

e Setting computer on Stand-by mode.

To configure power-saving options for a backup job, select the Settings screen from the backup wizard, click
More Settings, then select Advanced Settings. Selected power-saving options must be supported by the
computer. To configure power management settings for your computer, double-click Power Options in the
Control Panel.
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How to: Create Backup Shortcuts on the Desktop

Users can create shortcuts on the desktop area for created backup jobs for easy access. Shortcuts also run
backup jobs without the need to go through the backup wizard.

To create a shortcut for a backup job:

1. Open Jobs Manager.
2. Select a backup job.

3. Click Create Shortcut.
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Command Line Parameters

Genie Backup Manager can be started with various command line parameters to execute different actions on
a particular backup job, such as loading and running a backup job, running the application minimized,
alternating between backup types, shutting down the computer after backup etc. The parameters can be
used to create shortcuts which start backup tasks automatically.

Syntax

GBMS8 [-e] [-job "backup job name"] [-h] [-noexit] [-showlogfile] [-novalidate] [-bt|1 2 3 4] [-shutdown| 1 2 3 4]

Parameters

-e

Activate the Command Line engine.

-job "job name" Name of the backup job to be performed.

-novalidate Do not verify backed up data after backup.
-h Run the backup monitor minimized when backup starts.
-showlogfile Display backup log when backup is complete.
-noexit Do not exit Genie Backup Manager after backup.
-bt Specify backup type to be used with this backup run.
-btl Force running the backup job in full mode (backup all selected files).
-bt2 Force running the backup job in increment mode.
-bt3 Force running the backup job in mirror mode.
-bt4 Force running the backup job in differential mode.
-shutdown Choose power saving option to be executed when backup is complete.

-shutdownl Shutdown computer.
-shutdown2 Hibernate.
-shutdown3 Logoff.

-shutdown4 Standby.
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Data Scheduler

Backing up data can take a lot of time depending on the size of the data intended for backup, during which a
large portion of the machine's resources are consumed by the backup application. To avoid interrupting work
or slowing down the machine while it is being actively used, users can schedule backup tasks to run
unattended at times that guarantee no interruptions to their work. Scheduling also insure that the data is
being backed up on a regular basis without user interaction.

Scheduling Backups are Step 5 in the Backup Wizard. GBM enables users two modes of backup scheduling in
normal mode:

Basic Schedule: Schedule your backup Daily, Weekly, Monthly, Once, or at Windows login

Advanced Schedule: This option enables the user to schedule backups, rotate backup types, and limit
backup sets in one simple step.
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Basic Schedule

Scheduling is step 5 of the backup process in the backup wizard, in this step you can select how often you
wish the backup job to be executed. Available options are: Every few hours, Daily, Weekly, Monthly, Once,
and At Windows login.

How to schedule backup jobs in Basic Schedule?

1. From the left navigation menu in the backup wizard select Schedule

2. Check Enable Schedule, to enable schedule options.

3. Select how frequent you wish to run the backup:

Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run

Run Daily: Runs backup daily at a specific time

Run Weekly: Specify the time and days you wish the backup to run
Run Monthly: Specify the time and day of the month

Run Once: Run this backup one time on a specific time

Run at Windows logon: Runs every time you logon into your computer

4. Under Security Settings, you can specify if you wish to run the backup whether the user is logged on
or not. If you select Run whether user is logged on or not, you must enter the Windows login
username or password; otherwise your backup will not run if Windows is logged out.

5. In More Settings, you can specify the following options:

Minimize backup window when running job: Selecting this option runs the backup job while
scheduled backup window is minimized

Do not start backup if the computer is running on batteries: You can set this option that
tells the task to run only if the computer is on AC power (not battery power)

Do not wait 10 seconds before starting backup: By default the scheduled backup has a 10
second delay counter before actually running the backup. Choosing this option will enable to run
the task without this 10 second delay.

Wake up computer to run this task (if supported): If you computer is set to sleep at the
time of backup, you can choose to wake up the computer to run the task. This option is enabled
if Run whether user is logged on or not is enabled.



Advanced Schedule

A common practice in scheduling backups is to set the task to run backup in normal mode (all selected files)
on a weekly or monthly basis, and in increment or differential mode daily or weekly, the recurrence of
backups depends on how critical the data is and how frequently it changes. This all can be achieved in
Advanced Schedule mode

How to schedule backup jobs in Advanced Schedule?

1. From the left navigation menu in the backup wizard select Schedule

2. Check Enable Schedule, to enable schedule options.

3. Choose Advanced Schedule

4. By default, Full Backup Scheduling is always enabled as you cannot perform a

incremental/differential backup without a full backup. Select how frequent you wish to run the backup
as full backup type:

e Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run
e Run Daily: Runs backup daily at a specific time
e Run Weekly: Specify the time and days you wish the backup to run
e Run Monthly: Specify the time and day of the month
e Run Once: Run this full backup one time on a specific time
e Run at Windows logon: Runs every time you logon into your computer
5. Select Differential/Incremental Backup (optional) and select how frequent you wish to run
incremental/differential backup:
e Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run
e Run Daily: Runs backup daily at a specific time
e Run Weekly: Specify the time and days you wish the backup to run
6. Under Security Settings, you can specify if you wish to run the backup whether the user is logged on
or not. If you select Run whether user is logged on or not, you must enter the Windows login
username or password; otherwise your backup will not run if Windows is logged out.
7. In More Settings, you can specify the following options:
e Limit Number of backup sets to (if supported by media): This option enables GBM to keep the

most recent "X" number of full backups with its incremental/differential backups

e Minimize backup window when running job: Selecting this option runs the backup job while
scheduled backup window is minimized



e Do not start backup if the computer is running on batteries: You can set this option that
tells the task to run only if the computer is on AC power (not battery power)

e Do not wait 10 seconds before starting backup: By default the scheduled backup has a 10
second delay counter before actually running the backup. Choosing this option will enable to run
the task without this 10 second delay.

e Wake up computer to run this task (if supported): If you computer is set to sleep at the
time of backup, you can choose to wake up the computer to run the task. This option is enabled
if Run whether user is logged on or not is enabled.

To learn more about how to rotate backups using advanced schedule, see How to: Rotate Backups using
Advanced Scheduling

Notes:

e Advanced Scheduling is not supported in easy mode

e Limiting backup sets is not supported on FTP, Tape, CD/DVD using burning technology, and when the
backup is spanned to multiple locations

e Advanced scheduling overwrites purge settings and backup types specified in the settings page when
schedule runs. If you backup manually, it will take backup settings from the Backup Settings page.



How to: Rotate Backups using Advanced Scheduling

Rotating backup types is recommended for more reliable backups. The following examples will demonstrate
how to perform this practice easily in advanced scheduler.

Example 1:

Perform full backups on the first Sunday of the month and differential backups weekly on Fridays:

¢ In the advanced schedule, under Full backup, select Run Monthly
e Set the time you wish the backup to run, and then select on the first Sun of the month
e Mark the checkbox next to Differential Backup (optional) to enable differential backup schedule

e Select Run Weekly and set the time for the backup to run and under on the following days select
Fri

Example 2:

Perform full backups weekly on Sunday, incremental backups daily every 5 hours the rest of the week, and
on the beginning of a new week, delete the backups of the last week

In the advanced schedule, under Full backup, select Run Weekly

e Set the time you wish the backup to run, and under on the following days select Sun
e Mark the checkbox next to Incremental Backup (optional) to enable incremental backup schedule

e Select Run Every Few Hours, in Run Every set it to 5 hours, and under on the following days
select Mon, Tue, Wed, Thurs, Fri, and Sat

e Under More Settings, change Limit number of backup sets to (if supported by media) from
unlimited to 01



The Backup Monitor

When running a backup job as a scheduled backup task or from a desktop shortcut the task will be run in a
small window called the Backup Monitor.

The Backup Monitor Controls:

Help: Opens the Help documentation

Show Log...: Displays the backup log, this option is only enabled after backup completes

Abort: Aborts backup progress

Status bar: This window will display the status of the backup task along with a bar indicating progress.
Pause: Pauses the backup, this option is enabled during the backup process

Stop Timer: Cancels the 10 second timer before backup starts, to start the backup manually, click Start
Backup

Snooze: Postpones the backup and runs it later specified in the Click Snooze to be reminded again in.
You can choose the to snooze for:

. 10 minutes: after 10 minutes run backup

° 30 minutes: after 30 minutes, run backup

. 1 hour: after an hour run backup

. 2 hours: after 2 hours run backup

° 8 hours: after 8 hours, run backup

. 1 day: run this backup the next day at the same time
Note:

You can only snooze before backup starts

Computer power options: Set or change the computer power options to be performed after backup
completes. These options are:

. No Power option: do not perform anything after backup completes
. Shutdown: Shutdown computer after backup completes

. Logoff: Logoff computer after backup completes

. Hibernate: Hibernate computer after backup completes

. Suspend: Suspend computer after backup completes

For more information about power options, see Power Management Options







SQL Server

The need to back up databases on a regular basis is a major component of managing any production system.
Without proper backup of your Microsoft SQL databases, your company's data is just one administrator's
error away from disappearing permanently. Genie Backup Manager offers quick, easy and reliable backup of
your SQL Server data, without the need for elaborate scripts.

Genie Backup Manager does NOT require disconnecting from the SQL Server in order to create a window for

backup. Administrators and users can still connect to the SQL Sever and perform queries on the database
while GBM takes a point-in-time copy of the various tables.
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How to: Register MS SQL Plugin

Upon purchasing the SQL plugin, the user will receive an email containing a serial number for unlocking the
SQL Backup.

To register MS SOL plugin:

1. Start GBM.
2. Click Backup.
3. Under SQL Backup in Backup Category, click Register SQL plugin

4. Type or copy-paste the serial number into its designated field then click OK.
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How to: Backup SQL Server Data

Please refer to the SQL Server Backup Strategies page for more information on the best backup plan to
adopt for your SQL Server databases.

1. From the Main Page, select Backup

2. In Backup Category, Select SQL Backup

3. From the left navigation menu in the backup wizard select What to Backup

4. Expand the SQL Server list, select the server instance you wish to backup from.
5. Mark the checkbox next to each database you wish to backup.

6. Click Next to continue

Important note:

e Under the full or bulk-logged recovery model, before you can restore a database, you must back up the
active transaction log.
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SQL Databases

When you install SQL Server 7.0, the setup program automatically creates four system databases along with
two sample user-defined databases i.e. Pubs and Northwind. The four system databases that play a vital role
in the successful operation of SQL Server are Master, Model, Msdb and Tempdb database.

Master Database

This database stores all critical information such as server specific configuration information, user login
accounts, running processes, system error messages, system stored procedures etc. It also records the
existence of other databases and the location of the primary files that contain the initialization information
for the user databases. So it's always preferable to have a recent backup of this database.

Model Database

This database acts as a template for the new databases i.e. whenever you create a new database the
database objects present in this database get copied onto the new database. If you want to perform some
common operations on all user databases then you can include those objects such as tables, procedures etc
so that the new database also contains them.

Msdb Database

This is one of the system databases that play an important role in SQL server's management and
maintenance. It contains some system defined tables that are specific to this database only. The Msdb
database contains task-scheduling, exception handling, alert management and system operator information
i.e. it holds the information of all the operators such as email addresses or pager numbers and history
information about all the backups and restore operations.

Tempdb Database

As the name suggests this database stores all the temporary tables and the temporary results generated by
group by, order by, distinct clause etc. The temporary data resides on the tempdb database till the user is
connected to the SQL server. All the temporary data and tables related to the user get dropped once the
user logs out from the SQL Server. All the global variables lose their values after SQL Server shuts down or
SQL Server crashes. Tempdb auto grows as needed and each time the system is started; tempdb is reset to
its default size (i.e. 8.0 MB for data file and 0.5MB for log file). Because Tempdb is created every time SQL
Server is started, the model database must always exist on a SQL Server system.

Important Note:

Before attempting to restore a System database (Master, Msdb, model, or Pubs) you must start SOL
Sever in single user mode.
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SQL Recovery Models Overview

In order to make backups easier to implement, Microsoft has grouped the various strategies that can be
employed into three stereotypes or models: simple, full, and bulk-logged. These SQL Server-specific models
not only help you think about your needs, but also simplify the implementation of the appropriate strategy.
The recovery models are implemented per database, and determines how much data loss is acceptable in
case of a failure and what types of backup and restore functions are allowed.

Simple Recovery Model

This model minimizes administrative overhead for the transaction log, because the transaction log is not
backed up. The simple recovery model risks significant work-loss exposure if the database is damaged. Data
is recoverable only to the most recent backup of the lost data. Therefore, under the simple recovery model,
the backup intervals should be short enough to prevent the loss of significant amounts of data. However, the
intervals should be long enough to keep the backup overhead from affecting production work. Including
differential backups in the backup strategy can help reduce the overhead.

Select Simple if:

Your data is not critical.

e Losing all transactions since the last full or differential backup is not a problem.
e Data is derived from other data sources and is easily recreated.
e Data does not change often.

e Space is limited to log transactions. (This may be a short-term reason, but not a good long-term
reason.)

Full Recovery Model

Provides the normal database maintenance model for databases where durability of transactions is
necessary. Log backups are required. This model fully logs all transactions and retains the transaction log
records until after they are backed up.

Select Full if:

Data is critical and you cannot afford to lose any data.
e You always need the ability to do a point-in-time recovery.
e Bulk-logged activities are intermixed with normal transaction processing.

e You are using replication and need the ability to re-synchronize all databases involved in replication to
a specific point in time.



Bulk-Logged Model

This recovery model bulk logs most bulk operations. It is intended solely as an adjunct to the full recovery
model. For certain large-scale bulk operations such as bulk import or index creation, switching temporarily to
the bulk-logged recovery model increases performance and reduces log space consumption. Log backups are
still required. Like the full recovery model, the bulk-logged recovery model retains transaction log records
until after they are backed up.

Select Bulk-Logged if:

e Data is critical, but logging large data loads slows down the system.
e Most bulk operations are done off hours and do not interfere with normal transaction processing.

e You need to be able to recover to a point in time.

Changing Recovery Models in SQL

1. After connecting to the appropriate instance of the Microsoft SQL Server Database Engine, in Object
Explorer, click the server name to expand the server tree.

2. Expand the Databases.

3. Right-click a database, and then click Properties, which opens the Database Properties dialog box.
4. Inthe Select a Page pane, click Options.

5. The current recovery model is displayed in the Recovery model list box. Optionally, to change the
recovery model select a different one from the list.

Or from the terminal, run this command ...

e ALTER DATABASE {database name} SET RECOVERY {FULL | SIMPLE | BULK_LOGGED}
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SQL Data Protection

Protecting your mission critical databases strongly rely on understanding the SQL backup types and recovery
models. GBM gives the users and easy to use, Continuous Data Protection (CDP) for ultimate SQL database
protection . Users can also perform single backups from the Single Level Protection (SLP) page.
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SQL Backup Types

Choose between different backup methods, for SQL Backup. The first run in all times must be Full or The
backup will fail or its restore will be unreliable. SQL backups are not like other backups in GBM, as each
backup done on SQL backup, even if it is a different job, depends on previous runs. It is recommended that
your SQL backups are created in separate backup jobs from your other data.

e Database-complete: Backup all data in the database including the transaction log

e Database-differential: Backup all data in the database, including the transaction logs, since the last
full backup

e Transaction Log: Backup all items in the transaction log.

Note:

e Transaction logs can only be backed up in Full Recovery mode
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Database-Complete

When a user selects Complete backup, GBM will back up all the data in the database. Every table, stored
procedure and all other objects in the database are placed into a single backup file. Complete backup must
be done before backing up via Database-Differential or Transaction Log.

To set GBM to perform a complete backup:

1. From the left navigation menu in the backup wizard select CDP.
2. Goto Single Level Protection (SLP)

3. From the SQL Backup Type group select Database-Complete.
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Database-Differential

Database differential backup will gather all changes since the last full backup into a backup file. If you are
using Simple Recovery model, it is recommended that you do differential backup at least once a day.

To set GBM to perform Database differential backup:

1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

3. From SQL Backup Type select Database Differential.

Important Note:

When choosing Database differential Backup, you must make sure that you have performed a database
complete backup run either in the same job or a different job

Job naming in database differential

If all the SQL backup is done in the same job, your output files will look as follows:
Backup Job.gbp ... Database-complete backup

Backup Job.0.gbp ... First Database-differential backup run

Backup Job.1.gbp ... Second Database-differential backup run

Backup Job.2.gbp ... Third Database-differential backup run

If your differential runs are separate from the complete backup your output files will be as follows:
complete.gbp ... Database-complete backup

differential.gbp ... First Database-differential backup run

differential.0.gbp ... Second Database-differential backup run

differential.1.gbp ... Third Database-differential backup run

You can also make each operation in separate jobs as well and the naming will be as follows:

complete.gbp ... Database-complete backup



first run.gbp ... First Database-differential backup run
second.gbp ... Second Database-differential backup run

third.gbp ... Third Database-differential backup run
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Transaction Log

When choosing Transaction Log backup, you must make sure that you have performed a database complete
backup run either in the same job or a different job or the backup will fail. The backup will also fail if you are
not in full recovery model, to learn about recovery models, click here.

Transaction log will backup the transaction log and it is recommended to backup very frequent depending on
the database traffic.

To set GBM to perform Transaction log backup:

1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

3. From SQL Backup Type select Transaction log.

Job naming in Transaction log

If all the SQL backup are performed in the same job, your output files will look as follows:
Backup Job.gbp ... Database-complete backup

Backup Job.0.gbp ... First transaction log run

Backup Job.1.gbp ... Second transaction log run

Backup Job.2.gbp ... Third Transaction log run

If your differential runs are separate from the complete backup your output files will be as follows:
complete.gbp ... Database-complete backup

transaction.gbp ... First transaction log run

transaction.0.gbp ... Second transaction log run

transaction.1l.gbp ... Third Transaction log run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Database-complete backup

first run.gbp ... First transaction log run

second.gbp ... Second transaction log run

third.gbp ... Third transaction log run
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Continuous Data Protection

A common practice in protecting SQL Data is to run Database complete with differential and/or transaction
logs backup to ensure latest data recovery, for more information, please view SQL Server Backup

Strategies

How to protect SQL databases?

1. From the left navigation menu in the backup wizard select CDP
2. Select Continuous Data Protection (CDP)
3. Database Complete should be performed as you cannot perform a differential/transaction log backup
without a full backup. Select how frequent you wish to run the backup as full backup type:
e Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run
e Run Daily: Runs backup daily at a specific time
e Run Weekly: Specify the time and days you wish the backup to run
e Run Monthly: Specify the time and day of the month
e Run Once: Run this full backup one time on a specific time
e Run at Windows logon: Runs every time you logon into your computer
4. Select Differential/transaction log Backup (optional) and select how frequent you wish to run
differential/transaction log backup:
e Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run
e Run Daily: Runs backup daily at a specific time
e Run Weekly: Specify the time and days you wish the backup to run
5. Under Security Settings, you can specify if you wish to run the backup whether the user is logged on
or not. If you select Run whether user is logged on or not, you must enter the Windows login
username or password; otherwise your backup will not run if Windows is logged out.
6. In More Settings, you can specify the following options:
e Limit Number of backup sets to (if supported by media): This option enables GBM to keep the
most recent "X" number of database-complete backups with its differential/transaction log

backups

e Minimize backup window when running job: Selecting this option runs the backup job while
scheduled backup window is minimized

e Do not start backup if the computer is running on batteries: You can set this option that



tells the task to run only if the computer is on AC power (not battery power)

e Do not wait 10 seconds before starting backup: By default the scheduled backup has a 10
second delay counter before actually running the backup. Choosing this option will enable to run
the task without this 10 second delay.

e Wake up computer to run this task (if supported): If you computer is set to sleep at the
time of backup, you can choose to wake up the computer to run the task. This option is enabled
if Run whether user is logged on or not is enabled.

¢ Run Database- Complete backup now (Recommended): Choose this option if you wish to
run a database-complete backup after saving CDP settings.

Notes:

e Limiting backup sets is not supported on FTP, Tape, CD/DVD using burning technology, and when the
backup is spanned to multiple locations
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CDP Examples

Example 1:

Perform Database-Complete backups on the first Sunday of the month and differential backups weekly on
Fridays:

In CDP, under Database-Complete Backup, select Run Monthly
Set the time you wish the backup to run, and then select on the first Sun of the month
Mark the checkbox next to Differential Backup (optional) to enable differential backup schedule

Select Run Weekly and set the time for the backup to run and under on the following days select
Fri

Example 2:

Perform Database-Complete backups weekly on Sunday, Transaction log backups daily every 5 hours the
rest of the week, differential daily, and keep only 1 backup set

In the CDP, under Full backup, select Run Weekly

Set the time you wish the backup to run, and under on the following days select Sun

Mark the checkbox next to Differential (optional) to enable database-differential backup schedule
Select Run Daily

Mark the checkbox next to Transaction log Backup (optional) to enable transaction log backup
schedule

Select Run Every Few Hours, in Run Every set it to 5 hours, and under on the following days
select Mon, Tue, Wed, Thurs, Fri, and Sat

Under More Settings, change Limit number of backup sets to (if supported by media) from
unlimited to 01
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Single Level Protection

Using single Level protection enables users to create fast SQL backup using single backup type. When
performing SQL Backup using GBM, you must perform a Database-Complete Backup before any Transaction
log and Incremental backup.

Using Single Level Protection:

1. From Backup choose Microsoft SQL

2. Go to CDP and under Single Level Protection choose one of the following backup types:

e Database-complete: backs up all the data in the database including the transaction log

e Database-differential: Backup all data in the database, including the transaction logs, since the last
full backup

e Transaction Log: Backup all items in the transaction log.
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SQL Server Backup Strategies

When planning your SQL Server backup strategy, select the backup method that is the best tradeoff between
backup and restore time, depending on the size of your database. For example, full backups take the longest
to perform, but are the fastest to restore. Differential backups are overall faster than full backups, but take
longer to restore. Incremental (transaction log) backups are the fastest, but are generally the slowest to
restore.
Generally, it is faster to restore differential backups (with few, if any transaction logs) than it is to restore a
full backup (with many transaction logs). This is because the restoration of transaction logs have to play
back each transaction when restored. If a transaction took 5 minutes to run, it will also take about 5 minutes
to run again when the transaction log is restored.
For fastest backups, we recommend performing a disk backup to a local drive/drive array, then moving the
backup file(s) over the network to another server where the file can be stored, or to a tape device. Backing
up a database directly to tape on a local device, or directly to a hard disk over the network, is generally
slower.
The selected database recovery model should also play a role in your choice of backup method and
frequency. If you are using the Simple Recovery model:

e Use only Database-Complete backups.

e Depending on how frequently the data changes and how critical it is, you should execute at least one
full backup a day.

e This should occur during off-hours when there is minimal database use.

If you are using the Full or Bulk-Logged Recovery model:

e Option 1 -- use Database-Complete and Transaction.

e Option 2 -- use Database-Complete, Differential and Transaction.

e A full backup should be created at least once a day.

e Transaction log backups should occur every 15 minutes.

e Differential backups should occur every three hours.

e The full backup should occur during off-hours when there is minimal database use.

e The transaction and differential backups should be on a set schedule based on when your full backup
occurs.
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Restoring SQL Server Data

Although GBM has the ability to backup multiple databases, you can only restore one at a time. GBM can
restore your database whether it is online or offline.

SQL Server data differs from other data in GBM in terms of restore in that backups must be restored in the
order in which they were created, whereas with other GBM data, restoring the last backup will recover the
latest versions of all files and folders.

If you are restoring a non-Database-Complete backup, please refer to the specific help pages on Restoring a
transaction log backup or a Restoring a differential database backup.

Important notes

e If Leave database non-operational is selected on the last restore run, it will leave the database
unusable. To reverse this effect, repeat the restore process for the last run and make sure that Leave
database non-operational is not selected.

e Under the full or bulk-logged recovery model, before you can restore a database, you must back up the
active transaction log.

When you wish to restore databases you have the following two options and each option slightly differs in
the restoration process:
e Restoring to a new database.

e Restoring over existing database.

Restoring to a New Database

GBM enables the user to restore the data to a newly created database, as opposed to restoring over an
existent one, please refer to the following steps:

1. Open the Restore wizard.

2. Load a backup, then click Next.

3. Inthe Available Databases list, select Create new Database.

4. Under Set Restore Settings, Select Move database location and specify the paths of the database
location and logs location in the DB Location and Logs Location fields respectively.

5. Select Leave database non operational if there are still other differential or transaction runs that
you wish to restore after this run.

6. Click Next to start restore.



Restoring Over an Existing Database

Before attempting to restore a system database (Master, MSdb, model, or Pubs) you must start SOL
Sever in single user mode.

1. Open the Restore wizard.

2. Load a backup, then click Next.

3. From the Available Databases list, select the database you wish to restore to.

4. Under Settings, select Restore over existing database.

5. If you wish to change the location of the database and log; under Settings, select Move Database
location then specify the new paths for the Database and logs in the DB Location and Logs Location

fields respectively. Keep unchecked if you wish to restore to original location.

6. Select Leave database non operational if there are still other differential or transaction runs that
you wish to restore after this run.

7. Click Next to start restore.
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How to: Connect to the Database

To connect to the server via GBM, please refer to the following steps:

1. Open the restore wizard.

2. Load the backup set then click Next. If you are restoring multiple runs, see Restoring SQL Database
from Multiple Runs,

3. From the left pane select an SQL Server Instance, the databases backed up under that instance will
appear in the right pane.

4. Select the SQL database you wish to restore. You are only allowed to restore one database at a time.

5. Click Set Restore Settings.
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How to: Start the Database in Single-User Mode

Under certain circumstances, such as before recover a damaged system database, you may have to start an
instance of Microsoft SQL Server in single-user mode. To do so ...

1.

2.

In SQL Server Configuration Manager, click SQL Server Services.
In the right pane, right-click SQL Server <instance_name=>, then click Properties.

On the Advanced tab, in the Startup Parameters box, type "-m" separated from other parameters
by a semicolon (;).

Click OK.

Restart the database engine.

When you start an instance of SQL Server in single-user mode, note the following:

e Only one user can connect to the server.

e The CHECKPOINT process is hot executed. By default, it is executed automatically at startup.
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ow to: Restore a Transaction Log Backup

Backups must be restored in the order in which they were created. Before you can restore a particular
transaction log backup, you must first restore the following previous backups without rolling back
uncommitted transactions:

e The full database backup and the last differential backup, if any, taken before the particular transaction
log backup.

e All transaction log backups taken after the full database backup or the differential backup (if you
restore one) and before the particular transaction log backup.

To restore previous backups as stated above the Leave database non operational option must be checked
during restore from the Settings dialog, which can be accessed from the right pane when SQL Server is

selected in the restore wizard. This option tells the database that there is still additional data to be restored.
The following scenarios illustrate when this option should be selected.

Scenario

Restoring a backup set consisting of a database-complete backup followed by two transaction log backups.

Restore sequence Leave database non
operational
Database-complete Enabled
First transaction log Enabled
Second transaction log Disabled
Scenario

Restoring a backup set consisting of a Database-Complete backup followed by two differential database
backups, and a transactional log backup .

Restore sequence Leave database non
operational

Database-complete Enabled

Second differential database Enabled

Transaction log Disabled

Scenario



Backup sequence Backup type

1st Database-complete

2nd Differential database (first)

3rd Transaction log (first)

4th Differential database (second)

5th Transaction log (second)

6th Transaction log (third)

Restore sequence Leave database non
operational

Database-complete Enabled

Second differential database Enabled

Second transaction log Enabled

Third transaction log Disabled

Important note

e If Leave database non-operational is selected on the last restore run, it will leave the database
unusable. To reverse this effect, repeat the restore process for the last run and make sure that Leave
database non-operational is not selected.
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How to: Restore a Differential Database Backup

Backups must be restored in the order in which they were created. Before you can restore a particular
Differential Database backup, you must first restore the most recent Database-Complete backup before it.

To restore the previous Database-Complete backup as stated above the Leave database non operational
option must be checked during restore from the Settings dialog, which can be accessed from the right pane
when SQL Server is selected in the restore wizard. This option tells the database that there is still additional

data to be restored.

Important note

e If Leave database non-operational is selected on the last restore run, it will leave the database
unusable. To reverse this effect, repeat the restore process for the last run and make sure that Leave

database non-operational is not selected.
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Microsoft Exchange Server

Genie Backup Manager provides an easy, secure and reliable way to backup the MS Exchange Server databases using
advanced API technology. You do not need to stop the MS Exchange Server service while taking a backup. GBM is designed
to backup the MS Exchange Server database without interrupting MS Exchange Server operations.

Note:

To enable backing up Microsoft Exchange Server, GBM automatically copies "esebcli2.dll' from the program folder Microsoft
Exchange is currently installed in to X:/WI NDOWS/ System32/, where X is the drive you have windows installed on. However,
if GBM fails to do so, it must be copied manually.
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How to: Register MS SQL Plugin

Upon purchasing the Exchange plugin the user will receive an email containing a serial number for unlocking
the Exchange Backup.

To register MS Exchange Plugin:

1. Start GBM.
2. Click Backup.
3. Under Exhange Backup in Backup Category, click Register Exchange plugin

4. Type or copy-paste the serial number into its designated field then click OK.
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How to: Backup Exchange Server Data

To enable backing up Microsoft Exchange Server, GBM automatically copies "esebcli2.dll" from the program
folder Microsoft Exchange is currently installed in to X:/WINDOWS/System32/, where X is the drive you have
windows installed on. However, if GBM fails to do so, it must be copied manually.

Backing Up Exchange Server Data

1. From the Main Page, select Backup

2. In Backup Category, Select Exchange Backup

3. From the left navigation menu in the backup wizard select What to Backup

4. Expand the Exchange list, then select the Exchange Server you wish to backup from.

5. In the right pane expand the Microsoft Information Store list.

6. If you want to backup the entire Information Store on the selected server you can simply check the
box next to Microsoft Information Store, or you can expand the tree beneath it and select a

particular Storage Group.

7. Click Next to continue configuring the backup job.
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Exchange Continuous Data Protection (CDP)

Protecting your mission critical mailboxes strongly rely on understanding the Exchange backup types. GBM
gives the users and easy to use, Continuous Data Protection (CDP) for ultimate Exchange data protection.
Users can also perform single backups from the Single Level Protection (SLP) page.
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Exchange Backup Types

Choose between different backup methods for Exchange Backup. The first run in all times must be Full or the
backup will fail or its restore will fail even if the backup ran. Exchange backups are not like other backups in
GBM, as each backup done on Exchange backup, even if it is a different job, depends on previous runs. It is
recommended that your Exchange backups are created in separate backup jobs from your other data.

e Normal (Full): Backup the directory or Exchange store in its entirety, as well as the log files, then
purges the log files

e Incremental: Backup the changes since the last full or incremental backup (backs up the transaction
logs that have accumulated since the last full or incremental backup) and purges the logs.

e Differential: Backup all items in the transaction log, but does not purge the logs.

e Copy: Backup the directory or Exchange store in its entirety, as well as the log files, and does not
purge the log files.
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Normal

The normal backup process backs up the directory or Exchange store in its entirety, as well as the log files. A
normal backup marks the objects it has backed up so that incremental and differential backups have context.
This is accomplished by backing up the entire database and all the log files, and then purging the log files. To
restore from a normal backup, only one normal backup is needed. Purging is supported in this type of
backup if all the other backup types are full and database-complete.

To set GBM to perform a Full Exchange backup:

1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

3. From the Exchange Backup Type group select Normal (full).
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Incremental

An incremental backup backs up the subset of the component that has changed since the last normal or
incremental backup. Then it marks these objects as backed up. An incremental backup backs up only the log
files, and then purges them.

To set GBM to perform a Incremental Exchange backup:

1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

3. From the Exchange Backup Type group select Incremental.

Job naming in Incremental Backup

It is recommended that the user backs up Exchange data in a separate job, however there is no restrictions
on backing up Exchange or other data in the job, but if the backup types differ, it will effect on the backup
naming, for more information, please refer to Backup Types and file naming

If all the Exchange backup is done in the same job, your output files will look as follows:

Backup Job.gbp ... Normal (Full) backup

Backup Job.0.gbp ... First Incremental run

Backup Job.1.gbp ... Second Incremental run

Backup Job.2.gbp ... Third Incremental run

If your differential runs are separate from the complete backup your output files will be as follows:
complete.gbp ... Normal Full backup

differential.gbp ... First Incremental run

differential.0.gbp ... Second Incremental run

differential.1l.gbp ... Third Incremental run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Normal Full backup

first run.gbp ... First Incremental run

second.gbp ... Second Incremental run

third.gbp ... Third Incremental run
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Differential

A differential backup backs up changes in the directory or Exchange store that have occurred since the last
normal backup. A differential backup backs up only the log files but does not purge them. If a normal backup
is not performed before a differential backup, the job will fail.

To set GBM to perform a Differential Exchange backup:

1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

3. From the Exchange Backup Type group select Differential.

Job naming in Differential Backup

It is recommended that the user backs up Exchange data in a separate job, however there is no restrictions
on backing up Exchange or other data in the job, but if the backup types differ, it will effect on the backup
naming, for more information, please refer to backup types and output files created.

If all the Exchange backup is done in the same job, your output files will look as follows:

Backup Job.gbp ... Normal (Full) backup

Backup Job.0.gbp ... First Differential run

Backup Job.1.gbp ... Second Differential run

Backup Job.2.gbp ... Third Differential run

If your differential runs are separate from the complete backup your output files will be as follows:
complete.gbp ... Normal Full backup

differential.gbp ... First Differential run

differential.0.gbp ... Second Differential run

differential.1l.gbp ... Third Differential run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Normal Full backup

first run.gbp ... First Differential run

second.gbp ... Second Differential run

third.gbp ... Third Differential run
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Copy

The copy backup is the same as a normal backup except no marking takes place to give incremental and
differential context. This means that performing an incremental backup after a copy backup is equivalent to
performing it before a copy backup. Use a copy backup to get a full backup of the directory or Exchange
store without disturbing the state of ongoing incremental or differential backups. To restore from a copy
backup, only one copy backup is needed. Purging is not supported in this type of backup.

To set GBM to perform a Copy Exchange backup

1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

3. From the Exchange Backup Type group select Copy.
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Continuous Data Protection

A common practice in protecting Exchange Mailbox Data is to run Full backups with differential and/or
incremental backup to ensure latest data recovery.

How to protect Exchange Mailboxes

1. From the left navigation menu in the backup wizard select CDP
2. Select Continuous Data Protection (CDP)
3. Full should be performed as you cannot perform a differential/incremental backup without a full
backup. Select how frequent you wish to run the backup as full backup type:
e Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run
e Run Daily: Runs backup daily at a specific time
e Run Weekly: Specify the time and days you wish the backup to run
e Run Monthly: Specify the time and day of the month
e Run Once: Run this full backup one time on a specific time
e Run at Windows logon: Runs every time you logon into your computer
4. Select Differential/Incremental Backup (optional) and select how frequent you wish to run
differential/incremental backup:
e Run Every Few Hours: runs backup every few hours, in this option you can also specify the
days you wish the task to run
e Run Daily: Runs backup daily at a specific time
e Run Weekly: Specify the time and days you wish the backup to run
5. Under Security Settings, you can specify if you wish to run the backup whether the user is logged on
or not. If you select Run whether user is logged on or not, you must enter the Windows login
username or password; otherwise your backup will not run if Windows is logged out.
6. In More Settings, you can specify the following options:
e Limit Number of backup sets to (if supported by media): This option enables GBM to keep the

most recent "X" number of full backups with its incremental/differential backups

e Minimize backup window when running job: Selecting this option runs the backup job while
scheduled backup window is minimized

e Do not start backup if the computer is running on batteries: You can set this option that
tells the task to run only if the computer is on AC power (not battery power)

e Do not wait 10 seconds before starting backup: By default the scheduled backup has a 10



second delay counter before actually running the backup. Choosing this option will enable to run
the task without this 10 second delay.

e Wake up computer to run this task (if supported): If you computer is set to sleep at the
time of backup, you can choose to wake up the computer to run the task. This option is enabled
if Run whether user is logged on or not is enabled.

e Run Full backup now (Recommended): Choose this option if you wish to run a Full backup
after saving CDP settings.

Notes:

e Limiting backup sets is not supported on FTP, Tape, CD/DVD using burning technology, and when the
backup is spanned to multiple locations
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CDP Examples

Example 1:

Perform Full backups on the first Sunday of the month and differential backups weekly on Fridays:

In CDP, under Full Backup, select Run Monthly
Set the time you wish the backup to run, and then select on the first Sun of the month
Mark the checkbox next to Differential Backup (optional) to enable differential backup schedule

Select Run Weekly and set the time for the backup to run and under on the following days select
Fri

Example 2:

Perform full backups weekly on Sunday, incremental backups daily every 5 hours the rest of the week,
differential daily, and keep only 1 full backup

In the CDP, under Full backup, select Run Weekly

Set the time you wish the backup to run, and under on the following days select Sun

Mark the checkbox next to Differential (optional) to enable database-differential backup schedule
Select Run Daily

Mark the checkbox next to Incremental Backup (optional) to enable transaction log backup
schedule

Select Run Every Few Hours, in Run Every set it to 5 hours, and under on the following days
select Mon, Tue, Wed, Thurs, Fri, and Sat

Under More Settings, change Limit number of backup sets to (if supported by media) from
unlimited to 01
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Single Level Protection

Using single Level protection enables users to create fast Exchange backup using single backup type. When
performing Exchange Backup using GBM, you must perform a Full Backup before any Differential and
Incremental backup.

Using Single Level Protection:

1. From Backup choose Microsoft Exchange
2. Go to CDP and under Single Level Protection choose one of the following backup types:
e Normal (Full): Backup the directory or Exchange store in its entirety, as well as the log files, then
purges the log files

e Incremental: Backup the changes since the last full or incremental backup (backs up the transaction
logs that have accumulated since the last full or incremental backup) and purges the logs.

e Differential: Backup all items in the transaction log, but does not purge the logs.

e Copy: Backup the directory or Exchange store in its entirety, as well as the log files, and does not
purge the log files.
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Restoring Exchange Server Data

Please read Prerequisites for Restoring Exchange Server, to ensure that Exchange Server is configured
properly before attempting to restore your Exchange Server data using Genie Backup Manager.

If you have multiple runs to restore, it is recommended that you read Restoring Exchange Data from
Multiple Runs before proceeding.

How to Restore Exchange Data?

1. Open the restore wizard.
2. Load a backup, then click Next.

3. Expand the tree under Exchange Server and select an instance (you are only allowed to restore one
instance at a time)

4. From the right pane select the mailboxes you wish to restore
5. Specify a temp location path
Note

You can set GBM to automatically mount the database after restoration by selecting Mount database after
restore
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Prerequisites for Restoring a Storage Group

There are a few precautions that need to be taken into consideration before attempting to restore Exchange
Server data, or else restore would fail.:

1. Preparing MS Exchange Server when installed from scratch (Skip to step 2 if you do not have to

reinstall).

2. Configure the Storage Group for restore.

How to prepare MS Exchange Server When Installing from Scratch

A case may arise in which you have to completely reinstall and reconfigure Exchange. It is extremely
important that the new Exchange installation be configured identically to that of the original server, please
make sure that it is case sensitive.

1. The Site name must be the same.

2. The Organization name must be the same (Case sensitive).

3. The storage groups must be configured the same (Case Sensitive), along with the original path and
all the mailboxes.

4. Ensure that you install the same Exchange Service Packs that were existent on the previous server.

5. Remember, the key is to build the new Exchange Server identical to the previous one.

Configure the Storage group for Restoration

e The store you are restoring must be dismounted before you run the restore. Note the screen below for
reference.
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e Before running your Exchange Restore, make sure that the This Database Can be Overwritten



option is selected - following these screenshots for reference.
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How to: Restore an Incremental or Differential Backup

In Exchange Backups must be restored in the order in which they were created. Before you can restore a
particular Incremental or differential backup. When you restore backup of an Exchange database, the
database is in an inconsistent state. The process of bringing the database to a consistent state after a
restore procedure is called "hard recovery." During hard recovery, the Extensible Storage Engine (ESE) uses
information in the log files and patch files to redo operations performed on the database and then to undo
any operations that belong to incomplete transactions. The Last Backup Set check box (accessible from the
right pane when Exchange Server is selected in the restore wizard) determines if hard recovery should be
run after the backup completes. If you select this check box, hard recovery is run automatically after the
restore procedure finishes, and then the temporary files are removed. At this point, you can mount the
database.

Case scenario

First backup Full followed by two runs of incremental backups.

Restore sequence Last Restore Set Mount database after
restore

Full Not selected No

Incremental Not selected No

Incremental Selected Yes

Case scenario

First backup Full followed by Differential backup, then an Incremental backup.

Restore sequence Last Restore Set Mount database after
restore

Full Not selected No

Differential Not selected No

Incremental Selected Yes
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Run Backup
Users can run a backup job without going through the backup wizard by doing one of the following:
e From the Tools menu in the main page, click Run Backup and select a job to run.

e Create a shortcut on the Desktop for the backup job and double-click it whenever you wish to run a
backup task.
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Backup Progress

After the user selects Backup Now from the Selection Confirmation window, GBM will start the process of
backing up data. The Backup Progression window displays the status of the backup job, this information
includes:

Backup Job Name: Name assigned to the backup job.

Backup File: The full path and filename of the output backup file/folder.

Backup Type: Backup type of this backup run (Full, Increment, Mirror or Differential).

Backup Status: The current action being carried out

Elapsed Time: Time elapsed since the user hit the Backup Now button.

Actual Size: Actual size of processed data.

Compressed Size: Size of processed data after compression.

Processed: Number of new files being added to the backup set.

Updated: Number of processed files that have changed since the previous backup run.

Skipped: Number of processed files that have not been added to the backup set due to errors.

Unmodified: Number of processed files that have not changed since the previous backup run.

Missing: Number of processed files that have been moved or deleted since the previous backup run.

Backup Progress Options:

During backup, the user can change the following Options:

Pause: While the backup is running, the user can pause the backup if needed; however, tampering with the
created backup could lead to unstable results

Backup Performance: During backup, a user can speedup backup performance by moving the pointer
closer or exactly on Quicker backups or reduce impact on backup on the system with moving the pointer
closer to Faster Computer. You can globally change this setting from Global Preferences in General -

Advanced page

Enable/disable power options when backup completes: Using this option the user can enable/disable
power options upon completing backup or change the power option that was pre-configured during creating
backup. For more information about power options, see Power Management Options

Note:

Backup progress options are only supported in Normal Mode



Data Verification

Verification ensures that backed up data was successfully written on the storage media and that it can be
restored reliably. Genie Backup Manager will by default verify backed up data immediately after the backup
task is completed. But the user can also choose to test data integrity of a backup archive at a later time

using the Testing Data Integrity tool.

Testing data integrity can be done using one of two methods in Genie Backup Manager, these are:

e Bit-by-bit verification: This is the default method used by GBM to verify that a backup archive is
restorable, and the data contained within it is not corrupt. This is done by reading every bit of each
backed up file, however, this verification method does not compare data to make sure that the backed
up and original files are exactly identical. This means that if the contents of a file in the backup archive
were modified after backup, Genie Backup Manager will not detect it.

e CRC check verification: CRC is short for (Cyclic Redundancy Check); a very powerful technique to
obtain data reliability. The CRC is one of the most used techniques for error detection in data
communications and file verification.

When this verification method is used, Genie Backup Manager will generate a table of CRC values for
all the selected files during backup. Come verification time, a new CRC table is generated for the data
stored in the backup archive, and the CRC value for each file being verified is compared against its
counterpart in the original table created during backup. If a file passes CRC check, that means that it
can be restored reliably, and that it is exactly the same as the file that was originally backed up.

CRC verification is not supported when backup is performed with encryption without compression.

Genie Backup Manager by default uses bit-by-bit verification for testing backed up data, to switch to CRC
check, click the Tools menu, select Global Preferences, select Backup Settings, select Advanced
Settings, and make sure the option Use CRC check to compare files is selected.

Genie Backup Manager will automatically verify backed up data when the user closes the backup summary
dialog. To change this behavior, click the Tools menu, select Global Preferences, select Test Data
Integrity, then choose one of the following options:

e Automatically test data after backup: Always verify data after backup without asking me
e Ask me: Ask me whether to verify data when backup is completed.

e Do not test: Do not verify backed up data.

By default, after an incremental, mirror or differential backup, Genie Backup Manager will only verify new
and changed files that have been added to the backup set, which saves time, based on the assumption that
the rest of the data was verified previously when it was first backed up.

To set Genie Backup Manager to verify the entire backup archive at the end of each backup execution, click
the Tools menu, then select Global Preferences, select Test Data Integrity, and make sure the option
Test only new and changed files is not selected.

To manually test a backup, make sure that the storage media holding the backup is connected, click the
Tools menu, select Test Backup, select the backup job which created the backup archive you wish to test,
then click Test now. Alternatively, you can directly select the backup by clicking Browse, navigating to the
location of the archive, and selecting the backup's ".gbp" file.



Post-backup data verification is not supported when the backup storage media is Tape or a remote machine
using FTP or when Online Backup is selected. However, in all cases, data is verified while it's being written to
the media.
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Verification Methods

Testing data integrity can be done using one of two methods in Genie Backup Manager, these are:

Bit-by-bit verification: This is the default method used by GBM to verify that a backup archive is
restorable, and the data contained within it is not corrupt. This is done by reading every bit of each
backed up file, however, this verification method does not compare data to make sure that the backed
up and original files are exactly identical. This means that if the contents of a file in the backup archive
were modified after backup, Genie Backup Manager will not detect it.

CRC check verification: CRC is short for (Cyclic Redundancy Check); a very powerful technique to
obtain data reliability. The CRC is one of the most used techniques for error detection in data
communications and file verification.

When this verification method is used, Genie Backup Manager will generate a table of CRC values for
all the selected files during backup. Come verification time, a new CRC table is generated for the data
stored in the backup archive, and the CRC value for each file being verified is compared against its
counterpart in the original table created during backup. If a file passes CRC check, that means that it
can be restored reliably, and that it is exactly the same as the file that was originally backed up.

CRC verification is not supported when backup is performed with encryption without compression.

Changing the Verification Method

Genie Backup Manager by default uses the bit-by-bit verification method for testing backed up data, to
switch to the CRC check verification method, do the following:

1.

2.

3.

From the tool bar, click Tools, then select Preferences.
Select Backup Settings then Advanced Settings.

Make sure the option Use CRC check to compare files is marked.
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Verifying New and Changed Files

By default, after an incremental, mirror or differential backup run, Genie Backup Manager will only verify new
and changed files that have been added to the backup set. This saves a lot of time, based on the assumption
that the rest of the data was verified previously when it was first backed up.
To set Genie Backup Manager to verify the entire backup archive (data created by most recent full backup
along with all subsequent increments), you can do the following:

1. From the tool bar, click Tools, then select Global Preferences.

2. Select Testing Data Integrity.

3. Make sure the option Test only new and changed files is marked.
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Data Integrity Testing Tool

The Data Integrity Testing tool verifies backed up data to ensure it can be reliably restored. To open the
Data Integrity Testing tool click Tools in the toolbar, then select Test Backup.

The Controls

e Backup Jobs: List of executed backup jobs.
e Backup Job: Name of backup job.

e Status: Availability of the backup archive. If the media is not loaded, or the backup archive has been
moved, the backup will not be available for testing.

e Backup File: Path and filename of the backup archive.

e Refresh List: Refresh list of backup jobs and their statuses.

e Browse: Manually locate the backup archive you wish to test.

e Test Now: Perform data integrity test for the selected backup job from the list.

e View Test Log: Displays the log produced by a performed data integrity test.

e Settings: Open the data integrity testing settings page in the Global Preferences dialog.
e Close: Close the Data Integrity Testing Tools dialog.

e Help: Open this help page.
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Managing Open Files

Genie Backup Manager ensures business continuity of all their mission critical data, by backing up opened or
used files by other users or applications; leveraging Microsoft's latest Volume Shadow-Copy Service (VSS)
framework, to permit consistent backup of open files without the need for additional applications or plug-ins.

This option works for Windows XP, Windows 2003, and Windows Vista operating systems only. To backup
open or locked files on Windows 2000, users must install Open File Backup Agent as an add-on.

Open File Backup agent is a utility that helps GBM capture files that are open, even if they are changing
during the backup, without locking users out of the applications or forcing them to log off the network, giving
your backup software the ability to protect ALL your mission critical data by giving it access to exclusive,
open or in use files. And ensuring business continuity by protecting your data in real time without causing
interruptions.
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Volume Shadow Copy Service

The Volume Shadow Copy Service (VSS) provides the backup infrastructure for the Microsoft Windows XP
operating system, serving a mechanism for creating consistent point-in-time copies of data known as
shadow copies. Microsoft's VSS component allows GBM to backup opened files, resulting in a skipped-files
free backup.

Allowing VSS to handle backup of open files

1. From the toolbar click Tools, then select Global Preferences.
2. Select Open File Backup.

3. Select Use Volume Shadow Copy.

Limitation of Volume Shadow Copy Service:

e Works only with NTFS formatted partitions.

e Supported only under Windows XP, Windows Vista, and Windows Server 2003.
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Open File Backup Agent(OFB)

Genie Backup Manager Provides two options to ensure business continuity of all their mission critical data, by
backing up files even if opened or used by other users or applications. Genie Backup Manager utilizes the
latest technical innovations available. Leveraging Microsoft's latest Volume Shadow-Copy Service (VSS)
framework, to permit consistent backup of open files without the need for additional applications or plug-ins.

This option works for Windows XP, Windows 2003, and Windows Vista operating systems only. For support
for other operating systems and some older legacy applications, users must install Open File Backup Agent
as an add-on.

Open File Backup agent is a utility that helps GBM capture files that are open, even if they are changing
during the backup, without locking users out of the applications or forcing them to log off the network, giving
your backup software the ability to protect ALL your mission critical data by giving it access to exclusive,
open or in use files. And ensuring business continuity by protecting your data in real time without causing
interruptions.
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Using Open File Backup Agent

Open File Backup Agent (OFB) is easy to use, once activated, it will work in the background without the need
for user interaction.

Checking whether OFB Agent is installed:

1. From the toolbar click Tools, then select Global Preferences.

2. Select Open File Backup

3. The OFB status field will indicate whether OFB is installed or not.

Checking whether OFB is running:

Through the system tray, right click on the GBM icon and select Open File Backup and make sure the check
mark is next to Start.

1. From the toolbar click Tools, then select Global Preferences.

2. Select Open File Backup

3. The OFB status field will indicate whether OFB is installed or not.

Allowing OFB to handle backup of open files:

1. From the toolbar click Tools, then select Global Preferences.

2. Select Open File Backup

3. Click Start.

Or through the system tray, right click on the GBM icon and select Open File Backup then click Start.

Pausing OFB:

1. From the toolbar click Tools, then select Global Preferences.

2. Select Open File Backup.

3. Click Pause.



Or through the system tray, right click on the GBM icon and select Open File Backup Agent then click
Pause.

Allowing Open File Backup to Backup Open Files From Remote Locations

Open File Backup can be set to handle open files while backing up data using Genie Backup Manager from a
network-connected machine. This allows centralized LAN-based backups for clients with potentially-open
files.

Perform the following steps on each network computer you intend to backup data from:

1. Install Open File Backup Agent.
2. Click Start, point to Genie-Soft, then Open File Backup Agent.
3. Right-click the Agent icon in the system tray then select Settings

4. Make sure Allow Network Access to This Computer is selected.
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How to: Load Backup from the Catalog

If you want to restore data from a backup that was created on the same computer you are restoring to, and
the original backup job configuration is still present, you can load the backup and browse backed up files and
folders even if the backup archive itself is not accessible at the time. This is also the case for restoring Online

Backups and restoring backups from tape media.

To load a backup using the catalog:

1. Open the Restore Wizard.

2. Under Select a file to restore, click the plus sign next to the name of the backup job to view a list of
all its backup executions.

3. Select the backup run you wish to restore from.
4. Click Next to continue configuring the restore task.

Alternatively, you can do the following:

1. Open the Catalog.

2. Under History of backup runs, click the plus sign next to the name of the backup job to view a list of
all its backup executions.

3. Right-click a backup execution and select Restore. This will open the restore wizard and load the
selected backup.

4. Click Next to continue configuring the restore task.

Note:

Genie Backup Manager will try to locate the backup archive in the default backup destination configured in
the backup job. If GBM fails to find the archive, it will prompt you to insert/connect the media on which the
backup is stored, and select the folder containing the .gbp needed to restore the data.
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How to: Load Backup from the Archive

Backup catalogs ("index.gix" files) are saved locally and in the backup destination together with the backup
archive. When a backup job is executed, a new ".gbp" file is created, containing the catalog file and other
internal information needed by GBM to restore the data.

To load a backup in order to restore data from it, simply double-click the .gbp file corresponding to the
backup version you want to restore. Alternatively, you can open the Restore Wizard, click Browse to
navigate to the location of the .gbp file and select it, then click Open.

A special file naming convention is used by Genie Backup Manager to denote different backup
versions/executions of the same backup job. For more information, see Backup Types.
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How to: Restore Data?

My Profile:

How to: Restore Outlook Data

How to: Restore Outlook Express Data

How to: Restore Windows Mail Data

How to: Restore Windows Registry

How to: Restore Desktop Items

How to: Restore My Documents Folder

How to: Restore Windows Address book

How to: Restore Windows Contacts

How to: Restore Windows Favorites

How to: Restore Windows Fonts

How to: Restore Media Files

How to: Restore Images and Photos

How to: Restore Internet Explorer Settings

How to: Restore Windows Settings

My Folders:

How to: Restore Files and Folders

My Plugins:

Restore Plugins
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Genie Disaster Recovery

Disaster recovery focuses on continuous system protection by backing up Windows, system state, documents,
settings, and programs to recover the system to a stable state prior system failure.

Genie Backup Manager provides an easy to use wizard to create the disaster recovery backup. Genie Disaster
Recovery consists of two main steps

1. Create Genie Disaster Recovery (GDR) Bootable Disk

2. Create Genie Disaster Recovery (GDR) Backup

Opening the Disaster Recovery Wizard

To start the Disaster Recovery wizard do the following:

¢ From the Main Screen click the Disaster Recovery button.

Important Note:

Disaster Recovery Backup should only be restored on the same hardware configuration of the Disaster Recovery
Backup.



How to: Create Genie Disaster Recovery Bootable Disk

Genie Disaster Recovery (GDR) Bootable disc enables GBM to restore your Disaster recovery data outside the
Windows environment.

The boot disc is mainly a CD, DVD, or REV disc used to start GBM's Disaster Recovery's restore wizard and
therefore enables the user to select the most recent disaster recovery backup. Only one copy of this disc is
required, therefore it is unnecessary to perform this step every time a disaster recovery backup is performed.

This disc contains of the following components:

1. Windows boot files
2. Genie runtime files necessary to run the Disaster Recovery restore wizard

Important note:

You must create this bootable disc in order to restore your disaster recovery data, as the regular GBM program is
only operable in Windows environment.

To Create GDR Bootable Disc

1. In the Main Page, Select Disaster Recovery

2. A Dialog will open, click Create GDR Bootable or in the Welcome Page of the Disaster recovery wizard,
Select Create Genie Disaster Recovery (GDR) Bootable disc, then click Next

3. Select the bootable Media to boot from:

e CD/DVD recorder: Create a bootable CD or DVD

e lomega REV Disk: Create the bootable disk on lomega REV disk; using this option will automatically
format the REV Disk, prior creating boot disk

e Create ISO Image: This enables users to create the boot image as a .iso file on the local drive to be
burnt using third party burning software. The image can also be downloaded from http://www.genie-

soft.com/download/Genie DR.zip

4. Click Next to continue


http://www.genie-

How To: Create Genie Disaster Recovery Backup

After Genie Disaster Recovery bootable disc is created, it is required to backup essential data to restore your
system to the previous state prior the disaster.

The following components are always added to the disaster recovery backup job:

e Windows Folder

e Program Files

e Documents and Settings

e System State
Note:
It is recommended that the GDR backup job only consists this data as this backup is restored outside windows
environment and for a faster recovery without any conflicts or errors, it is recommended that the size stays

reasonable and all other data should be backed up in a different backup and restored inside windows environment.
For more information, please refer to_Disaster Recovery Strategies

To Backup Genie Disaster Recovery (GDR) Backup:

1. In the Main Page, select Disaster Recovery

2. If a Genie Disaster Recovery Bootable disk is not created and you do not wish to create one in the time
being, not recommended, then click Skip creating disk. If a disk has been created, then in the welcome
page Select Create Disaster Recovery Backup and click Next

3. In Where to Backup page, Select the Backup Destination

4. In What to Backup a list of Disaster Recovery Data is displayed you can add additional folders by clicking
on Add Additional Files/Folders link or via My Folders Tab.

5. From the Settings Page Select the Settings of the backup job

6. Click Next to start backup

Important Note:

Creating Disaster Recovery bootable disk is essential to restore your Disaster Recovery Backup job.






Disaster Recovery: Where to Backup

In Disaster recovery you can backup to the following locations:

Internal and External Drives: This includes local drives, External USB drives, and Flask disks. You can also
enable multi drive spanning to span your disaster recovery backup to more than one location

Network locations: This includes any drive, RAID, SANs NAS... remotely off your computer

Online Backup: Genie Disaster Recovery Backup is the ONLY software that enables Creating Disaster
Recovery Backups to Genie offsite storage. Now with the enhanced restoration process, you can recovery
your system in No time.

Optical Media:This includes (DVD+RW/DVD=+R/DVD-RAM/CD-R/CD-RW), including double layer DVDs and
Blu-ray, using both built-in burning capability and packet writing - with the aid of third party software -.

Removable media: You can also create REV, External USB, Flash disks, Zip, Jaz and floppies using
removable media option




Disaster Recovery: What to Backup

What to Backup Consists of Two Tabs:
My GDR: Contains the essential data necessary to restore your system after failure to boot your operating
system or if it becomes unstable. This data consists the following:

e Windows Folder: Contains the Windows Folder; Drive:\Windows

e Program Files: Contains data of installed programs; Drive:\Program Files

e Documents and Settings: Contains Documents and Settings Data for All users; Drive:\Documents and
settings

e System State: Contains the following:

e Boot files, including system files and performance counter configurations

e COM+ Class registration database: A store of registration information for COM objects in the
Windows system. COM is a standard for binary interoperability of registered software
components.

e Windows Registry: A database that Windows uses to store hardware and software configuration
information, user preferences and setup information

e System Files under Windows File protection: A system service that protects special operating
system files. In the event that one of these files is deleted or overwritten, System File Protection
will replace the file with the original from its cache

My Folders: If you wish to add other important files to your backup you can do so from the Add additional
Files/ Folders link or by Clicking on My Folders tab.

Note

Adding additional Files/Folders is not recommended because it will increase the size of the backup and time
resulting in increasing time of system recovery. It is recommended to keep a separate backup for your
personal files/folders and restore them in Windows environment. For more information, please refer to

Disaster Recovery Strategies




Disaster Recovery Settings

The user can configure the disaster recovery backup job with the following settings:

Compression: Create Disaster Recovery backup with non-proprietary 64- bit ZIP compression or perform
backup without compression to view backup in native format. For more information, please review the
Compression section in the help documentation

Security: Disaster Recovery backup can be secured with multiple levels of protection to ensure that backed
up data is not accessible to unauthorized persons. Either with Zip password protection or AES encryption. For
more information about security options, see the Security in GBM section.




Disaster Recovery Strategies

Having a disaster recovery job minimizes Recovery Time Objective (RTO) after unstable systems,
hardware failure, virus attacks, and erroneous deletion of system files...

Restoring Disaster Recovery is performed outside Windows environment; therefore, the disaster recovery job
consists of two Parts

1. Creating a bootable disk to run the disaster recovery restoration environment
2. The actual disaster recovery job.

To restore your data, you must insert the bootable disk when the computer starts, then browse for your
Disaster recovery job.

To ensure faster RTO, it is recommended:

1. Perform disaster Recovery on a newly installed machine with all important programs installed
on the system: Disaster Recovery job includes Windows folder, program files, documents and settings, and
System state; however, in fears of virus attacks, spyware or other malicious attacks on these files; it is
recommended that you perform disaster recovery on a clean system to ensure consistent data.

2. Keep your disaster recovery backup as small as possible: Restoring disaster recovery data is
performed outside windows environment, leaving the system unfeasible. Therefore, it is not recommended to
include large files and folders in the Disaster recovery job, assuring faster recovery time of the operating
system. When the system is up, you may restore your data in windows environment, if needed.

3. Perform separate backups of your data: GBM enables fast backup and restore of data backups inside
Windows environment. Therefore, it is recommended to perform recurrent-scheduled data backups to avoid
minimum data loss.



Walkthrough: Creating Disaster Recovery

This Walkthrough summarizes how to create a complete disaster recovery backup

Step 1: Create Genie Disaster Recovery Bootable

In this Step you will create a bootable CD/DVD/REV needed to boot the restoration runtime environment.
This step is only required once

Requirements: Blank or empty CD, DVD, or empty REV disk.
Recommended: New CD/DVD
Steps:

Create Bootable CD/DVD Disc

Create Bootable REV Disk

Create 1SO Image

Warning: GBM will erase all contents of the disk prior creating the bootable disk; therefore, please make
sure the REV disk does not contain any important data.

Step2: Create Disaster Recovery Job:

This step backs up the main data necessary to recover your system after it fails to load properly
Requirements: Backup storage media;

Recommended: External, Online, or removable media.

Steps:

1. In the Main Page, select Disaster Recovery

2. If a Genie Disaster Recovery Bootable disk is not created and you do not wish to create one in the time
being, not recommended, and then click Skip creating disk. If a disk has been created; in the welcome

page Select Create Genie Disaster Recovery(GDR) Backup and click Next

3. In Where to Backup page, Select the Backup Destination

4. In What to Backup a list of Disaster Recovery Data is displayed you can add additional folders by
clicking on Add Additional Files/Folders link or via My Folders Tab.

5. From the Settings Page Select the Settings of the backup job

6. Click Next to start backup
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Restoring Disaster Recovery Job

Disaster Recovery jobs are restored outside Windows environment. Therefore, the disaster recovery boot
disc loads the recovery environment and then after the disaster Recovery restore wizard is loaded you can

simply restore your system.
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Genie Disaster Recovery Restore Wizard

This Wizard loads up outside Windows environment when booting up the system from Genie Disaster
Recovery Bootable Media

These are the steps that you must confirm in the Genie Disaster Recovery restore wizard:

1. Select a file to restore: Select the Disaster recovery backup archive you wish to restore data from.
Depending on the destination on which the backup is stored, select one of the following options from

the left menu:

e Disk Restore: For selecting and loading a backup stored on disk-based media

e Online Restore: Select and load a Disaster Recovery job stored on your Genie Online Backup
Account.

2. Disaster Recovery Mode: This enabled users to select the whether to restore all data or select
specific data to restore, and whether to restore the boot manager.

3. Data Selection: Select the files and folders you wish restore. This step appears only if custom restore
is selected

Utilities

|32 Explore My Computer _ Opens Windows Explorer

{__\_ Il [F1]
@ \Web Browser _ Opens Mozilla Firefox web browser

1] FTP Client _ Opens FTP client to browse FTP sites
- .
== Partition Manager _ 5,0 1s a partitioner utility enabling hard disk partitioning

o= Opens Windows Notepad program.

B Command Prompt _ Opens Windows Command Prompt "cmd.exe" program.

- y ] ) ) ) R
) Enables network drive mapping to restore disaster recovery jobs stored on a network
location

View Metwork Statu . i
g VIEW NEDWOT o - Views the status of the network connections

;-_Q Remote Desktop
Connection - Opens the Remote desktop connection to connect to a remote computer

Install Driver  _ Enables users to install additional drivers

Menu Commands



Menu

File

System
Utilities

Web Utilities

Network
Utilities

Help

Item

Exit

Explore My
Computer

Windows Tasks
Manager

Partition Manager
Notepad

Command
Prompt

Install Driver

Web Browser
FTP Client

Telnet

Map Network
Drive

View Network
Status

Remote Desktop
Connection

Contents

About

Function

Close this wizard and return to Windows.

Open Windows Explorer.

Open the Windows tasks manager.

Open a partitioner utility enabling hard disk partitioning .
Open Windows Notepad program.

Open Windows Command Prompt "cmd.exe" program.

Enable users to install additional drivers.

Open Mozilla Firefox web browser.
Open FTP client to browse FTP sites

Enable access via Telnet protocol

Enable network drive mapping to restore disaster recovery
jobs stored on a network location.

View the status of the network connections.

Open the Remote desktop connection to connect to a
remote computer

Open the help documentation.

Credits and basic information about the product.
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How to: Restore Disaster Recovery Job?

Disaster Recovery is only used to restore your current windows installation from virus attacks, accidental deletion
of system files, or any action leading to an unstable system.

You can simply restore your disaster recovery job by following these steps:
1. Make Sure that your CD/DVD Drive is the first bootable device in your boot sequence; REV drives are also
identified as CD Drives under BIOS.
2. Insert the Genie Disaster Recovery Bootable media in your drive while your computer is starting up
3. Press any key to boot from the disc
4. After the booting completes the Genie Disaster Recovery Restore wizard will appear, select the Disaster

Recovery backup to restore depending on the destination on which the backup is stored, select one of the
following options from the left menu:

e Disk Restore: For selecting and loading a backup stored on disk-based media, if the job spanned to
multiple locations, browse to the last location/disk it has spawn to.
e Online Restore: Select and load a Disaster Recovery job stored on your Genie Online Backup Account.
5. Select Disaster Recovery Restore Mode
e Full disaster Recovery Restores (Highly Recommended)
e This option restores all disaster recovery data backed up in the disaster recovery job. This mode
is highly recommended as it ensures stable recovery
e Custom Restore (for Advanced users)
e This option enables advanced users to select the items they wish to recover. This is
recommended for advanced users as it is difficult to determine the cause of an unstable system
and does not ensure full recovery.

e Enable Restore Boot Manager (Highly Recommended) in the following two cases:

1. You only have one Operating System installed
2. You have performed this Disaster Recovery job after installing all Operating Systems on your
machine
6. Click Next.

7. Continue with Restoration process






Logs and Reports

Genie Backup Manager offers a variety of detailed logs and reports that help users to keep track of what
happens during its various operations, the most important of which is backup.
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The Logs Manager

The Logs Manager utility provides users with a graphical interface for viewing, exporting and printing backup
activity logs. The logs manager keeps a complete archive of all the logs produced by backup jobs that are
currently configured in the Jobs Manager.
To open the Logs Manager, Click Tools, then select Logs Manager. Users have the choice of viewing
backup jobs in the following sorting orders:

e By Jobs: Logs are sorted according to the names of their respective backup jobs. Expanding the tree

beneath a backup job displays a list of its versions sorted according to their dates.

e By Date: Logs are sorted according to the date on which the backup job was run. Jobs that were run
on the same day are grouped together.

The logs manager offers two types of logs: Normal and Detailed.
Normal

The normal log is opened by default after each backup run. It displays a summary of the backup task's
settings and statistics, grouped into four sections:

e Job information: selected backup job settings, including the job's name, backup destination, backup
type, etc.
e Backup information: a breakdown of the types and sizes of the backed up data sources.

e Backup summary: a summary of the types of processed files (new, modified, unchanged, deleted,
skipped) and errors encountered during backup.

e Data integrity test: displays a summary of errors encountered during testing the integrity of each file
in the backup archive (if any).

You can print this log by clicking Print, or save it as an html file by clicking Save as.

Detailed

The detailed log lists all processed files along with each file's status - whether successfully backed up or not.
Genie Backup Manager's internal files - files creating by GBM in the backup archive for the purpose of
cataloging and indexing - are hidden by default. You can view them by checking the Show GBM system
files option.

To only view skipped file - files that GBM failed to backup - select Show only skipped/failed files and
folders.

This log can be saved to a text file that can be later on printed or emailed by clicking the Export button.
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The Backup Log

The normal log is opened by default after each backup run. It displays a summary of the backup task's
settings and statistics, grouped into four sections:

e Job information: selected backup job settings, including the job's name, backup destination, backup
type, etc.

e Backup information: a breakdown of the types and sizes of the backed up data sources.

e Backup summary: a summary of the types of processed files (new, modified, unchanged, deleted,
skipped) and errors encountered during backup.

e Data integrity test: displays a summary of errors encountered during testing the integrity of each file
in the backup archive (if any).
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The Restore Log

To view the log file containing details about GBM's activity during restore click View Restore Log in the last
screen of the restore wizard

Their is only one restore log, which is overwritten during every restore task. The Restore log file is located in
the following folder:

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\Genie-
Soft\GBMAPPLICATION\Jobs\restore.html

Windows Vista:

C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Jobs\restore.html
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Data Verification Log

After using the Data Integrity Test tool to perform data verification on a backup archive, you can click the
View Test Log button to display an HTML file containing the test results. Any encountered errors will be

listed in the log.

For a complete list of backed up files and the status of each tested file, select Click here for a more
detailed log.
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Event Viewer logging

Event Viewer maintains logs about program, security, and system events on your computer. You can use
Event Viewer to view and manage the event logs, gather information about hardware and software
problems, and monitor Windows security events. GBM logs backup information in the Application logs of the
Event viewer.

Opening the Event Viewer

To open Event Viewer, click Start > Control Panel > Administrative Tools > then double-click Event
Viewer.

Logging information found in the event viewer:

GBM logs in the event viewer when three events occurs:

Starting a backup: GBM places the backup job name, backup media, backup type, and security option
applied for the job in the log.

Backup ending: The backup job name, backup size, and verification status are logged.

Applying power options: The power option type is logged.



GBM Trace Log

When trace log is activated, Genie Backup Manage logs all backup activities and dumps the verbose to a file,
for purposes of debugging. The file is typically located in:

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\Genie-
Soft\GBMAPPLICATION\Logs

Windows Vista:

C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Logs

Where X is the letter of the drive on which Windows is installed.

To activate the GBM trace log click the Tools menu, select Global Preferences, select General, select
Advanced, make sure Enable advanced logging for debugging is checked. Note that activating the trace

log will slightly slow down the program's operations.

The trace log is emptied every time Genie Backup Manager is restarted.
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Tape Trace Log

Genie Backup Manager logs all tape-related operations and stores them in a file typically located in

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\Genie-
Soft\GBMAPPLICATION\Logs

Windows Vista:
C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Logs

If you encounter a problem with tape backup,restore, or tape operations, you can submit this file to the
Genie-Soft support team for debugging.
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VSS Trace Log

Genie Backup Manager logs all Volume Shadow Copy operations and stores them in a file typically located
in

Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%o\Application Data\Genie-
Soft\GBMAPPLICATION\Logs\vsslog.log

Windows Vista:
C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Logs\vsslog.log

If you encounter a problem with backup while GBM is set to use Microsoft's Volume Shadow Copy service to
backup open files, submit this file to the Genie-Soft support team for debugging.
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Email Notification

If you are a network administrator who is always on the move, and you've scheduled backup jobs to run
while you're away, but still need to make sure everything goes smoothly, then email notification is the

feature you need.

E-mail notification is a nifty feature that enables GBM to send information to the user about the status of the
performed backup upon its completion via email.
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How to: Activate E-mail Notification

1. From the toolbar click Tools,then select Preferences.
2. Select Email Settings.
3. Select Enable e-mail notification.

4. Enter the following settings:

e SMTP server: The name or IP address of SMTP server to be used for sending notification emails
e Port: SMTP sending port. (25 by default)

e SSL: SSL (Secure Sockets Layer) is a security protocol that provides communication privacy.
Select this option if your SMTP server supports this protocol.

e From: The email address to appear in the From field of the sent notification email
e To: The address of the recipient of the notification email

e Subject: Enter the description that will appear in the Subject field on the sent email
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How to: Send Email Notifications

1. Make sure email notification is enabled.

2. From the left navigation menu in the backup wizard select Settings.
3. Click More Settings then select Email Notification.
4. Select Send e-mail notification.
5. Choose one of the following options:
e When backup is complete: Send notification email when backup is over.
e Only if error occurs: Send notification email only if GBM encountered a problem during backup

(skipped files, failed to create backup file, etc...)

1. Type a subject for the submitted email. If you do not manually enter a subject line, it will by default be
sent as "GBM Backup Notification"
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SMTP Authentication

GBM supports different SMTP authentication methods for sending email notifications. SMTP authentication
uses different methods of encryption to protect the user mail account's name and password as they are
being sent to the SMTP server. If you do not know which authentication method your email server uses,
please consult your system administrator.

To choose an authentication method:

1. From toolbar, click Tools, then select Preferences.
2. Select Email Notification Settings.
3. Click Authentication Method.

4. Choose one of the following authentication methods:

e NONE: Send the password to the server in an insecure format.
e AUTH LOGIN: Most common authentication method.
e CRAM MDS5: (Challenge Response Authentication Mode), most secure authentication method.

e LOGIN PLAIN: Sends authentication in plain text
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Pop-Up Notifications

When System Tray Agent is activated, Genie Backup Manager will occasionally display pop-up dialogs
notifying the user of the status of configured backup jobs, along with information about the most recently
executed backup. This dialog will alert users when a backup job has not been executed for a long period of

time.

To manually view the pop-up notification, right click the System Tray Agent icon, then select Analyze my
backup status.
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Sound Alerts

Genie Backup Manager can be set to play sound files to notify users when specific backup-related events
take place, such as when a backup task is completed, or when GBM prompts the user to replace a storage
volume.

To open the Sound Alerts settings page, click Tools, select Global Preferences, expand the General list,
then select Sounds.

To disable sound alerts, uncheck the Enable sound alerts option.

To attach a sound file to a predefined event, select the event from the list, select Attach sound to selected
event, then click Browse to select a sound file from your computer.

Events that support sound alerts are:

Finishing backup successfully.
e Finishing backup with errors.
e Completing data verification.
e Prompting the user to replace disk during a multiple media backup.

e Finishing data integrity testing.
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Scripting in Genie Backup Manager

GBM offers two powerful scripting environments that can help users take control of what and how they
backup

e GenieScript: XML-based scripting designed to enable users to create custom plugins that extend the
capabilities of GBM.

e GRunScript: Most backup software offer complex command line options to allow users to perform
backups without using the user interface, a feature which is intended to provide extended flexibility for
advanced users who wish for instance to create batch files that can be shared with other network users
to perform standardized backup tasks. Genie Backup Manager takes this a step further by allowing
users to create complete backup jobs using XML based scripting.
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Using XML Tags

This page is not intended to teach you scripting per se', it will however give you an insight on the way tags
work. GenieScript and GRunScript are very simple, and you don't have to be an advanced user to understand
how to use them for writing scripts. You can learn scripting while creating your first GenieScript plugin, or
GRunScript backup job, especially with the aid of the Templates and Examples provided in this help section.

Tags are commands that come in two parts: A beginning and a closing tag, both parts are enclosed within
brackets, and the difference between a beginning and an ending tag is the forward slash </> on the latter.

Ex: <Author> Genie-Soft </Author>
The bracketed text is the command that needs to be performed, the text between the beginning and ending
tags is a value that is passed on to the command, for instance in the previous example, the tag <Author>

passes on the name of the author of the script to the compiler.

Sometimes tags also have properties; these are subcommands that are usually included in the beginning tag
that pass on specific properties to the compiler related to the main tag command.

Ex: <Folder IncludeSub =" False"> C:\personal </Folder>

Here, the tag <Folder> is telling GBM to backup the folder (C:\personal), the property IncludeSub which is set
to False instructs it to only backup files in the main folder, and to ignore any underlying subfolders.

Note:

e Tags are case sensitive.
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Environmental Variables

Environmental Variables are like the wildcards of file and folder paths, they are provided by Windows so as
to enable writing portable bits of code to be used on any Windows platform.

Each one of these variables corresponds to a certain system or custom folder in the Windows OS, and will
always get the right path for that folder, which might differ from one Windows platform to another.

Say for instance that you want to write a code that uses the file Notepad.exe file located in the Windows
directory, in that case you would refer to the path to that file as $$P_WIN$$/Notepad.exe, that will ensure
that your code points to the right path whether you're working under Windows NT, 2000 or XP

Here's a list of all Windows and custom environmental variables that you can use when writing scripts:

Windows Environmental Variables

$$P_ WINSS
$$P_WINTEMPS$$
$$P_PROGRAM_FILES$$

$$P_COMMON_PROGRAMFILES$$

$$P_DESKTOPS$S$

$$P_COMMON_DESKTOPS$$

$$P_PROGRAMSS$$

$$P_STARTMENUS$S$

$$P_APPDATAS$S

$$P_SENDTOS$$

$$P_STARTUPSS

Windows path (C:\WINNT, C:\Windows)
Windows temporary location
Program files folder. A typical path is C:\Program Files.

Contains application program related files that are, or can be, used
by more than one application program.

A typical path is C:\Program Files\Common Files

File system directory used to physically store file objects on the
desktop (not to be confused with the desktop folder itself).

A typical path is C:\Documents and Settings\username\Desktop

Refers to the desktop items common for all the users.

A typical path is C:\Documents and Settings\All Users\Desktop.

File system directory that contains the user's program groups
(which are also file system directories). A typical path is
C:\Documents and Settings\username\Start Menu\Programs.

File system directory containing Start menu items. A typical path is
C:\Documents and Settings\username\Start Menu.

File system directory that serves as a common repository for
application-specific data. A typical path is C:\Documents and
Settings\username\Application Data

File system directory that contains Send To menu items. A typical
path is C:\Documents and Settings\username\SendTo.

File system directory that corresponds to the user's Startup
program group. The system starts these programs whenever any
user logs onto Windows NT® or starts Windows® 95. A typical
path is C:\Documents and Settings\username\Start
Menu\Programs\Startup.



$$P_COOKIESS$S$

$$P_FAVORITESS$$

$$P_HISTORYS$SS

$$P_INTERNET_CACHES$$

$$P_PERSONALS$S$

$$P_COMMON_DOCUMENTSS$$

$$P_COMMON_MUSICS$

$$P_COMMON_PICTURES$$

$$P_COMMON_VIDEO$$

$$P_RECENTS$S$

$$P_TEMPLATES$$

$$P_SYSTEMSS

$$P_LOCAL_APPDATAS$S

$$P_COMMON_PROGRAMS$$

$$P_COMMON_STARTMENUSS$

$$P_COMMON_STARTUP$S$

File system directory that serves as a common repository for
Internet cookies. A typical path is C:\Documents and
Settings\username\Cookies.

File system directory that serves as a common repository for the
user's favorite items. A typical path is C:\Documents and
Settings\username\Favorites.

File system directory that serves as a common repository for
Internet history items.

File system directory that serves as a common repository for
temporary Internet files. A typical path is C:\Documents and
Settings\username\Temporary Internet Files.

File system directory that serves as a common repository for
documents. A typical path is C:\Documents and
Settings\username\My Documents.

Refers to the Documents common for all users.

Typical path C:\Documents and Settings\All Users\Documents

Refers to music files common for all users.

Typical path C:\Documents and Settings\All Users\Music

Refers to pictures and image files common for all users.

Typical path C:\Documents and Settings\All Users\Pictures

Refers to video and media files common for all users.

Typical path C:\Documents and Settings\All Users\Video

File system directory that contains the user's most recently used
documents. A typical path is C:\Documents and
Settings\username\Recent.

File system directory that serves as a common repository for
document templates.

System folder. A typical path is C:\WINNT\SYSTEM32

File system directory that serves as a data repository for local
(nonroaming) applications. A typical path is C:\Documents and
Settings\username\Local Settings\Application Data

File system directory that contains the directories for the common
program groups that appear on the Start menu for all users. A
typical path is C:\Documents and Settings\All Users\Start
Menu\Programs.

File system directory that contains the programs and folders that
appear on the Start menu for all users. A typical path is
C:\Documents and Settings\All Users\Start Menu.

File system directory that contains the programs that appear in the
Startup folder for all users. A typical path is C:\Documents and
Settings\All Users\Start Menu\Programs\Startup.



$$P_COMMON_TEMPLATESS$$

$$P_COMMON_APPDATASS

$$P_CONNECTIONSS$S$

$$P_CDBURN_AREAS$S$

$$P_NETHOODS$$

$P<Variable Name=>%$$

$$P_APPPATHS$$

$$P_APPPATHEXESS

$$P_COMPUTERNAMES$S$

$$P_USERNAMES$S

File system directory that contains the templates that are available
to all users. A typical path is C:\Documents and Settings\All
Users\Templates.

Application data for all users. A typical path is C:\Documents and
Settings\All Users\Application Data.

Refers to network and Dial-up Connections.

Refers to staging area used by Windows to store the data before
recording to CD.

Typical path USERPROFILE\Local Settings\Application
Data\Microsoft\CD Burning

Location of the "Network Neighborhood" folder. Typically located in
"\Documents and Settings\%Username%\NetHood"

Custom Environmental Variables

Returns the path or file/folder name assigned to the variable in the
<Variables> tag

Path for the application retrieved from Registry using the <Path>
tag (GenieScript)

Current Application EXE file name. (GenieScript)

Returns network name for the computer on which the backup job
is being run.

Returns username of the user currently logged on into Windows.
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Plugin Scripting (GenieScript)

GenieScript is XML-based scripting designed to enable users to create custom plugins that extend the
capabilities of GBM.

What Can GenieScript Do?

Any installed Windows based application stores data and settings on your computer through a number of
"changes" that it makes to your system, such as copying files to certain folders, writing to registry, etc...
GenieScript gives you access to these program-unique changes and data so that you can back them up for
safe keeping and restore them whenever the need to do so arises. This means that with GenieScript you can
backup anything from application settings and saved games to entire programs.

GenieScript can be used effectively to automate the backup of items such as:

e Entire programs.

Program settings and preferences.

Database files.

Mail clients' data.
e Game saves.
And much more.

GenieScript also provides the means for making backed up items portable between different Windows
platforms using Environmental Variables.
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How to: Create a Plugin using XML Tags

In order to simplify learning GenieScript we've written an example using all the tags needed to write a full
plugin script and added explanation after each tag or block of script using the script comments convention.
(Sentences enclosed in <!-- --> are comments that the compiler will ignore and are only there for the
benefit of whoever reviews the script).

Notes:

e Click the plus sign to view sub-tags and explanation.
e Tags are case sensitive.

e The script must be written using the same tag order as listed above.

*l<Backup> <!-- Starts the script file, a necessary tag that tells the compiler that the plugin script has begun. -->

</Backup>
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How to: Create a Plugin using Plugin Creator

Most users prefer dealing with GUIs to perform tasks. The Plugin creator generates the XML file
automatically without the need to write the XML tags. This can be done in 11 simple steps:

Step 1: Information

Step 2: Supported Version

Step 3: Main Program Path

Step 4: Variables

Step 5: Reqistry

Step 6: Files

Step 7: Folders

Step 8: Ini Files

Step 9: Shortcuts

Step 10: Restore

Step 11: Author




Winamp3

t<Backup>

</Backup>



Win Zip
t<Backup>

</Backup>
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How to: Compile a Plugin Script

After you've finished writing a backup script you need to convert it into a binary file that GBM can
understand, this is done using GenieScript Compiler which can be found in the "Genie Backup Manager Tools
window under Genie-Soft in the Start Menu.

To compile a GS script:

1. From the toolbar in Genie Backup Manager, click Tools, then select GenieScript Compiler.
2. Click Open and browse to the location where you've stored your script.

3. Click Compile.

4. If your script is error free the compiler will create a file with the extension (gpc) in the same folder as
the script.

5. Copy the output file to the folder GScript in your GBM main program folder. This is typically:
Drive:\Program Files\Genie-Soft\GBMAPPLICATION\GScript
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Script Compilation Errors

Error Message
The operation was successful

Failed to create output file
name

File does not exist

Could not find "Backup™ main
tag

Could not find "Program" tag
Could not find "Main" tag

Could not find "Main ->
Name" tag

Could not find "Version" tag

Could not find "Path" tag

Could not find "Path ->
Filename" tag

Could not find "Path -> Type"
tag

Could not find "Path ->
Keyname" tag

Could not find "RegistryKeys"
tag

Could not find "RegistryKeys
-> Key" tag

Error while Parsing
"IncludeSub" Attribute inside
"Key" tag

Error while Parsing "Files" tag

To without From, Must write
from tag

Error while Parsing "Links"
tag

Icon index is invalid

Could not find "Restore" tag
Could not find "RestorePath"
tag

Could not parse "Path ->
IncludeSub” tag

Number Description

o
1

2

10

11

12

13

14

16
17
18

19

20

Operation was successful

Failed to create output filename, make sure there is
enough space or that the folder is not locked

The script file does not exist or GScript can’t open the file,
make sure the file is not locked

Couldn’t find or open <Backup> tag, make sure the tag is
spelled correctly; tags are case sensitive

Couldn’t find or open <Program> tag, make sure the tag
is spelled correctly; tags are case sensitive

Couldn’t find or open <Main> tag, make sure the tag is
spelled correctly; tags are case sensitive

Couldn’t find or open <Name> tag inside <Main>.This tag
is necessary, it contains name of the item that the script
backs up

Couldn’t find or open <Version> tag, you must specify the
version or you can type “ALL” to make script applicable to
all versions

Couldn’t find or open <Path> tag, make sure the tag is
spelled correctly; tags are case sensitive

Couldn’t find or open <Filename> tag, make sure the tag
is spelled correctly; tags are case sensitive

Couldn’t find or open <Type> tag inside <Path>. Valid
Type values are: -1, 1, 2, 3

Couldn’t find or open <Keyname> tag inside <Path>,
make sure the tag is spelled correctly; tags are case
sensitive

Couldn’t find or open <RegistryKeys> tag, make sure the
tag is spelled correctly; tags are case sensitive

Couldn’t find or open <Key> tag inside <RegistryKeys>,
make sure the tag is spelled correctly; tags are case
sensitive

Could not parse attribute “IncludeSub” within <Key=> tag
inside <Registry>, valid values are TRUE or FALSE (case
sensitive)

Couldn’t find or open <Files> tag, make sure the tag is
spelled correctly; tags are case sensitive

<To> without <From=>, you must enter a <From> tag
before you write <To> tag

Couldn’t find or open <Links> tag, , make sure the tag is
spelled correctly; tags are case sensitive

Links icon index is invalid, valid values are 0 and higher
Couldn’t find or open <Restore> tag, make sure the tag is
spelled correctly; tags are case sensitive

Couldn’t find or open <RestorePath> tag, make sure the
tag is spelled correctly; tags are case sensitive

Could not parse <IncludeSub> tag within <Path> tag,
valid values are TRUE or FALSE (case sensitive)



Could not parse "File ->
Filter" tag

Could not parse "Folders" tag

To without From, Must write
from tag

Could not parse "Folders ->
IncludeSub" tag

Could not parse "File ->
NeverUninstall" tag

Could not parse " File->
CompareTimeStamp" tag
Could not parse "File ->
RegServer" tag

Could not find "Ini -> IniFile"
tag

Error while Parsing "Links ->
URL" tag

Error while Parsing "Path ->
Enable" tag

Error while Parsing "Restore -
> PathMustExist" tag

Error while Parsing "Restore -
> Uninstall" tag

21

22

23

24

26

27

28

29

30

31

Could not parse <Filter> tag within <File> tag, valid
values are TRUE or FALSE (case sensitive)

Couldn’t find or open <Folders> tag, make sure the tag is
spelled correctly; tags are case sensitive

<To> without <From>, you must enter <From=> tag
before you write <To> tag

Could not parse <IncludeSub> tag within <Folders> tag,
valid values are TRUE or FALSE (case sensitive)

Could not parse <NeverUninstall> tag within <File> tag,
valid values are TRUE or FALSE (case sensitive)

Could not parse <CompareTimeStamp=> tag within <File>
tag, valid values are TRUE or FALSE (case sensitive)
Could not parse <RegServer> tag within <File> tag, valid
values are TRUE or FALSE (case sensitive)

Couldn’t find or open <IniFile> tag within <Ini>, make
sure the tag is spelled correctly; tags are case sensitive
Could not parse <URL> tag within <Links> tag, valid
values are TRUE or FALSE (case sensitive)

Could not parse <Enable> tag within <Path> tag, valid
values are TRUE or FALSE (case sensitive)

Could not parse <PathMustExist> tag within <Restore>
tag, valid values are TRUE or FALSE (case sensitive)
Could not parse <Uninstall> tag within <Restore> tag,
valid values are TRUE or FALSE (case sensitive)
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Scripted Backup (GRunScript)

Most backup software offer complex command line options to allow users to perform backups without using
the application's graphical user interface, a feature which is intended to provide extended flexibility for
advanced users who wish for instance to create batch files that can be shared with other network users to
perform standardized backup tasks. Genie Backup Manager takes this a step further by allowing users to
create complete backup jobs using XML based scripting.
GRunScript is created by feeding the script all the settings and selections the user would specify using the
backup wizard, these include:

1. Backup Job information.

2. Backup storage device selection.

3. Data selection.

4. Settings.

e Backup Type.
e Security settings.
e Compression settings.

e Email notification settings.
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How to: Create a Backup Job Script

In order to simplify learning GRunScript we've written an example script using all the tags needed to write a
full script file and added explanation after each tag or block of script using the script comments convention.
(Sentences enclosed in <!-- --> are comments that the compiler will ignore and are only there for the
benefit of whoever reviews the script).

Notes

e Click the plus sign next to each tag to expand it.

e Tags are case sensitive.

*<Backup> <!-- Starts the script file, a necessary tag that tells GBM to start interpreting -->

</Backup>
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How to: Run a Scripted Backup
To run a scripted backup:
1. Convert the script's extension from .xml to .grs.

2. Double click the file. This will automatically start the backup job without the need of opening the GBM
interface.

To schedule your script as an unattended backup task:

1. Click Start, click All Programs, point to Accessories, point to System Tools, and then click
Scheduled Tasks.

2. Double-click Add Scheduled Task.
3. Click Next.
4. Click Browse, then select the script file.

5. Continue by following the on-screen instructions.
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Backup to Tape Media

1. Backup to tape dialog freezes with Idle status

Backup to tape dialog freezes with Idle status
SYMPTOMS

While backing up large amount of data to tape, the progress dialog freezes with and 'ldle' status without
performing any tape activity.

This status reflects the status of the tape hardware and has nothing to do with what the program is actually
doing. Here this isn't an error; the program is generating the Table Of Contents that is to be written on the
tape. It doesn't mean the program has stopped working.

CAUSE

Backing up a large number of files causes this delay. Real-time virus scanning also might slow down the
process too.

RESOLUTION

Try to disable your virus scanner if this stays for too long. Otherwise ignore it and the program should start
showing activity soon.
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Scheduling Unattended Backup Tasks

1. Generic troubleshooting tips.

2. GBM Is requesting a username for scheduling an unattended backup although | do not use one.

3. Error Message: "Failed to create a scheduled backup job."

4. Error message: "0x80070005: Access is denied."

Generic troubleshooting tips

GBM uses Windows Schedule task to schedule the backup tasks. However, under certain circumstances,
Windows fails to run the scheduled tasks. Here are steps to troubleshoot scheduling issues.

1. Run the Job manually from GBM: If the scheduled task does start but encountered problems running,
open GBM and run the task from there as it may be a problem from the backup job itself. If you
encounter problems in the manual run, please contact technical support.

2. Check the scheduled task status: If your scheduled tasks are running in different times than expected
or not running at all, check your scheduled tasks from Control Panel> Scheduled Tasks, remove all
unwanted schedules of the task or edit the schedule time of the schedule task by right-clicking the
scheduled task> properties> under the schedule tab you can edit the schedule. You can also edit the
scheduled tasks via GBM from Scheduled Wizard> Edit Existing Tasks. You can also check the Status
column in the Scheduled Tasks window. The following table describes the status types.

Status Description

Blank The task is not running, or it ran and was successful.
Running The task is currently being run.

Missed One or more attempts to run this task was missed.

Could not start The most recent attempt to start the task failed.

For details on the scheduled tasks status, go to step 4.

3. Run the job via scheduled Tasks: You can try to attempt a manual run from opening the scheduled task
in the task wizard> Right-click> Run and see if the tasks runs.

4. Check the scheduled task logs for detailed tasks status: The Scheduled Tasks log (SchedLgU.txt),
enables you to view more information about the status of a scheduled task. This log file for Scheduled
Tasks is stored in the Windows folder, where it is used to record the activity of scheduled tasks. You
can use the log file to determine why a task might have stopped, by viewing errors that may have
encountered the task or to check on the status of a task. Usually, you can search the Microsoft
knowledge base http://support.microsoft.com/search/ with the error codes you are encountering and
find fixes and workarounds for common errors.

5. Manually schedule the task: You may refer to the following knowledgebase article on how to manually
schedule unattended GBM backup tasks.

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55



http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55

6. Schedule a Task non- related to GBM: Try scheduling a task that is not related to GBM so you can
identify if the problem is related to GBM or Windows.

Back to top

GBM Is requesting a username for scheduling an unattended backup although I do not
use one.

SYMPTOMS:

Genie Backup Manger requests a username and password for scheduling an unattended backup task even
though mine is a standalone computer and no user name or password are required to log in.

CAUSE:
Your Windows has a login password, but its set to Null.
RESOLUTION:

Use the following when you are prompted to enter a username and password

User: {Username}
Password: Empty

Back to top

Error Message: "Failed to create a scheduled backup job."

If you are on a domain the user name must be written in the format Domain/Username. Also make sure that
the user name and password that you entered are the ones for the user logged onto the machine when the
backup job is intended to run.

GBM uses Windows Scheduled Tasks agent to schedule unattended backup jobs. Make sure that the
Scheduled Tasks agent is active by manually creating a scheduled task and running it once. For instructions
on how to do this, please follow the link below:

http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55

In most cases, the user will get an error message that reads

"The new task has been created, but may not run because the account information could not be set. The
specific error is: 0x8007007a: The data area passed to a system call is too small."

This indicates that the buffer that stores account information for ALL scheduled tasks is finite, and has been
exhausted.

To work around this error:

1. Copy/Paste the following to a notepad file and name it StopStartTaskScheduler.bat:


http://www.genie-soft.com/asp/Community/KnowledgeArticle.asp?KBID=55

@echo off

net stop "Net Logon"

net stop "Windows Time"

net stop "Task Scheduler"

net start "Windows Time"

net start "Net Logon"

net start "Task Scheduler”

@ping -n 901 127.0.0.1>nul

@echo You may set the account information for the 'new task' and schedule additional tasks.

2. Open a CMD prompt.

3. Type StopStartTaskScheduler.bat and press Enter.

4. When you see the You may set the account information for the "'new task' and schedule
additional tasks message, in 15 minutes, the Task Scheduler scavenger tool, which start 10

minutes after the Task Scheduler service is started, should have freed enough buffer memory.

NOTES:

e You may have to press OK in a dialog that tells you that some scheduled tasks have been missed.

e When the script starts the Task Scheduler, it is normal to receive: "The requested service has already
been started.”

Back to top

Error message: "0x80070005: Access is denied"
SYMPTOMS:

When | try to create a scheduled job manually from windows schedule wizard | get an error message that
reads “Ox80070005: Access is denied”

CAUSE:

This problem also occurs because of a regression that was introduced in Windows XP Service Pack 2 (SP2)
and Windows XP Tablet PC Edition 2005.

RESOLUTION:

Please make sure that you are logged on into your user’s account with the correct password, Even though if
you are an administrator the scheduler will not recognize you as you are not logged on with admin password.

From Microsoft knowledge base :"A supported hotfix is now available from Microsoft, but it is only intended
to correct the problem that is described in this article. Only apply it to systems that are experiencing this
specific problem. This hotfix may receive additional testing. Therefore, if you are not severely affected by
this problem, we recommend that you wait for the next Windows XP service pack that contains this hotfix."
To download fix please use the following link:

http://www.microsoft.com/technet/security/bulletin/ms04-022.mspx



http://www.microsoft.com/technet/security/bulletin/ms04-022.mspx

To work around this problem:

1. Click Start, click Run, type Gpedit.msc, and then click OK.

2. Expand the following items in the Local Computer Policy list:

e Computer Configuration
e Windows Settings
e Security Settings

e Local Policies

3. Click User Rights Assignment.

4. Double-click Access this computer from the network, and then click Add User or Group.
5. Add the new user name or the group name in the Enter the object names to select area.
6. Click Check Names to verify the entries.

7. Click OK two times.

Back to top
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Backup Types

1. Error Message: "Missing index.qgix file, can't continue without this file".

2. GBM.is set to backup only new and changed files, but it reports the size of the entire set of
selected files and folders before backup, even though few files were added or updated.

Error Message: "Missing index.gix file, can't continue without this file"
SYMPTOMS:

When backing up in mirror or incremental mode with compression disabled, the backup can't find index.gix
and reports the error message:

"Missing index.gix file, can't continue without this file"
CAUSE:

Your previous backup run was interrupted.
RESOLUTION:

Run a full backup. This will recreate the index.gix file.

Back to top

GBM is set to backup only new and changed files, but it reports the size of the entire
set of selected files and folders before backup, even though few files were added or
updated

CAUSE

During the "confirming data selections" step before backup, Genie Backup Manager depends on the Archive
bit/flag attribute to determine which files have not already been backed up. If GBM was not able to reset this
flag during previous backups, for instance if the source was write-protected, it will assume that all files need
to be backed up. Note that this does not prevent GBM from actually backing up only the correct set of files in
real-time, as it refers to its own internal index.

RESOLUTION

If the data source was a network location, change the share permissions for folders that you've selected for
backup to "full control”. Otherwise, please make sure that the source media is not write-protected.

Back to top
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Contacting Support

Even though we strive to make Genie Backup Manager easy to install and use, we understand that
sometimes you may need a helping hand.

Before contacting the support team, please take the time to collect the following information that will help
our team identify the problem and provide you with timely support:
1. Name of the product you are using and build number. You can find the build number by opening the
main application and going to Help > About.
2. Windows platform the program is being used on.
3. Registration name and serial number if applicable.

4. Can the problem be consistently reproduced, if so what are the steps that can be followed to replicate
the error.

You can contact the support team at Genie-Soft using the helpdesk call tracking system. Users must be
signed up with My Account in order to send inquiries (available for free for both registered and non
registered users). Sign up with My Account.

If you've forgotten your password, click on the Forgot your password? link in the My Account login page,
enter your email address, and click Send. An email will be sent to you. Click the link in the email to confirm
the request. The system will then automatically reset your password and send you another email containing
the new password.

Registered users can also:
e Add (genie_soft@hotmail.com) on MSN messenger. Registered XP users may request remote
Assistance.

e Contact the support technician through I1CQ, UIN #266034018.

Using the Helpdesk

To access the helpdesk, log in to 'My Account'. From the My Account menu, select Helpdesk.

If you click on Main, a list of all open tickets will be displayed; click on a ticket's case number to view your
inquiry and the support technician's responses.

To submit a new inquiry, click on Submit New Request, complete the form, then click Send. To attach a
file to the call ticket, click Choose to select the file you wish to send from your computer, then click Attach.

Upon form submission, a ticket will be created in our call tracking system. When the support specialist
assigned to your call responds to your inquiry, an e-mail will be sent to notify you with a URL and a unique
ticket number that you can use to view the response. You can send a reply by writing a new message in the
text box at the bottom of the page, then clicking Send.
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Ordering Genie Backup Manager

Genie Backup Manager has a trial version. This means that you can evaluate a fully functional copy of the
software for FREE. You are entitled to evaluate the software for up to 30 days without obligation to pay.
After 30 days, if you decide to keep the software, you must pay for and register your copy with us.

There are also a number of 'incentives' for registering:

1. Removes the registration and license dialogs.

2. You can use the software after the trial period.

3. You can use the auto update feature to check for new software upgrades and fixes.
4. Receive priority customer support.

5. Free upgrade to any minor version (8.x)

6. Special offers on major upgrades.

How to register / purchase:

To purchase the software point your web browser to http://www.genie-soft.com/store/store.html

Software Satisfaction Guaranteed

If for any reason you are not satisfied with software purchased directly from Genie-Soft, simply contact us
for a refund within 21 days of purchase.

For returns, please contact sales@genie-soft.com

Please note that shipping and delivery charges are non-refundable.
These terms and conditions apply only to Genie-Soft software purchased directly from Genie-Soft. If your

software was purchased through a different vendor, it must be returned to that vendor and is subject to the
return policies of that vendor.

Your Order Is Secure
Ordering through Genie-Soft. is certain to provide you with a safe and secure credit card transaction.

Your order is secure because we use Secure Socket Layer (SSL) encryption for every transaction.


http://www.genie-soft.com/store/store.html
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